> SPSS’ 13.0 Brief Guide

o |

g




For more information about SPSS® software products, please visit our Web site at http: //www.spss.com or contact

SPSS Inc.

233 South Wacker Drive, 11th Floor
Chicago, IL 60606-6412

Td: (312) 651-3000

Fax: (312) 651-3668

SPSSis aregistered trademark and the other product names are the trademarks of SPSS Inc. for its proprietary
computer software. No material describing such software may be produced or distributed without the written
permission of the owners of the trademark and license rights in the software and the copyrightsin the published
materials.

The SOFTWARE and documentation are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure
by the Government is subject to restrictions as set forth in subdivision (c) (1) (ii) of The Rightsin Technical Data
and Computer Software clause at 52.227-7013. Contractor/manufacturer is SPSS Inc., 233 South Wacker Drive,
11th Floor, Chicago, IL 60606-6412.

General notice: Other product names mentioned herein are used for identification purposes only and may be
trademarks of their respective companies.

Tablel ook is atrademark of SPSS Inc.

Windows is a registered trademark of Microsoft Corporation.

DataDirect, DataDirect Connect, INTERSOLYV, and SequeLink are registered trademarks of DataDirect
Technologies.

Portions of this product were created using LEADTOOLS © 1991-2000, LEAD Technologies, Inc. ALL
RIGHTS RESERVED.

LEAD, LEADTOOLS, and LEADVIEW are registered trademarks of LEAD Technologies, Inc.

Sax Basic is atrademark of Sax Software Corporation. Copyright © 1993-2004 by Polar Engineering and
Consulting. All rights reserved.

Portions of this product were based on the work of the FreeType Team (http://mww.freetype.org).

A portion of the SPSS software contains zlib technology. Copyright © 1995-2002 by Jean-loup Gailly and Mark
Adler. The zlib softwareis provided “asis,” without express or implied warranty.

A portion of the SPSS software contains Sun Java Runtime libraries. Copyright © 2003 by Sun Microsystems,
Inc. All rights reserved. The Sun Java Runtime libraries include code licensed from RSA Security, Inc. Some
portions of the libraries are licensed from IBM and are available at http://oss.software.ibm.convicudj/.

SPSS® 13.0 Brief Guide

Copyright © 2004 by SPSS Inc.

All rights reserved.

Printed in the United States of America.

No part of this publication may be reproduced, stored in aretrieval system, or transmitted, in any form or by any
means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission
of the publisher.

ISBN 0-13-154242-7



Preface

The SPSS® 13.0 Brief Guide provides a set of tutorials designed to acquaint you
with the various components of the SPSS system. You can work through the
tutorials in sequence or turn to the topics for which you need additional information.
You can use this guide as a supplement to the online tutorial that is included with
the SPSS Base 13.0 system or ignore the online tutorial and start with the tutorials
found here.

SPSS 13.0

SPSS 13.0 is a comprehensive system for analyzing data. SPSS can take data from
almost any type of file and use them to generate tabulated reports, charts, and plots of
distributions and trends, descriptive statistics, and complex statistical analyses.

SPSS makes statistical analysis more accessible for the beginner and more
convenient for the experienced user. Simple menus and dialog box selections make
it possible to perform complex analyses without typing a single line of command
syntax. The Data Editor offers a simple and efficient spreadsheet-like facility for
entering data and browsing the working datafile.

Internet Resources

The SPSS Web site (http://mww.spss.com) offers answers to frequently asked
guestions about installing and running SPSS software and provides access to data
files and other useful information.

In addition, the SPSS USENET discussion group (not sponsored by SPSS)
is open to anyone interested in SPSS products. The USENET address is
comp.soft-sys.stat.spss. It deals with computer, statistical, and other operational
issues related to SPSS software.



You can also subscribe to an e-mail message list that is gatewayed to the USENET
group. To subscribe, send an e-mail message to listserv@listserv.uga.edu. The text of
the e-mail message should be: subscribe SPSSX-L firstname lastname. You can then
post messages to the list by sending an e-mail message to listserv@listserv.uga.edu.

Additional Publications

For additional information about the features and operations of SPSS Base 13.0,

you can consult the SPSS Base 13.0 User’s Guide, which includes information on
standard graphics. Examples using the statistical procedures found in SPSS Base 13.0
are provided in the Help system, installed with the software. Algorithms used in the
statistical procedures are available on the product CD-ROM.

In addition, beneath the menus and dialog boxes, SPSS uses a command |anguage.
Some extended features of the system can be accessed only via command syntax.
(Those features are not available in the Student Version.) Complete command syntax
is documented in the SPSS 13.0 Command Syntax Reference, available in PDF form
from the Help menu.

Individuals worldwide can order additional product manuals directly from SPSS
Inc. For telephone orders in the United States and Canada, call SPSS Inc. at
800-543-2185. For telephone orders outside of North America, contact your local
office, listed on the SPSS Web site at http://mww.spss.com/worldwide.

The SPSS Satistical Procedures Companion, by Marija Norusis, has been
published by Prentice Hall. It contains overviews of the procedures in the SPSS
Base, plus Logistic Regression and General Linear Models. A Satistical Procedures
Companion covering advanced procedures is forthcoming.

SPSS Options

The following options are available as add-on enhancements to the full (not Student
Version) SPSS Base system:

SPSS Regression Models™ provides techniques for analyzing data that do not fit
traditional linear statistical models. It includes procedures for probit analysis, logistic
regression, weight estimation, two-stage | east-squares regression, and general
nonlinear regression.



SPSS Advanced Models™ focuses on techniques often used in sophisticated
experimental and biomedical research. It includes procedures for general linear
models (GLM), linear mixed models, variance components analysis, loglinear
analysis, ordinal regression, actuarial life tables, Kaplan-Meier survival analysis,
and basic and extended Cox regression.

SPSS Tables™ creates a variety of presentation-quality tabular reports, including
complex stub-and-banner tables and displays of multiple response data.

SPSS Trends™ performs comprehensive forecasting and time series analyses with
multiple curve-fitting models, smoothing models, and methods for estimating
autoregressive functions.

SPSS Categories® performs optimal scaling procedures, including correspondence
analysis.

SPSS Conjoint™ performs conjoint analysis.

SPSS Exact Tests™ cal culates exact p values for statistical tests when small or very
unevenly distributed samples could make the usual tests inaccurate.

SPSS Missing Value Analysis™ describes patterns of missing data, estimates means
and other statistics, and imputes values for missing observations.

SPSS Maps™ turns your geographically distributed data into high-quality maps with
symboals, colors, bar charts, pie charts, and combinations of themes to present not
only what is happening but where it is happening.

SPSS Complex Samples™ allows survey, market, health, and public opinion
researchers, as well as social scientists who use sample survey methodology, to
incorporate their complex sample designs into data analysis.

SPSS Classification Tree™ creates a tree-based classification model. It classifies
cases into groups or predicts values of a dependent (target) variable based on values
of independent (predictor) variables. The procedure provides validation tools for
exploratory and confirmatory classification analysis.

The SPSS family of products also includes applications for data entry, text analysis,
classification, neural networks, and flowcharting.



Training Seminars

SPSS Inc. provides both public and onsite training seminars for SPSS. All seminars
feature hands-on workshops. SPSS seminars will be offered in major U.S. and
European cities on aregular basis. For more information on these seminars, contact
your local office, listed on the SPSS Web site at http: //www.spss.com/wor | dwide.

Technical Support

The services of SPSS Technical Support are available to registered customers of
SPSS. (Student Version customers should read the special section on technical support
for the Student Version. For more information, see “ Technical Support for Students’
on p. vii.) Customers may contact Technical Support for assistance in using SPSS
products or for installation help for one of the supported hardware environments. To
reach Technical Support, see the SPSS Web site at http://mww.spss.com, or contact
your locd office, listed on the SPSS Web site at http: //www.spss.com/worldwide. Be
prepared to identify yourself, your organization, and the serial number of your system.

Tell Us Your Thoughts

Your comments are important. Please et us know about your experiences with SPSS
products. We especially like to hear about new and interesting applications using
the SPSS system. Please send e-mail to suggest@spss.com, or write to SPSS Inc.,
Attn: Director of Product Planning, 233 South Wacker Drive, 11th Floor, Chicago IL
60606-6412.

SPSS 13.0 for Windows Student Version

The SPSS 13.0 for Windows Student Version is alimited but still powerful version
of the SPSS Base 13.0 system.

Capability

The Student Version contains al of the important data analysis tools contained in
the full SPSS Base system, including:

m  Spreadsheet-like Data Editor for entering, modifying, and viewing data files.

vi



m  Statistical procedures, including t tests, analysis of variance, and crosstabul ations.

®m Interactive graphics that allow you to change or add chart elements and variables
dynamically; the changes appear as soon as they are specified.

m  Standard high-resolution graphics for an extensive array of analytical and
presentation charts and tables.

Limitations

Created for classroom instruction, the Student Version is limited to use by students
and instructors for educational purposes only. The Student Version does not contain
all of the functions of the SPSS Base 13.0 system. The following limitations apply to
the SPSS 13.0 for Windows Student Version:

m Datafiles cannot contain more than 50 variables.

m Datafiles cannot contain more than 1,500 cases. SPSS add-on modules (such
as Regression Models or Advanced Models) cannot be used with the Student
Version.

m  SPSS command syntax is not available to the user. This means that it is not
possible to repeat an analysis by saving a series of commands in a syntax or “job”
file, as can be done in the full version of SPSS.

m  Scripting and automation are not available to the user. This means that you

cannot create scripts that automate tasks that you repeat often, as can be done
in the full version of SPSS.

Technical Support for Students

Students should obtain technical support from their instructors or from local support
staff identified by their instructors. Technical support from SPSS for the SPSS 13.0
Student Version is provided only to instructors using the system for classroom
instruction.

Before seeking assistance from your instructor, please write down the information
described below. Without this information, your instructor may be unable to assist
you:

m  Thetype of PC you are using, as well as the amount of RAM and free disk
space you have.

m  The operating system of your PC.
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m A clear description of what happened and what you were doing when the problem
occurred. If possible, please try to reproduce the problem with one of the sample
data files provided with the program.

m  Theexact wording of any error or warning messages that appeared on your screen.
®  How you tried to solve the problem on your own.

Technical Support for Instructors

Instructors using the Student Version for classroom instruction may contact SPSS
Technical Support for assistance. In the United States and Canada, call SPSS
Technical Support at 312-651-3410, or send an e-mail to support@spss.com. Please
include your name, title, and academic institution.

Instructors outside of the United States and Canada should contact your local SPSS
office, listed on the SPSS Web site at http: //www.spss.com/wor|dwide.
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Chapter

Introduction

This guide provides a set of tutorials designed to acquaint you with the various
components of the SPSS system. You can work through the tutorials in sequence or
turn to the topics for which you need additional information. The goal isto enable
you to perform useful analyses on your data using SPSS.

This chapter will introduce you to the basic environment of SPSS and demonstrate
atypical session. We will run SPSS, retrieve a previously defined SPSS datafile, and
then produce a simple statistical summary and a chart. In the process, you will learn
the roles of the primary windows within SPSS and will see afew features that smooth
the way when you are running analyses.

More detailed instruction about many of the topics touched upon in this chapter
will follow in later chapters. Here, we hope to give you a basic framework for
understanding and using SPSS.

Sample Files

Most of the examples presented here use the data file demo.sav. This datafileis
afictitious survey of several thousand people, containing basic demographic and
consumer information.

All sample files used in these examples are located in the folder in which SPSSis
installed or in the tutorial\sample_files folder within the SPSS installation folder.
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Starting SPSS

To start SPSS:

» From the Windows Start menu choose;

Programs

SPSS for Windows

SPSS for Windows

To start SPSS for Windows Student Version:

» From the Windows Start menu choose:

Programs

SPSS for Windows Student Version

When you start a session, you see the Data Editor window.

Figure 1-1

Data Editor window (Data View)
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Variable Display in Dialog Boxes

Either variable names or longer variable labels will appear in list boxesin dialog
boxes. Additionally, variablesin list boxes can be ordered alphabetically or by their
position in the file.

In this guide, we will display variable labelsin aphabetical order within list boxes.
For a new user of SPSS, this provides a more complete description of variablesin
an easy-to-follow order.

Since the default setting within SPSSisto display variable labelsin file order, we
will change this before accessing data.

» From the menus choose:

Edit
Options...

» Select Display labels in the Variable Lists group on the General tab.
» Also select Alphabetical.

» Click oK, and then click OK to confirm the change.

Opening a Data File
Before you can analyze data, you heed some data to analyze.

To open a datafile:

» From the menus choose:
File
Open
Data...
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Alternatively, you can use the Open File button on the toolbar.

Figure 1-2
Open File toolbar button

-

L=-

This opens the Open File dialog box.

Figure 1-3
Open File dialog box

Open File nm
Lok i Ia zample_filez j . &5 E3-
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cars.sav credit_card.zav dvdplayer.say E

&) cellular sav creditpromo. zaw esatisf. zav E
] |

File name: Idemo.sav Dpen

Files of tywpe: ISPSS [*.zav) LI ﬂl
Cancel |
A

By default, SPSS-format data files (.sav extension) are displayed. You can display
other file formats using the Files of Type drop-down list.

By default, data files in the folder (directory) in which SPSSisinstalled are
displayed. Thefilesfor this guide are located in the folder in which SPSSisinstalled
or in the tutorial\sample _files folder within the SPSS installation folder.

» Double-click the tutorial folder.

» Double-click the sample files folder.

» Click the file demo.sav in the files list box (or just demo if file extensions are not
displayed).
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Figure 1-4
Sample_files folder displayed in Open File dialog box
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» Click Open to open the SPSS datafile.

Figure 1-5
Variable labels
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The datafileis displayed in the Data Editor. If you put the mouse cursor on avariable
name (the column headings), a more descriptive variable label is displayed if one has
been defined for that variable.
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By default, the actual data values are displayed. To display labels:
» From the menus choose:

View
Value Labels

Alternatively, you can use the Labdl tool on the toolbar.

Figure 1-6
Value Labels tool

%

Descriptive value labels are now displayed. This makesit easier to interpret the

responses.
Figure 1-7
Value labels displayed in the Data Editor
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Running an Analysis

The Analyze menu contains a list of general reporting and statistical analysis
categories. Most of the categories are followed by an arrow, which indicates that there
are severa anaysis procedures available within the category; they will appear on a
submenu when the category is selected.

We'll start with a simple frequency table (table of counts).

» From the menus choose:

Analyze
Descriptive Statistics
Frequencies...

This opens the Frequencies dialog box.

Figure 1-8

Frequencies dialog box
L3 Ak in vears [age] ! el el ] |
@ Call waiting [eallwa
@ Caller ID [calid] [Pase |
[A} Gender [gender] Reset |
® Haz newspaper sul C |
# Household income ﬂl
® Income category [ir Help |
@ Internet [inkermet]

¥ Display frequency tables

Statistics... Charts... Format... |
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» Select (click) the variable Income category.

Figure 1-9
Variable labels and names in the Frequencies dialog box
ugE in years [age] u Variable(s] K. |
< Call waiting [callwa —
4 Caller 1D [calid] _las c
[A Gender [gender] Feset |
@ Has newspaper sul
< Household income ﬂl
< Income category finceat] | Help |
@ Intermnet [internet]
T I Y 3 .4....;:...ﬂ
¥ Dizplay frequency tables
Statistics...l Charts... | Farmat... |

A more compl ete description of each variable pops up when the cursor is over it. The
variable name (in sguare brackets) is inccat, and it has the variable label Income
category. If there were no variable label, only the variable name would appear in

the list box.

In the dialog box, you choose the variables you want to analyze from the source list
on the left and move them into the Variable(s) list on the right. The OK button, which
runsthe analysis, is disabled until at |east one variableis placed in the Variable(s) list.

Additional labeling information can be easily obtained for any variable on the list
by clicking on the variable name with the right mouse button.

» Click the right mouse button on Income Category [inccat], and then click (Ieft mouse
button) Variable Information.

» Click the down arrow on the Value Labels drop-down list.
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Defined labels for income variable
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Value labels: |1.00 Under $25,000
1.00 Under $25,000
2.00 425,000 to $49,939
3.00$50,000 to $74.993
4.00 $75,000 or more

All of the defined value labels for the variable are displayed.

» Click Gender [gender] in the source variable list, and then click the right-arrow
button to move the variable into the target Variable(s) list.

» Click Income category [inccat] in the source list, and then click the right arrow

button again.
Figure 1-1

Variables selected for analysis
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A pound sign (#) icon next to the variable name indicates that the variableis numeric.
Anicon with the letter “A” indicates that the variable is a string (a phanumeric)
variable, which may contain both letters and numbers. A less-than sign (left angle

bracket) indicates that the variable is a short string, containing eight or fewer
characters.

» Click OK to run the procedure.

Viewing Results

Figure 1-12
Viewer window

i Dutput! - SPSS Viewer [_ (O] x|
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Mizsing o 0]
Frequency Table
d 1l | W

Results are displayed in the Viewer window.

You can quickly go to any item in the Viewer simply by selecting it in the outline pane.

» Click Income category.
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Figure 1-13
Frequency table of income categories
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This takes you directly to the frequency table for income categories. This frequency
table shows the number and percentage of people in each income category.

Creating Charts

Although some statistical procedures can create high-resolution charts, you can also
use the Graphs menu to create charts.

For example, you could create a chart that shows the rel ationship between wireless
telephone service and PDA (personal digital assistant) ownership.

» From the menus choose:

Graphs
Bar...

» Click Clustered and then click Define.
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» Scroll down the source variable list and select Wireless service [wireless] asthe

Figure 1-14

Define Clustered Bar dialog box

Il Define Clustered Bar: Summaries for Groups of Cases

@ Age in pears [age] | 2]
® M arital status [marits
< Years at curent ade
@ Household income i
® Income categom in
@ Price of pimary veh
@ Primary vehicle price
@ Level of education |
< Years with curent &
#> Reired [retire]

G ears with current &
@ Job zatizfaction [job
[A} Gender [gender]

@ Number of people i
® Fultiple lines [multlr
@ Yoice mail [voice]

@ Paging service [pag
@ Internet [internet]

@ Caller 1D [calid] =
@ Call waiting [callwait
@ Owarz TV [ownby]

@ Dz WCR [ownver
@ Owns stereo/CD plc'j

- .

— Bars Represent
& 1 of cases

" Cum. M

% of
~

()

L,

" Other statistic [e.g., mean]

ariable:

cazes

I

Change Statistic... |

Categony Agis:

| > Wirsless service [wirelss

Define Clusters by:

I@ Qwinz POA [ownpda)

— Patel By

Rows:

™| Mest row varables

Columng:

I~ Hest column warniables

Template

[ Use chart specifications fram:

K
Paste
Reset
Cancel

Help

cHHE]

Category Axis variable.

» Select Owns PDA [ownpda] as the Define Clusters By variable.

» Click OK to create the chart.
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Figure 1-15
Bar chart displayed in Viewer window
i Dutput! - SPSS Viewer [_ (O] x|
File Edit “iew |nsert Fomat Analpze Graphs  Uhlites  Window Help
S8R » = | DOk 2 & 1
Outpt 4000 =l
Log
Frecuencies
Title:
Motes 3000
- [ Statistics
2000
a Owns PDA
1000
. - o
% Motes 8 0 | | DYES
Mo Yes

-r[,ﬁﬁ] Bar of court

YWireless senvice

« | v« |

I

-

H 2

Introduction

The bar chart is displayed in the Viewer. It shows that people with wireless phone
service are far more likely to have PDAs than people without wireless service.

You can edit charts and tables by double-clicking on them in the contents pane of
the Viewer window, and you can copy and paste your results into other applications.

Those topics will be covered later.

Exiting SPSS

To exit SPSS:

» From the menus choose:
File
Exit

» Click No if you get an alert asking if you want to save your results.
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Using the Help System

Help is available in a number of different ways, including:

Help menu. Every window has a Help menu on the menu bar. The Topics menu item
provides access to the Help system, where you can use the Contents and Index tabs to
find topics. The Tutorial menu item provides access to the introductory tutorial.

Dialog box Help buttons. Most dialog boxes have a Help button that takes you directly
to aHelp topic for that dialog box. The Help topic provides general information and
links to related topics.

Pivot table context menu Help. Right-click on termsin an activated pivot tablein
the Viewer and select What's This? from the context menu to display definitions
of the terms.

Statistics Coach. The Statistics Coach item on the Help menu provides a wizard-like
method for finding the right statistical or charting procedure for what you want to do.

Case Studies. The Case Studies item on the Help menu provides hands-on examples
of how to create various types of statistical analyses and interpret the results. The
sample data files used in the examples are also provided so that you can work through
the examples to see exactly how the results were produced.

This chapter uses the files demo.sav and bhel ptut.spo.

15
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Help Contents Tab

The Topics item on the Help menu opens a Help window.

» From the menus choose:

Help
Topics

Figure 2-1
Help Contents tab

i? Base System

4 e =2 @ [

Hide Back Fomvard Stop

Refresh  Home

Contents | Indes |

= @ Baze Syztel

@ Overview:

@ Getting Help

@ Data Files

@ Witual Active File
@ D ata Editar

@ Copy Data Properties
@ Define Variable Prope
@ D ata Transformations
@ File Handing and File
@ Restructuring Data
@ wiorking with Output
@ Draft Wiewer

@ Pivot Tables

@ Warking with Comma
@ Frequencies

4 I | 4

=
_

-

Overview

SPSS for Windows provides a powerful
statistical analysis and data management
system in a graphical environment, using
descriptive menus and simple dialog boxes
to do most of the work for you, Most tasks
can be accomplished simply by pointing and
clicking the mouse.

In addition to the simple point-and-click
interface for statistical analysis, SPSS for
Windows provides:

Data Editor. & versatile spreadsheet-like
system for defining, entering, editing, and
displaying data.

||

The Contents tab in the left pane of the Help window is an expandable and collapsible
table of contents. It is most useful if you're looking for general information or are
unsure of what index term to use to find what you're looking for.
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Help Index Tab

Figure 2-2

Help Index tab

i? Basze System !EIB
G Al

Hide Back Fomward Stop  Refresh Home

Content:  Index | Overview

Type it the keyword to find:

I SPSS for Windows provides a powerful

statistical analysis and data management
M system in a graphical environment, using

2516 descriptive menus and simple dialog bozes
command sprtax to do most of the work for you, Maost tasks
3D IDtttaliolnt can be accomplished simply by pointing and
sCatlerplats i H
2D scattirplots clicking the mouse.
caze labels
caze weights In addition to the simple point-and-click
control variables interface for statistical analysis, SPSS for

displ;yed data
rotating
spikes
wireframe | Data Editor. & versatile spreadsheet-like
Access IMicrosoft] system for defining, entering, editing, and

Display | displaying data.

Windows provides:

||

» Click the Index tab in the left pane of the Help window.

The Index tab provides a searchable index that makes it easy to find specific topics.
The Index tab is organized in aphabetical order, just like a book index. It uses
incremental search to find what you' re looking for.
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For example, you can:
» Type med.
Figure 2-3
Incremental index search
i? Base System !EIB
e = 0 o)
Hide Back Fomward Stop  Refresh Home
Ind . =
Contentz  1ndsx | Ovelrview
Type it the keyword to find:
[med SPSS for Windows prowvides a powerful
_ statistical analysis and data management
popE——— system in a graphical environment, using 1y
median statistic descriptive menus and simple dialog boxes
in Explore to do most of the work for you. Maost tasks
in Hequencies can be accomplished simply by pointing and
N Means i H
i DLAP Cubes clicking the mouse.
in A atio Statisticz i |
in Summrnarize In addition to the simple point-and-click
"“'?d'Ta” t'3|3td dertSamles Test interface for statistical analysis, SPSS for
I [ wo-lndependent-aamples | esiz R . R
memory Windows provides:
increasing vir_tual memary
memary allocation ) j Data Editor. & versatile spreadsheet-like
in TwoSten Cluster Anlsis system for defining, entering, editing, and
Display | displaying data.

The index scrolls to and highlights the first index entry that starts with these letters,
which is median.

Dialog Box Help

Most dialog boxes have a Help button that displays a Help topic about what the
dialog box does and how to do it.

» From the menus choose:

Analyze
Descriptive Statistics
Frequencies...
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» Click Help.
Figure 2-4

Dialog box Help topic

i? Base System
G

Hide Back Fonward  Stop

Using the Help System

[ f)

Refresh  Home

LContents | Index |

5 ([ Base Spstem
@ Overview

@ Data Files
@ Data Editor

@ Define Varidl

@ Diraft Viswer

=] [m Frequencies
Fregue
Frequer

EN

=l

@ Getting Help J
@ vitual Active File

@ Copy Data Prope

ble F

@ Data Transformal
@ File Handling anc
@ Restructuring Da
@ woiking with Dul

@ Pivot Tables
@ Working with Cor

CiET

@ How to Obtai =

»

Frequencies

The Frequencies procedure provides statistics
and graphical displays that are useful for
describing many types of variables, For a first
look at your data, the Freqguencies procedure is
a good place to start,

For a frequency report and bar chart, you can
arrange the distinct wvalues in ascending or
descending order or order the categories by
their frequencies. The frequencies report can be
suppressed when a wariable has many distinct
values. You can label charts with frequencies
{the default) or percentages.

Example. What is the distribution of a
company's customers by industry type? From
the output, you might learn that 37.5% of your
customers are in government agencies, 24,9% in
corporations, 28.1% in academic institutions,

|»

|

In this example, the Help topic describes the purpose of the Frequencies procedure

and provides an example.

Statistics Coach

The Statistics Coach can help to guide you through the process of finding the

procedure that you want to use.

» From the menus choose:

Help
Statistics Coach
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Figure 2-5
Statistics Coach, first step

What do you want to do?
Indusiry
Govemment $2,525 |§1,252,641
Commercial §2,431 |$1,230,304 . Bummarize, describe. or preserd dsta
$1.211.724
§2,517 83,744 569 ™ Look atvariance and distribution of data
Cumulative
Percent Percent € Craale OLAP report cubss
<1 Minute 186 186
1-2 Minutes 235 421
24 Minutes 05 625  Compare groups for slgnificant differences
= 4 Minutes 375 1000
Total 1000
Tirme ‘." :::{:r“ =

on hold Easl | West
= 1 Minute

12 Minutes

-4 Minutes

= 4 Minutes

" Igentiy graups of similar cases

" Identify groups of similar vanables

g

The Statistics Coach presents a series of questions designed to find the appropriate
procedure. The first question is simply “What do you want to do?’

For example, if you want to summarize data:
» Select Summarize, describe, or present data.

» Then click Next.
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Figure 2-6
Data type selection

What kind of data do you want to
summarize?

Data in categonies (nominal, ordinal)

© Continuews, numeric data (inferval, ratio)

 Conlinuous, numeric variables within calegornes

© Muliple response data

e | e s ] coce |

The next question asks about the type of data you want to summarize. If you're
unsure, each choice displays different examples.

» Select Continuous, numeric data (interval, ratio).
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Figure 2-7
Selecting a different data type

What kind of data do you want to
summarize?
Data in categones (nominal, ordinal)

@ | Continuous, numeric data (interval, ratio)

 Conlinuous, numeric variables within calegones

C Multiple response data

15 e | et

The example changes to reflect your choice. If you're still unsure, you can:
» Click More Examples.

A new example of the same data type is displayed. If the examples don’t provide
enough information, you can:

» Click Help.



23

Using the Help System

Figure 2-8
Statistics Coach Help topic

<8 Help - Microzoft Internet Explorer !EIE
-

Data Types

Categorical data are data with a limited number
of distinct values ar categaries (far example,
gender or religion). Also referred to as
qualitative data. Categorical variahles can be
string (alphanurmeric) data or numeric variables
that use a numeric codes to represent
categories (far example, 0=Female and 1 =
LETEN

Mominal data are categorical data where there
is nainherent arder to the categories. For
example, a job category of "sales" isn't higher or
lower than a job category of"marketing” or
"research”

Ordinal data are categorical data where thereis =
a meaningful order of categories, butthere isnt
ameasurable distance between categaries. Far
example, there is an order to the walues high,
medium, and low, hutthe "distance" between

the values can't be calculated.

In this example, the Help topic defines the different data types.
» Close the Help window.

» Select Data in categories (nominal, ordinal) and click Next.
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» Select Tables and numbers and click Next.

Figure 2-9
Selecting tables or charts

Vihat kind of display do you want?

& Tables and numbers

© Chars and graphs
Cumulative

Marital Slatus Valid Percent Pareant

Married 530 530

Wlidawed 11.0 B0

Divorced 14.2 783

‘Separated A 7 B0
Mavar married 181 1000
Total 100.0

More Examples Help | Back | hex| Cancel |
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» Select Individual case listings within categories.

Figure 2-10
Statistics Coach, final step

§? Statistics Coach

Vihat kind of summarny do you wani?

© Counts or parcentagas by categony

Employee | Employment
Code Calzgory
46 | Clerical

AT | Clerical

C Counts of parcaniagas for caleqories of ona
within of anather as

18 | Custodial & Indiidual tase lisings within categanes

49 | Clerical
50 | Manager
a1 | Clerical
52 | Clerical
53 | Manager
a4 | Clerical
55 | Clerical

1
2
3
F]
5
&
7
g

More Examples Help | Back | Finish | Cancel |

When the Statistics Coach has enough information, the Next button changes to Finish.
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When you click Finish, the dialog box for the selected procedure opens
automatically, and a Help topic for the procedure is also displayed.

Figure 2-1
Dialog box and Help topic

t Summarize Cases

b Mge in vears [age] Varniahlas:

3 How To - Mictasolt Internet Explorer !EB

To Obtain Individual Case Listings in

|

Categories Cancel
From the menus choose; Help
Anatyze blafs}
Reports

Case Summaries.,
Selectone or more variables

Select a categaorical grouping variable that diide
your data into subgroups.

The categarical grouping variabla can be 2 Optens
sling alphanumenic) variable or @ numeric _i
variable thal use numeric codes 1o represent
categoties (eg., O=iale, 1=Female).

Tell me more... I

Thisis acustom Help topic, based on your selectionsin the Statistics Coach. Since
some dialog boxes perform numerous functions, more than one path in the Statistics
Coach may lead to the same dialog box, but the instructions in the Help topic may
be different.

» Click Tell me more in the Help topic to get more detailed information.



Figure 2-12
“Tell me more” Help topic

2 Data Requirements - Microzoft Intemnet Explorer

Uze one or marevariables ag

summary variables.

Yfau can aptionally disable display
of indiidual cages. In thal case,

1 Summarize Cazes

Using the Help System

You con opticnally
disable the display of
individual cases ar
limit the number of
coses displayed

L

warigbles

Use the Statistics
button to select
stetistics apprapricte
for your summery

summanvanables, These shauld I
bz the variables for which yauwant aisbles: [ ;’U“m,f;ﬁ,.“f;'r‘.'fb'f;"*
Lo displayvalues and compule Y] Only numeric variables
surmmary siatislics. Individual case P& will shaw grou
values will be displaved far all ")I&N&ﬁua —Jstatistics in the output,
summany variables, bul statistics E Fesst
will only be cormpuled for numeri;
variables. Cancel
|

Use optional categarical varables Use optional cotegorical
(numerically coded or sting) as :m:g::: O;hgerﬁgguhm
grouping variables. Slah.slll:s am Grovping Varable(s} sumrnal",-.ﬂill be braoken
compuied separately for each % ndany dawn by these groups.
aroup defined by & grauping s T T
varlable m & region I 1 It 1

- industry | region id | revenue h
Some stalistics, such as the mean =
and standard deviation, are onty [¥ Display casas 3| South 0| 178 I
agpropriate for continuous gritensal) L7 | Uit cases ol I—.Im
data, Others, such as Ihe meadian, - 1| West 1] §4.358 I
minimum and madmum, arg [ Show only vaiid cases
approprizte for ordinal or ™ Shaw cace numbees Shalislics... 2| Maith 12 $3,155
continuous data, Select stabstics - -
thal are appropriale forwour

anb group summary stalislics are
display=d.

Bk E

This Help topic provides detailed information on the data type(s) appropriate for
the selected procedure.

Case Studies

Case studies provide comprehensive overviews of each procedure. Data files used
in the examples are installed with SPSS, so you can follow aong, performing the
same analysis—from opening the data source and selecting variables for analysis to
interpreting the results.

To access the case studies:

Right-click on any pivot table created by a procedure. For example, you can
right-click on the frequency table for Gender.
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Figure 2-13
Accessing the case studies

i Yiewer !EI E

File Edit View Inzert Fomat Analyze Graphs  Utiliies  Window Help

S[ala|n| | @] | Duln @] &)+

E Output ;I
; ] Log
£ {E] Frequencies Gender
-[E] Title o
Motes » Frequency | Percert | “alid Percert F
Walicd Female 493 49.3 493
hzle a07 Wihat's This?
Tatal 1000
Cutt
Copy
Copy objects
Paste Aff
Income categon e
Create/Edit Awtoscnpt
Freguency | | Expart..
“alid  Under 325 264 Fesults Coach
$25 - 343 382 Cage Studies

. | 4] 1

SPSS Pivot Table Object »

» Select Case Studies on the pop-up context menu.

Case studies are not available for al procedures. The Case Studies choice on the
context menu will appear only if the feature is available for the procedure that created
the selected pivot table.
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Reading Data

Data can be entered directly into SPSS, or it can be imported from a number

of different sources. The processes for reading data stored in SPSS data files,
spreadsheet applications, such as Microsoft Excel, database applications, such as
Microsoft Access, and text files are all discussed in this chapter.

Basic Structure of an SPSS Data File

Figure 3-1
Data Editor
Data E ditor |_ (O] x]
File Edit View Data Transform Analwze Graphs  Ubliies  Window Help
S|R|8| B of | L] =|k] sl Flrz| BlEE %
|13: age |33
age marital address incorme inccat caq
1 37 1 12 35.00 2.00
2 33 1 12 29.00 200
3 42 1 21 34.00 200
4 58 0 28 49.00 200
5 56 0 9 57.00 3.00
53 45 0 5 39.00 2.00
7 47 1 4 56.00 3.00
8 B2 1 16 250.00 4.00 |
o £ 1 7 720N 20N 158
« [ v [\ Data view £ Wariable Yiew / I 1T | o[

SPSS data files are organized by cases (rows) and variables (columns). In this data
file, cases represent individual respondents to a survey. Variables represent each
question asked in the survey.

29
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Reading an SPSS Data File

SPSS data files, which have a .sav file extension, contain your saved data. To open
demo.sav, an example file that is installed with the product:

» From the menus choose:
File
Open
Data...

» Make surethat SPSS (*.sav) is selected in the Files of Type drop-down list.
Figure 3-2
Open File dialog box

Open File nm
Look in: | ‘=4 sample_files j - &5 B~

File name:  [demo.sav Open

Files of twpe: ISPSS [ zav] LI Paste

du

Cancel

» Navigate to the sample_files folder.

» Select demo.sav and click Open.
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The data are now displayed in the Data Editor.

Figure 3-3

Opened data file

[z Data Editor
File Edit ‘“iew Data Tranzform Analyze Graphs

Utilities  Window Help

(08| B| o] D =|2] ol Fle=| ElElF @@
|13:age |33
age marital address income inccat caq

1 37 1 12 35.00 200 1

2 33 1 12 29.00 200

3 42 1 1 34.00 200

4 58 0 28 49.00 200

5 56 0 9 57.00 3.00

& 46 0 5 39.00 200

7 47 1 4 56.00 300

g 62 1 16 250.00 4.00
TITl\gata\ﬁewfziariahle\-fiew} ||4T? o - vl

Reading Data from Spreadsheets

Reading Data

Rather than typing all of your data directly into the Data Editor, you can read data
from applications such as Microsoft Excel. You can also read column headings

as variable names.

» From the menus choose:

File
Open
Data...
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» Select Excel (*.xIs) from the Files of Type drop-down list.

Figure 3-4
Open File dialog box
Open File nm
Lok jr: I — sample_files j - EF -
demaxls
File narne: Idemo.xls Dpen I
Files of type: | Excel [%.xk) ~] Paste |
Cancel |
i

» Select demo.xls and click Open to read this spreadsheet.

The Opening Excel Data Source dialog box is displayed, allowing you to specify
whether variable names are to be included in the spreadsheet, as well as the cells that
you want to import. In Excel 5 or later, you can also specify which worksheets

you want to import.

Figure 3-5
Opening Excel Data Source dialog box

C:\Program Files\SPS5 \tutorial's ample_files\damo. «l:

¥ Read variable names from the first row of data:

Werksheet: [demo [41:AB5401] =]

Range: I

0k I Cancel Help |
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» Make sure that Read variable names from first row of data is selected. This option
reads column headings as variable names.

If the column headings do not conform to the SPSS variable-naming rules, they are
converted into valid variable names and the original column headings are saved as
variable labels. If you want to import only a portion of the spreadsheet, specify the
range of cellsto be imported in the Range text box.

» Click OK to read the Excel file.

The data now appear in the Data Editor, with the column headings used as variable
names. If you' re using a spreadsheet application other than Excel or Lotus, you should
be able to export your data to a supported format that can then be read into SPSS.

Figure 3-6
Imported Excel data
Data Editor [ _ O] x]
File Edit ‘iew Data Transform  Analyze  Graphe  Utiltes  Window  Help
S(R1|S| B <[] D] =k sl Flr SlEF[S 2
|‘| - age E
age matital address incorme inccat car 4
1 55 1 12 72.00 3.00 37.00
2 56 o 29 153.00 4.00 76.00
H 28 1 9 28.00 2.00 13.90
4 24 1 4 2R.00 2.00 13.00
5 25 1 2 23.00 1.00 11.30
] 45 1] 9 7B.00 4.00 3730
7 44 1 17 144.00 4.00 7210
] 46 1 20 7a.00 4.00 .10
2 41 1] 10 26.00 2.00 13.00
10 29 0 4 19.00 1.00 960
11 34 0 0 g2.00 4.00 44.40
12 55 0 17 7200 3.00 36.10
13 28 0 9 55.00 3.00 28.20
14 1 1 2 20.00 1.00 960 =z
TITI'(Bata\ﬁew ﬁ:—{fariable Wiew [ Il Hﬁlﬁ o e e 7




34

Chapter 3

Reading Data from a Database

Data from database sources are easily imported using the Database Wizard. Any
database that uses ODBC (Open Database Connectivity) drivers can be read directly
by SPSS after the drivers are installed. ODBC drivers for many database formats are
supplied on the installation CD. Additiona drivers can be obtained from third-party
vendors. One of the most common database applications, Microsoft Access, is
discussed in this example.

» From the menus choose:
File
Open Database
New Query...

Figure 3-7
Database Wizard Welcome dialog box

Database Wizard [ x|

Welcome To the Database Wizard!

Thig wizard will help you select the data elements you wish to work with during pour SPSS session.

Select Data Source;

From which data source(z] would you like to retrieve data? Ea dBASE Files

%B dB aze Files - Word
S ECDCMusic

%i Wizual FoxPro Tables

i i
Add D ata Source. . |
< Back I Mewt » I Cancel | Help

» Select MS Access Database from the list of data sources and click Next.
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If MS Access Database is hot listed here, you need to run Microsoft Data Access
Pack.exe, which can be found in the Microsoft Data Access Pack folder on the CD.

Figure 3-8
ODBC Driver Login dialog box

ODBC Driver Login [ x|

Data Source: M5 Access Database

IC:'\F‘rogram FileshS PSS\ utonalhzample_fleshd

Database

ak. | Cancel

» Click Browse to navigate to the Access database file that you want to open.

Figure 3-9
Open File dialog box

Look in: I — sample_files j - £ -

re== oo = -

adl.zav brakes. sav creditpromo. say
aflatoxin.say Cars.zav :demo. mdb

= . P pa=

autoaccidents. sav cellular. sav demo. zay

E‘t automaton, sps ceramics. sav [Z] demo.tst
] bankloan sav clathing_defects.sav 28] demo.xls
leks] bhelptut. spa cohtacts. zav dietztudy. zav

<] |

File name: |demo.mdb DOpen I
Files af type: |A|| filess 7] =] Cancel |

4

N e L L |

» Select demo.mdb and click Open to continue.

» Click oK inthe login dialog box.
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In the next step, you can specify the tables and variables that you want to import.

Figure 3-10
Select Data step

D atabase Wizard [ x|

Select Data

Move you need to zelect the fields vou wizh to work with, To select items, click on an item in the 'available’ izt and, with
the mouze button pressed, drag it owver to the 'Retrieve Fields' list,

Hint: Diragging a table selects all of itz figlds.

Available Tables:

Retrieve Fields In Thiz Order:

E--% s % demo: D >
..... 2 ADDRESS & demo: AGE
..... % AGE %demo: MARITAL
..... % atﬂ,[\jmn 8 demo: ADDRESS
----- 2 demo: INCOME
----- 8 C4R & demo: INCCAT
""" % EEHEAT %demo: CaR
% EMPCAT 2 demo: CARCAT
..... £ EMpLov %demo: ED
_____ & cenpen 2 dema EMPLOY
_____ demo: RETIRE i

2 D % _I_I
----- 8 NCCAT .4 I K — -
¥ Sort figld names
< Back I Mext = | Finizh | Cancel | Help

» Drag the entire demo table to the Retrieve Fields in This Order list.

» Click Next.
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In the next step, you select which records (cases) to import.

Figure 3-1
Limit Retrieved Cases step

D atabase Wizard [ x|

Limit Retrieved Cases

Limit the cazes that are retrieved by specifving one or more crkernia.

Hint: Figlds and Functions can be added to an expression by dragaing and diopping into an expression cell.

Critenia:

Connector Expression 1 Relation Expression ﬂ

=

Functions

-LlAU?lU‘IJhtAJhJ—\
=
b

ASCH (strexpr) 3 5

CHAR(ascicade) © (RN S ITE

COMCAT (strexpr,stresp € Mative randem sampling & SPSS random sampling
LEFT[strexpr.count]

LTRIM|strewpr] % Spprorimately |1|J :j % of allcases
LENGTHfstesprl ) =

€ Exactly I1IJIJ cages from the first [1000 cages
Prampt FarYalue . | _
< Back I Mext = I Finizh | Cancel | Help |

If you do not want to import al cases, you can import a subset of cases (for example,
males older than 30), or you can import a random sample of cases from the data
source. For large data sources, you may want to limit the number of casesto asmall,
representative sample to reduce the processing time.

» Click Next to continue.
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If you are in distributed mode, connected to a remote server (available with SPSS
Server), the next step allows you to aggregate the data before reading it into SPSS.

Figure 3-12
Aggregate Data step

Aggregate Data

“Y'ou can aggregate your data before retrieving it according to groups defined by break variables or press Nest to
retrieve the orginal cases. The output variables can be renamed on the nesxt panel.

Break ‘ariable(s)
2 dema: MULTLINE ~l
B demes VOICE 2 deme: INCCAT
& demo: PAGER ]
& dema: INTERMNET
& dema: CALLID
& demo: CALLWAIT +| | 2
& dema: DWNTY
& demo: DWwWNVCR — Aggregated Y ariable:
& deme: DwNCD Summaries of Yariable(s)
& dema: DWNPDA, Hame Function \ﬂ
& dema: DWNPC AGE_sum Sum
& demo: DwNFAK 4 CAR_sum Sum
2 dema: NEWS ED_sum sum
& dema: RESFONSE = EMPLOY_sum Sum _ILI
< | » <] | »
¥ Mumber of cazes

Aggregation is only available when connected to SPSS Server

Mesit » | Finizh | Cancel | Help |

You can also aggregate data after reading it into SPSS, but pre-aggregating may
save time for large data sources.

» For this example, you don't need to aggregate the data. If you see this step in the
Database Wizard, click Next.
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Field names are used to create variable names. If necessary, the names are converted
to valid variable names. The origina field names are preserved as variable labels.
You can also change the variable names before importing the database.

Figure 3-13
Define Variables step

D atabase Wizard [ x|

Define Variables
Edit SPS5 vanable names and properties.
Mames will be automatically generated if lsft blank.

To corwert a ztring wariable to numeric uzing the onginal values az value labels, check Recode to Mumenc.

Result Wariable Data Type Recode _tu ;I
Hame Humeric
demao; MARITAL  |MARITAL Mumeric _I
dema; ADDRESS | ADDRESS Mumeric
dema; INCORME IMCOME Mumeric
dema; INCCAT IMCCAT Mumeric
demao; CAR CAR Mumeric
demao; CARCAT  |CARCAT Mumeric
dema: ED ED Mumeric
dema; EMPLOY  |EMPLOY Mumeric
dema: RETIRE RETIRE Mumeric
dema; EMPCAT EMPCAT Mumeric
demo: GENCER. | GENDER Etring |
demn RESINFE RFE=INDF Rumerir: ﬂ
“fidth for variable-width string figlds: =

< Back I Mesit » I Finizh | Cancel | Help |

» Click the Recode to Numeric cell in the Gender field. This option converts string
variables to integer variables and retains the original value as the value label for
the new variable.

» Click Next to continue.

If you arein distributed mode, connected to a remote server (available with SPSS
Server), the next step allows you sort the data before reading it into SPSS.
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You can also sort data after reading it into SPSS, but presorting may save time for
large data sources.

» For this example, you don’t need to sort the data. If you see this step in the Database
Wizard, click Next.

The SQL statement created from your selections in the Database Wizard appears in
the Results step. This statement can be executed now or saved to afile for later use.

Figure 3-14
Results step

Results

Your zelection has rezulted in the fallowing SEL quen:

SELECT ID, AGE, MARITAL, ADDRESS, IMCOME, INCCAT, CAR, CARCAT, ED, EMPLOY, RETIRE. ;I
EMPCAT, GENDER, RESIDE, WIRELESS, MULTLINE, WVOICE, PAGER, INTERMET, CALLID,

CaLlWwWaIT, OwWNTY, OwWHYCR, OWNCD, OWHNPDA, OWNPC, OWwWNFax, NEWS, RESPONSE FROM
demo

—hat would you like to do with this queny?

' Retrieve the data | have selected.

" Paste it into the syntax editor for further modification

— Save quen to file

Browse |

< Back | Hext > T Finish Cancel | Help |

» Click Finish to import the data.
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All of the datain the Access database that you selected to import are now availablein

the SPSS Data Editor.
Figure 3-15

Data imported from an Access database

Data Editor

File Edit ‘iew Data Transform  Analwze  Graphs

Utilitiez  “Window Help

=8| 8] || 0] =|k] &l Fre SEF[S 2
|‘| - age E
age matital address incorme inccat car 4
1 55 1 12 72.00 3.00 37.00
2 56 ] 28 153.00 4.00 76.00
z 28 1 9 25.00 2.00 13.90
4 24 1 4 25.00 2.00 13.00
5 25 1 2 23.00 1.00 11.30
] 45 0 9 76.00 4.00 37.30
7 44 1 17 144.00 4.00 72.10
g 45 1 20 75.00 4.00 37.10
9 41 0 10 26.00 2.00 13.00
10 28 0 4 19.00 1.00 9.60
11 34 0 ] §5.00 4.00 44.40
12 55 0 17 72.00 3.00 36.10
13 28 0 9 55.00 3.00 28.20
14 21 1 2 20.00 1.00 960
TITI'(Bata\ﬁew ﬁ:—{fariable Wiew [ Il Hﬁlﬁ o e T 7

Reading Data from a Text File

Text files are another common source of data. Many spreadsheet programs and
databases can save their contents in one of many text file formats. Comma or
tab-delimited files refer to rows of data that use commas or tabs to indicate each
variable. In this example, the data are tab delimited.
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» From the menus choose:
File
Read Text Data...

» Choose Text (*.txt) from the Files of Type list.

Figure 3-16
Open File dialog box

Open File nn
Look jr: Ia sample_files j - =5 B~

File name: |demo.t:-:t Open

Files of type: | Test *.tu) | Paste |
Cancel |
v

» Select demo.txt and click Open to read the selected file.
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The Text Import Wizard guides you through the process of defining how the specified
text file should be interpreted.

Figure 3-17

Text Import Wizard - Step 1 of 6

Text Import Wizard - Step 1 of 6 m
638 840 1 81 285 ﬂ “weloome bo the test impart wizard!
&) 13

Thiz wizard will help vou read data fram pour text file and
zpecify infarmation about the variables.

A P [oes pour ket file match a predefined format?
1 i Yes Browse.. |
2 o
3
i
«f | »
Tt file: ]
? 1 1ID 1 2ID 1 3ID 1 qID 1 5ID
1| AGEOMARTITALOADDRESSOINCOMEOINCCATOCAROCARCATOEDOEMPLO] -
2| 550101207 . 0003 .00037.00035 . 000102500030£0500010101000
3| (560002590153 .0004.00076.0003.0001035500030x0101000101001
4| E50109028.0002.00015.9001.00030400010£020000000000000 LI
I 0

< Bank I Mest » I Eirat | Cancel | Help |

» In Step 1, you can choose a predefined format or create a new format in the wizard.
Select No to indicate that a new format should be created.

» Click Next to continue.
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As stated earlier, thisfile uses tab-delimited formatting. Also, the variable names
are defined on the top line of thisfile.

Figure 3-18
Text Import Wizard - Step 2 of 6

Text Import Wizard - Step 2 of 6 m

—How are your variables ananged?

# Delimited - Variables are delimited by a specific character (i.e.. comma, tab).

" Fized width - Variables are aligned it fixed width columns.

—Aire wariable names included at the top of your file?

& Yes
" Mg
T et file: 1

1] 10 20 30 40 50
L 1 1 1 1 1 1 1 1 1 1

1| AGEOMARTITALOADDRESSOINCOMEOINCCATOCAROCARCATOEDOEMPLO] -

2| 550101207 . 0003 .00037.00035 . 000102500030£0500010101000

3| (560002590153 .0004.00076.0003.000103500030x0101000101001

4| E50109028.0002.00015.9001.00030400010£020000000000000 LI
KIN| 2]

< Back I Mest » I Firizh | Cancel | Help |

» Select Delimited to indicate that the data use a delimited formatting structure.
» Select Yes to indicate that variable names should be read from the top of thefile.

» Click Next to continue.
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» Type 2 in the top section of next dialog box to indicate that the first row of data
starts on the second line of the text file.

Figure 3-19

Text Import Wizard - Step 3 of 6

Text Import Wizard - Delimited Step 3 of &6 m
The first caze of data begins on which line number? IE 3:

—Huow are pour cages represented?

* Each line represents a case

A specific number of vanables represents a case: I'I 3:

—How many cazes do you want to import?

Al of the cases

™ The first |1 [ilili} cases.

" A random percentage of the cases [approximate]: I'IU 3:

i

—Data previey

[u] 10 20 30 40 S0

L 1 1 1 1 1 1 1 1 1 1
15501012072 . 0003 .00037. 00035 . DDEIlEIZSEIDEISEIfEISEIDEI1EI1EI1E;I
156000250153 .0004.000%6. 0003 . 000103 500030rm010100010

ZE0109028. 0002 . 00013 . 9001 . 00030400010:£0900000000000 ~ |

1| 2

< Back I Mest » I Firizh | Cancel | Help |

» Keep the default valuesfor the remainder of thisdialog box, and click Next to continue.
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The Data preview in Step 4 provides you with a quick way to ensure that your data
are being properly read by SPSS.

Figure 3-20
Text Import Wizard - Step 4 of 6

“w'hich delimiters appear bebween variables? “w'hat iz the text qualifier?

¥ Tab [~ Space & Hone

" Single quote
[~ Comma [ Semicolon

[ Other: I—

" Double quote

" Other; I—

Data preview
w1 w2 Lk V4 5 L] lﬂ
AGE MARITAL ADDRESS INCOME INCCAT CAR CARC
5 1 12 72.00 .00 37.00 3.00
326 u] 29 153.00 4.00 FE.00 3.00
25 1 k] 25.00 2.00 13.90 1.00 vI
| iy

<Back | Mews> | Finish |

» Select Tab and deselect the other options.

» Click Next to continue.
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Because the variable names may have been truncated to fit SPSS formatting
requirements, this dialog box gives you the opportunity to edit any undesirable names.

Figure 3-21
Text Import Wizard - Step 5 of 6
Text Import Wizard - Step 5 of 6 m
— Specifications for vanable(z) zelected in the data previe
Yanable name:
Liata farmat:
IDD Mt Irmpart j
—Data previey
AGE MARITAL ADDRESS IHCOME INCCAT CAR Cﬂﬂ
o5 1 12 72.00 3.00 3700 3.00
a6 u] 28 153.00 4.00 FE.00 3.00
25 1 9 25.00 2.00 1380 1.00
24 1 4 25.00 2.00 13.00 1.00 T
4 | | 3

< Back I Mest » I Firizh | Cancel | Help |

Data types can be defined here as well. For example, it’s safe to assume that the
income variable is meant to contain a certain dollar amount.

To change a data type:

Under Data preview, select the variable you want to change, which is Income in
this case.
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» Select Dollar from the Data format drop-down list.

Figure 3-22
Change the data type

Text Import Wizard - Step 5 of 6 m

— Specifications for variable(z) zelected in the data previe

Wariable name: Origital Hame:

Liata farrmat:

MHumeric hd I

Mumeric
String
D ate,/Time

—Data previey
AGE MARITAL ADDRESS IHCOME INCCAT CAR Cﬂﬂ
o5 1 12 . 3.00 3700 3.00
6 u] 29 4.00 .00 3.00
25 1 9 2.00 1380 1.00
24 1 4 2.00 13.00 100
A I | 3

< Back I Mest » I Firizh Cancel | Help |

» Click Next to continue.
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Text Import Wizard - Step 6 of 6

Text Import Wizard - Step 6 of 6 m

r'ou have successfully defined the farmat of wour test file.

Would pou like to save this file format for future use?
" Yes I
@i

Savebe,, |

@ Mo

Wiould pou like to paste the spntax?
" Yes

¥ Cache data locally

Press the Finizh button to complete the bewt impoart wizard.

— Data preview
AGE MARITAL ADDRESS IHCOME IHCCAT CAR Ci ‘l

a5 1 12 F2.00 3.00 3700 3.0

56 o 29 153.00 4.00 76.00 3.00

258 1 9 25100 200 13.80 1.00

24 1 4 26.00 200 13.00 1.00.%
4 I I b

< Back | [ | Finizh I Cancel | Help

Reading Data

» Leavethedefault selectionsin this dialog box, and click Finish to import the data.

Saving Data

To save an SPSS data file, the Data Editor window must be the active window.

» From the menus choose:

File
Save

» Browse to the desired directory.
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» Type aname for thefile in the File name text box.

The Variables button can be used to select which variables in the Data Editor are
saved to the SPSS data file. By default, all variables in the Data Editor are retained.

» Click Save.

The namein thetitle bar of the Data Editor will change to the filename you specified.
This confirms that the file has been successfully saved as an SPSS datafile. Thefile

contains both variable information (names, type, and, if provided, labels and missing

value codes), and all data values.
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Using the Data Editor

The Data Editor displays the contents of the active data file. The information in the
Data Editor consists of variables and cases.

m In Data View, columns represent variables and rows represent cases
(observations).

m |n Variable View, each row is a variable, and each column is an attribute
associated with that variable.

Variables are used to represent the different types of data that you have compiled. A
common analogy is that of a survey. The response to each question on a survey is
equivalent to avariable. Variables come in many different types, including numbers,
strings, currency, and dates.

Entering Numeric Data

Data can be entered into the Data Editor, which may be useful for small datafiles or
for making minor edits to larger data files.

» Click the Vvariable View tab at the bottom of the Data Editor window.

Define the variables that are going to be used. In this case, only three variables are
needed: age, marital status, and income.

51
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Figure 4-1
Variable names in Variable View
Data Editor |_ O] x|
File Edit Miew Data Transform Analwee  Graphs  Utilitie:  Window  Help
zlE|S| B] o|| L] k]l Fe BEE 2
Mame Type YWidth | Decimals Label Yalue 2
1|age Mumeric 8 2 Mane
2| rnarital MNumeric 8 2 MNone
3lincome Numeric 8 2 MNone
4
3
5
¥
a
g
10
11
12
13
14
15
15 et
« [+ [\ Data ¥iew pVariable View / 1] | D

» Inthefirst row of the first column, type age.
» Inthe second row, type marital.

» In the third row, type income.
New variables are automatically given a numeric data type.

If you don't enter variable names, unique names are automatically created. However,
these names are not descriptive and are not recommended for large datafiles.

» Click the Data View tab to continue entering the data.

The names that you entered in Variable View are now the headings for the first three
columns in Data View.
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Using the Data Editor

Begin entering data in the first row, starting at the first column.

Figure 4-2
Values entered in Data View
Data Editor !Elm
Fil= Edit iew Data Transform  Analyze Graph:  Utilities  window  Help
SR8 B ol 1] =]k 6l Fl= BlEE S 2
|34: |
age marital Income Al war At =
1 55.00 1.00 F2000.00
2 53.00 00| 153000.00
4
A
3
A
W
g
2]
10
11
12
13
14 =
TITI‘;Bata\ﬁew;{Variable View J s | v[

In the age column, type 55.

In the marital column, type 1.

In the income column, type 72000.

Move the cursor to the first column of the second row to add the next subject’ s data.
In the age column, type 53.

In the marital column, type 0.

In the income column, type 153000.
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Currently, the age and marital columns display decimal points, even though their
values are intended to be integers. To hide the decimal pointsin these variables:

» Click the variable View tab at the bottom of the Data Editor window.
» Select the Decimals column in the age row and type 0 to hide the decimal.

» Select the Decimals column in the marital row and type 0 to hide the decimal.

Figure 4-3
Updated decimal property for age and marital
D ata Editor | _ (O] x|
Eile Edit Miew Data Transform  Analwze  Graphs  Utilities  indow Help
S|H|S| =] ol L] =|k| & A BEE [ 2
MName Type YWidth | Decimals Label Walueg 2
1|age MNumeric g 0 Mane
2| marital MNumeric g 0 Mane
3|income MNumeric g 2 Mane
4
5
B
7
g
g
10
11
12
13
14
15
16 il
4 [+ [\ Data ¥iew »Variable View 4] | ol .
Entering String Data

Non-numeric data, such as strings of text, can aso be entered into the Data Editor.
» Click the variable View tab at the bottom of the Data Editor window.

» Inthefirst cell of the first empty row, type sex for the variable name.
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Using the Data Editor

» Click the button in the Type cell to open the Variable Type dialog box.

Figure 4-4
Button shown in Type cell for sex

Data Editor !Elm
File Edit Miew Data Transform Analwee  Graphs  Utilitie:  Window  Help
S|R|8| B || B =|k| 6] EE= BlEE [ 2
Mame Type Width | Decimals Label =
1|age Mumeric 8 0 {
2| marital Mumeric 8 0 {
3lincome Numeric 8 0 I
4|sex MNurmeric 8 0 I
5
)
7
g
g
10
11
12
13
14
15
16 X
« [+ [\ Data ¥iew pVariable View / 1] | o[

» Select String to specify the variable type.
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» Click OK to save your changes and return to the Data Editor.

Figure 4-5
Variable Type dialog box

Vanable Type n m

' Mumeric oK
" Comma
" Dot
" Scientific notation Characters IB_ Help
" Date

" Dollar

" Custom curency

# Sting

Cahcel

uili

Defining Data

In addition to defining data types, you can a so define descriptive variable and value
labels for variable names and data values. These descriptive labels are used in
statistical reports and charts.

Adding a Variable Label

Labels are meant to provide descriptions of variables. These descriptions are often
longer versions of variable names. Labels can be up to 256 characters long. These
labels are used in your output to identify the different variables.

Click the variable View tab at the bottom of the Data Editor window.
In the Label column of the age row, type Respondent's Age.

In the Label column of the marital row, type Marital Status.

vV v v Vv

In the Label column of the income row, type Household Income.
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» Inthe Label column of the sex row, type Gender.

Figure 4-6
Variable labels entered in Variable View
Data Editor !Elm
File Edit Miew Data Transform Analwee  Graphs  Utilitie:  Window  Help
SR8 B ol B =]k 6l == BlEE T 2
MName Type YWidth | Decimals Label =
1|age Mumeric 8 0 Respondent's Age i
2| rnarital MNumeric 8 0 Marital Status i
3lincome Numeric 8 2 Household Income I
4] sex String g 0 Gender i
3
5
¥
a
g
10
11
12
13
14
15
15 i
« [+ [\ Data ¥iew pVariable View / 1] | o[

Changing Variable Type and Format

The Type column displays the current data type for each variable. The most common
are numeric and string, but many other formats are supported. In the current data
file, the income variable is defined as a numeric type.

» Click the Type cell for the income row, and then click the button to open the Variable
Type dialog box.
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» Select Dollar in the Variable Type dialog box.

Figure 4-7
Variable Type dialog box
Variable Type nm
£tz TR = =
" Comma $H A g —I |—I
S Hit ] Cancel |
¢ Dot | s
€ Scientific notation BRI Help
Scientific natation R L. ;I 4'
" Date
&+ Dollar widih: Iﬁ
" Custom currency Decimal Placoe ID_
r"' St_l'lng ecimal Flaces:

The formatting options for the currently selected data type are displayed.
» Select the format of this currency. For this example, select S ### #t.

» Click OK to save your changes.

Adding Value Labels for Numeric Variables

Value labels provide a method for mapping your variable valuesto astring label. In
the case of this example, there are two acceptable values for the marital variable.

A value of 0 means that the subject is single, and a value of 1 means that he or

she is married.

» Click the Values cell for the marital row, and then click the button to open the Value
Labels dialog box.

The value is the actual numeric value.

The value labél isthe string label applied to the specified numeric value.
» Type 0 inthe Vauefield.

» Type Single in the Value Label field.
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» Click Add to add this label to the list.

Figure 4-8
Value Labels dialog box

WYalue Labels [ 7] x|

—Value Labels o

Value:

Cancel
Value Label:

Bl

Help

Add ="
1

"M arried"
Change |
Bemove |

» Repeat the process, thistime typing 1 in the Value field and Married in the Value
Labdl field.

» Click Add, and then click OK to save your changes and return to the Data Editor.

These labels can also be displayed in Data View, which can help to make your data
more readable.
» Click the Data View tab at the bottom of the Data Editor window.

» From the menus choose:
View
Value Labels

The labels are now displayed in alist when you enter values in the Data Editor. This
has the benefit of suggesting avalid response and providing amore descriptive answer.
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Figure 4-9
Value labels displayed in Data View
Data Editor !Elm
Eile Edit Miew Data Transform  Analwze  Graphs  Utilities  indow Help
=S| B o] L] k] sl FHe BlalE [ 2
|34: |
age marital Income SeX war yar :
1 55| Married $72,000
2 53| Single $153 000
il
4
5
B
¥
g
g
10
11
12
13
14 5
<[> I‘;E)ata\ﬁew;(\fariable View [ |4 | ol

Adding Value Labels for String Variables

String variables may require value labels as well. For example, your data may use
single letters, M or F, to identify the sex of the subject. Value labels can be used to
specify that M stands for Male and F stands for Female.

» Click the Vvariable View tab at the bottom of the Data Editor window.

» Click the Values cell in the sex row, and then click the button to open the Value
Labels dialog box.

» TypeF inthe Vauefield, and then type Female in the Value Label field.
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» Click Add to add thislabel to your datafile.

Figure 4-10
Value Labels dialog box
WYalue Labels [ 7] x|
—Value Labels g |
Value:
Cancel |
Value Label:
Help |
Sdd F ="Female"

b = "h ale"
Change |

» Repeat the process, this time typing M in the Value field and Male in the Value
Labdl field.

» Click Add, and then click OK to save your changes and return to the Data Editor.

Because string values are case sensitive, you should make sure that you are consistent.
A lowercase mis not the same as an uppercase M.

Using Value Labels for Data Entry

In a previous example, we chose to have value labels displayed rather than the
actual data by selecting value Labels from the View menu. You can use these values
for data entry.

» Click the Data View tab at the bottom of the Data Editor window.

» Inthefirst row, select the cell for sex and select Male from the drop-down list.
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» Inthe second row, select the cell for sex and select Female from the drop-down list.

Figure 4-1

Using variable labels to select values

Drata Editor

Eile Edit “iew Data Transform  Analyze  Graphs

Utilities  *indow Help

&S| B »|| L] =| k| &l £ 2lEE [ @

|2: -1 |F
age matital income Se¥ WAL war
1 55 hlarried 572000 | hale
2 a3 Single 153000 [Female =
3
4 hiale
5
]
7
g
g
10
11
12
13
14
TITI'{Bata\ﬁewAVariable View f | |

A

Only defined values are listed, which helps to ensure that the data entered arein a
format that you expect.

Handling Missing Data

Missing or invalid data are generally too common to ignore. Survey respondents may

refuse to answer certain questions, may not know the answer, or may answer in

an unexpected format. If you don't take steps to filter or identify these data, your

analysis may not provide accurate results.
For numeric data, empty datafields or fields containing invalid entries are handled

by converting the fields to system missing, which is identifiable by a single period.
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Figure 4-12
Missing values displayed as periods
Data Editor [ _ O] x]
File Edit ‘iew Data Transform  Analyze  Graphe  Utiltes  Window  Help
=(R1S| B of| L] =0 sl Flr Sl&F[S 2
|‘IS: income |
age marital income Sex war war =
1 55 hlarried 72000 | Male
2 a3 Single $153 000 |Female
3
il
5
]
7
g
o
10
11
12
13
14 =
TITI'(Bata\ﬁew;{Variable Wiew [ |l | e[

The reason avalue is missing may be important to your analysis. For example, you
may find it useful to distinguish between those who refused to answer a question and
those who didn’'t answer a question because it was not applicable.

Missing Values for a Numeric Variable
» Click the variable View tab at the bottom of the Data Editor window.

» Click the Missing cell in the age row, and then click the button to open the Missing
Values dialog box.



64

Chapter 4

In this dialog box, you can specify up to three distinct missing values, or a range of
values plus one additional discrete value.

Figure 4-13
Missing Values dialog box
Mizsing Yalues HEA
Mo missing values

&' Discrete missing values Cancel |
ISSE‘ I I Help |

" Bange plus one optional discrete missing value

Low | Hidtr: |

[rizcrete walue: I

» Select Discrete missing values.
» Type999 in the first text box and leave the other two empty.

» Click OK to save your changes and return to the Data Editor.

Now that the missing data value has been added, alabel can be applied to that value.

» Click the Values cell in the age row, and then click the button to open the Value
Labels dialog box.

» Type 999 in the Vaue field.

» Type No Response in the Value Label field.

Figure 4-14
Value Labels dialog box

Value Labels [ 7] x|

—Walue Labels K
Walue: 933

Cancel

“alue Label: |Mo Response

il

Help
Add

Change |
Eemove |
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» Click Add to add thislabel to your datafile.

» Click OK to save your changes and return to the Data Editor.

Missing Values for a String Variable

Missing values for string variables are handled similarly to those for numeric values.
Unlike numeric values, empty fields in string variables are not designated as system
missing. Rather, they are interpreted as an empty string.

» Click the Vvariable View tab at the bottom of the Data Editor window.

» Click the Missing cell in the sex row, and then click the button to open the Missing
Values dialog box.

» Select Discrete missing values.

» TypeNR in the first text box.

Missing values for string variables are case sensitive. So, avalue of nr is not treated
as amissing value.

» Click OK to save your changes and return to the Data Editor.

Now you can add a label for the missing value.

» Click the Values cell in the sex row, and then click the button to open the Value
Labels dialog box.

» Type NR in the Value field.



66

Chapter 4

» Type No Response in the Value Label field.

Figure 4-15
Value Labels dialog box

WYalue Labels [ 7] x|

—Value Labels

[
Value: HR

Cancel
Walue Label: |Mo Responze

Bl

Help
Add F ="Female"
b = "h ale"
Change |
Bemove |

» Click Add to add this label to your project.

» Click OK to save your changes and return to the Data Editor.

Copying and Pasting Value Attributes

Once you’ ve defined variable attributes for a variable, you can copy these attributes
and apply them to other variables.
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» In Variable View, type agewed in thefirst cell of the first empty row.

Figure 4-16

agewed variable in Variable View

Data Editor
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Utilitiez  “Window Help

2| |8| B || B || 6 Eli=| BlEE 2
Name Type Width | Decimals Label
1|age Mumeric 8 0 Respondent's Age {
2| marital Mumeric 8 0 harital Status {
3lincome Dallar 12 0 Househald Income r
4] sex String 8 0 Gender {
5| agewed Mumeric 8 2 Age Married I
]
7
g
o
10
11
12
13
14
15
16
1 [+ [\ Dataview hVariableview /|| |

» Inthe Label column, type Age Married.

» Click the Values cell in the age row.

» From the menus choose:

Edit
Copy

» Click the Values cell in the agewed row.

» From the menus choose:

Edit
Paste
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The defined values from the age variable are now applied to the agewed variable.

16

4 [ » [\ Data iew ) Variable View / [4] |

Figure 4-17
Values pasted for agewed
Data Editor | _ O] x|
File Edit iew [Data Transform  Analyze  Graphs  Ublities  Window  Help
= = I e A N == e =)
Type YWidth Decimals Label YWalues i 2
1| Murneric 8 n} Respondent's {993, Mo Resp |299
2 Numeric 9 0 Marital Status {0, Singlel...  |Mone
3| Dollar 12 a Household Inc [Mone Mone
4| String 8 0 Gender {F, Female}... |NR
alMumeric g 2 Age Married {99300, Mo Re|Mone
B
7
&
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To apply the attribute to multiple variables, ssimply select multiple target cells (click
and drag down the column).

Figure 4-18

Multiple cells selected

Data Editor !Elm
File Edit iew [Data Transform  Analyze  Graphe  Ublities  Window  Help
2| |8 8| of | 1] =[] sl E[r= B[%]E |9
YWidth | Decimals Label “Walues hdissing Colu2

115 0 Respondent’s ({999, Mo Resp (999 g

2|9 0 Marital Status [{0, Singlel..  |Mone a

3|12 n} Househald Inc [Mane Mane 9

415 0 Gender {F, Female}... (MR g

=1 [ 2 Age Married  [{999.00, Mo Re|Mone g

= |

= |

= -

10

11

12

13

14

15

16 >
4 [ » [\ Data view } variable View / [4] | el .
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When you paste the attribute, it is applied to al of the selected cells.

Figure 4-19
Values pasted into multiple cells
D ata Editor | _ O] x|
File Edit iew [Data Transform  Analyze  Graphs  Ublities  Window  Help
= = I e A N == e =)
MName Type Width | Decimals Label Yalue 2
1|ane Murneric 8 0 Respondent's ({993, Mo
2| marital Mumeric 9 0 harital Status ({0, Single
3lincome Dallar 12 0 Household Inc |Mone
4] sex String 8 0 Gender {F, Fema
ol agewed MNumeric g 2 Age Married  [§299.00
B|var00001T  [Mumeric g 2 §999.00, 1
7|vard0002  [Mumeric g 2 999.00, 1
g|vard0003  [Mumeric g 2 §999.00, 1
4
10
11
1
13
14
15
16 bl
4 [+ [\ Data view j Variable View [ 4] | ol

New variables are automatically created if you paste the values into empty rows.

You can also copy al of the attributes from one variable to another.
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» Click the row number in the marital row.

Figure 4-20
Selected row

Data Editor =] B3

Fil= Edit iew Data Transform  Analyze Graph:  Utilities  window  Help

S|R(3| B o] B =k] 6l Fe= BlElE T 2
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|vard000Z  [Mumeric |3 2 {999.00, Mo R
Blvard0003 [Mumeric |3 2 {999.00, Mo R
5|
10
11
12
13
14
15
X i | o

4 [ » [\ Data view } variable View O |E »

» From the menus choose:
Edit
Copy

» Click the row number of the first empty row.

» From the menus choose:

Edit
Paste
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All of the attributes of the marital variable are applied to the new variable.

Figure 4-21
Values pasted into row

Data Editor [ _ O] x]
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Defining Variable Properties for Categorical Variables

For categorical (nominal, ordinal) data, Define Variable Properties can help you
define value labels and other variable properties. Define Variable Properties:

m  Scansthe actual data values and lists all unique data values for each selected
variable.

m |dentifies unlabeled values and provides an “auto-label” feature.

m  Provides the ability to copy defined value labels from another variable to the
selected variable or from the selected variable to multiple additional variables.
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This example uses the data file demo.sav. This data file already has defined value
|abels; so before we start, let’ s enter avalue for which there is no defined value | abel:

In Data View of the Data Editor, click the first data cell for the variable ownpc (you
may have to scroll to the right) and enter the value 99.

From the menus choose:

Data
Define Variable Properties...

Figure 4-22
Initial Define Variable Properties dialog box

Define ¥ariable Properties

Select the varables to scan. They should be categorical [nominal Cancel |
or ordinal] for best rezults. vou can change the measurement level |

zetting in the nest panel. Help

Llze thiz facility ta label wariable values and set other properties after
zcanhing the data.

Yarnables:

& Call waiting [call.. =]
& Caller 1D [calid]
Gender [gender]

& Household inco...
Ihcome categony...

f Intermnet [internet]

Varniables to Scan:

fﬂwns computer [ow...
& Dins far maching ..
fﬂwns PD& [ovwnpda)
& Dwins stereo/CD pla...
&Dwns T [owrity]
fﬂwns VR [owrver]

& Job satisfaction [ ..

& Level of educati..

f M arital status [m...

f Fultiple lines [mu...
Mewspaper subs...

& Newspaper aits.. |

[ Limit number of cases scanned bo:

v Limit number of values displayed to: 200

Intheinitial Define Variable Properties dialog box, you select the nominal or ordinal
variables for which you want to define value labels and/or other properties.

Since Define Variable Properties relies on actual values in the data file to help you
make good choices, it needs to read the datafile first. This can take sometime if your
data file contains a very large number of cases, so this dialog box also allows you
to limit the number of cases to read, or scan. Limiting the number of casesis not
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necessary for our sample datafile. Even though it contains over 6,000 cases, it
doesn’t take very long to scan that many cases.

Drag and drop Owns computer [ownpc] through Owns VCR [ownvcr] into the
Variables to Scan list.

You might notice that the measurement level icons for all of the selected variables
indicate that they are scale variables, not categorical variables. By default, all numeric
variables are assigned the scale measurement level, even if the numeric values are
actually just codes that represent categories. All of the selected variablesin this
example are really categorical variables that use the numeric values 0 and 1 to stand
for No and Yes, respectively—and one of the variable properties that we'll change
with Define Variable Properties is the measurement level.

Click continue.

Figure 4-23
Define Variable Properties main dialog box
Define Yariable Properties [ X]
Scanned YWariable List Current Yariable: IDWHDC Label: |Dwns compLter
U| M..I Y ariable Meazurement LeveI:IScale vI Sugaest | Tvpe: INumeric ;” ;I
- oWnpC . .
@ f e Urlabeled values: I1 twfidth: |4 Qemmals:lﬂ
% § Dwnpja Yalue Label grid: o Enter or edit labels in the grid. “v'ou can enter additional values at the baottom.
Jarate?
@ f oy Changed Mis=ing Count Value Label
O & owrver 1 r C 3588 0|Ma
2 - [ 2811 1[ves
E r C 1 99
4 - r
KN — 2l
Copy Propertie: Unlabeled ¥ alues
Cases scanned: [oa00 ’7 From Another W ariable. .. | To Other Y ariables. . | ’7 Automatic Labels |
Waluie list limnit: 200 K I Baste | Beset | Cancel | Help |

» Inthe Scanned Variable List, select ownpc.
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The current level of measurement for the selected variable is scale. You can change
the measurement level by selecting one from the drop-down list or you can let Define
Variable Properties suggest a measurement level.

Click Suggest.

Figure 4-24
Suggest Measurement Level dialog box

Define ¥ariable Properties: Suggest Measurement Level E2

Variable: Iownpc Continue
Currert Meazurement Level: Is cale Cancel
Suggested Level: IDrdinaI or Mominal

Help

dil

Explanation: ownpc has only small, nonnegative, integer values and
does not have a large numer of different values.

& nominal level is one where the vanable values do not have a natural
ranking, for example names of countries.

An ordinal level is one where the vanable values have a natural order
but differences between values are not meaningful, for example,
importance of a political position coded "'low", "medium'’, and "high"".

A goale level is one where the differences between variable values are
comparable, for example, age it pears.

The suggested meazurement level is bazed on empirical rules and iz not
a substitute far uzer judgrent.

SPSS uszes the measurement level in some cases to determine whether
the variable defines categories in a table or graph or is to be summarzed.

Since the variable doesn’'t have very many different values and all of the scanned cases
contain integer values, the proper measurement level is probably ordinal or nominal.

Select Ordinal and then click Continue.
The measurement level for the selected variable is now ordinal.

The Value Labels Grid displays all of the unique data values for the selected variable,
any defined value labels for these values, and the number of times (count) each
value occurs in the scanned cases.
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>

>

>

The value that we entered, 99, is displayed in the grid. The count isonly 1 because
we changed the value for only one case, and the Label column is empty because we
haven’t defined a value label for 99 yet. An X in the first column of the Scanned
Variable List also indicates that the selected variable has at least one observed value
without a defined value label.

In the Label column for the value of 99, enter No answer.

Then click (check) the box in the Missing column. Thisidentifies the value 99 as user
missing. Data values specified as user missing are flagged for special treatment and
are excluded from most calculations.

Figure 4-25
New variable properties defined for ownpc
Define ¥Yariable Properties
Soanned Yanable List Cument Warable: Iownpc Label: IDwns computer
lé‘ |.M | Wariable Measurement Level: IDrdinaI 'I Suggest | Tupe: INumeric L” ;I
OWHPC o o
@ & owrla Urlabeled values: ID “width: |4 QBC"'“EHS-IU
@ f ownpda . ) . . "
@ & e Walue Label grid: Enter ar edit labels in the grid. 'ou can enter additional values at the battom.
@ f by Changed | Missing Count Value Label
O ¢ owrver 1 r [ 3568 0|hla
2 r C 2811 1|ves
3 ~ Il 1 29 | Mo answer
4 - ~
KN — 2l
Copy Propertie Unlabeled ' alues
Cases scanned: [5ann ’7 From Anather Yariable. .. Tao Other Yariables... | ’7 Autornatic Labels |

W alue list limit: 200

Paste | Reset | Cancel | Help |

Before we complete the job of modifying the variable properties for ownpc, let’s
apply the same measurement level, value labels, and missing values definitions to
the other variablesin the list.

In the Copy Properties group, click To Other Variables.
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Figure 4-26
Apply Labels and Level dialog box

Apply Labels and Level Lo
Select the variables that the curent “
wariable's walue labels,
measurement level, missing value |
definition, and farmat will be copied Lz

to. [Walue labels and miszing walues
are merged ) Help |

Wariables:

Inthe Apply Labels and Level dialog box, select al of the variables in the list, and
then click Copy.
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If you select any other variablein the list in the Define Variable Properties main
dialog box now, you'll see that they are all now ordinal variables, with a value of 99
defined as user missing and a value label of No answer.

Figure 4-27
New variable properties defined for ownfax
Define ¥ariable Properties
S Vi L Curent Warable: Iownfa:-c Label: IDwns fax machine
lﬁlﬁlﬂll ‘Y ariable teazurement Lewvel: IDrdinaI VI Suggest | Tupe: INumeric LII LI
awnpc . .
B[ ownfex Unlabeled values: ID twfidth: |4 Demmals:lﬂ
E onnpda Walue Label grid: o Enter or edit labels in the grid. “ou can enter additiohal values at the bottom.
@ owncd
@ El oty Changed Missing Count Yalue Label
@ B ownver 1 - I 51498 0/|Mao
2 C C 1202 1|ves
3 3 ¥ i 99 |hla anzwer
3 = =
KN — 2l
Copy Propertie Unlabeled ' alues
Cases scanned: [5ann ’7 From Anather Yariable. .. | Tao Other Yariables... I ’7 Autornatic Labels |
Yalue list mit. |20 0k | Paste | Reset | Cancel | Hep |

» Click OK to save all of the variable properties that you have defined.
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Examining Summary Statistics
for Individual Variables

This chapter discusses simple summary measures and how the level of measurement
of avariable influences the types of statistics that should be used. We will use the
data file demo.sav.

Level of Measurement

Different summary measures are appropriate for different types of data, depending
on the level of measurement:

Categorical. Data with alimited number of distinct values or categories (for example,
gender or marital status). Also referred to as qualitative data. Categorical variables
can be string (alphanumeric) data or numeric variables that use numeric codes to
represent categories (for example, 0 = Unmarried and 1 = Married). There are two
basic types of categorical data:

m Nominal. Categorical datawhere there is no inherent order to the categories. For
example, ajob category of “sales’ isn't higher or lower than ajob category of
“marketing” or “research.”

m  Ordinal. Categorical data where there is a meaningful order of categories, but
there isn’t a measurable distance between categories. For example, thereis
an order to the values high, medium, and low, but the “ distance” between the
values can’t be calcul ated.

79
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Scale. Data measured on an interval or ratio scale, where the data values indicate
both the order of values and the distance between values. For example, a salary of
$72,195 is higher than a salary of $52,398, and the distance between the two valuesis
$19,797. Also referred to as quantitative or continuous data.

Summary Measures for Categorical Data

>

For categorical data, the most typical summary measure is the number or percentage
of casesin each category. The modeisthe category with the greatest number of cases.
For ordinal data, the median (the value above and below which half the cases fal)
may also be a useful summary measure if thereis alarge number of categories.

The Frequencies procedure produces frequency tables that display both the number
and percentage of cases for each observed value of avariable.

From the menus choose:

Analyze
Descriptive Statistics
Frequencies...

Select Owns PDA (ownpda) and Owns TV (owntv) and move them into the Variable(s)
list.

Figure 5-1
Categorical variables selected for analysis
& Income category inﬂ il
® Internet [internet] ® Dwns PDA [ownpda]
A Level of education @ Dwns TV [ownty] ﬂl
< Marital status [marit Reset |
@ Multiple lines [multh C I
@ Newspaper subscri ﬂl
® Mumber of people | Help |
& Owns compuiter [ov
¥ Display frequency tables
Statistics... | Charts... Format... |

Click OK to run the procedure.
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Figure 5-2
Frequency tables

s Viewer !EI n

File Edit View Insert Fomat Analyze Graphs  Utilities ‘Window Help

=[S » = o] Bleb] @ & ]
—— 3]

Frequencies Owns PDA
Title
Motes Cumnulative
@ Statistics 5 Freguency Percent Walid Percent Fercent

] Frequency 1 Valid Mo 5077 783 EE EE
- Title Ves 1323 20.7 207 1000 J
oLl Owns P Tatal B400 100.0 100.0

[E] Bar Chart
e [ Title

Owns TV
Cumulative
Freguencies | Frequency Percent Walid Percent Percent
Title valid Mo 54 ] ] E
) Motes Yes G346 992 932 100.0
L statistics Total B400 100.0 100.0

Liogy - -
a | <] | L

The frequency tables are displayed in the Viewer window. The frequency tables
reveal that only about 21% of the people own PDAS, but almost everybody ownsa TV
(99.2%). This might not be an interesting revelation, although it might be interesting
to find out more about the small group of people who do not own televisions.

Charts for Categorical Data

You can graphically display the information in a frequency table with a bar chart
or pie chart.

» Open the Frequencies dialog box again. (The two variables should still be selected.)
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You can use the Dialog Recall button on the toolbar to quickly return to recently
used procedures.

Figure 5-3
Dialog Recall tool

» Click Charts.

» Select Bar charts and then click Continue.

Figure 5-4
Frequencies Charts dialog box
Frequencies: Charts m
~Chart Type————————————
" Mone
- Cancel
@ Bar charts _I
" Pie charts il
" Histograms
I~ with nomal curye

r— Chart Values

@ Frequencies " Percentages

» Click oK in the main dialog box to run the procedure.
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Figure 5-5
Bar chart

s Viewer !El E

File Edit “iew Insert Format Analyze Graphs  Ulilities ‘window  Help

==|S|2 el = ] Ble=k| @ & 1|
Output B Owns PDA, il

(3 Log B0
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(75 Log 1000
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-[E Ttle

4000

Frequency

Lg o
% ox: Owing TV
;'IE Bar Char = onn '| | -
o 1 o)Al | H 4

In addition to the frequency tables, the same information is now displayed in the form
of bar charts, making it easy to see that most people do not own PDASs but almost
everyone ownsaTV.

Summary Measures for Scale Variables

There are many summary measures available for scale variables, including:

m  Measures of central tendency. The most common measures of central tendency
are the mean (arithmetic average) and median (value above and below which
half the cases fall).

m  Measures of dispersion. Statistics that measure the amount of variation or spread
in the datainclude the standard deviation, minimum, and maximum.

» Open the Frequencies dialog box again.
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» Click Reset to clear any previous settings.

» Select Household income in thousands (income) and move it into the Variable(s) list.

>

Figure 5-6

Scale variable selected for analysis

W anable(s):
L Househaold income i t

@ Age inyears [age] | -
@ Call waiting [eallwa
@ Caller D [calid]

[A} Gender [gender]

® Income category in
& Intemnet [internet]

& Level of education

< Warital status [marit
A i T _......:LI

[

[~ Display frequency tables

Statistics...

Charts...

Format...

ak
Paste
Feset
Cancel

Help

Elilele[-

Click statistics.

» Select Mean, Median, Std. deviation, Minimum, and Maximum.

>

Figure 5-7

Frequencies Statistics dialog box

Frequencies: Statistics

 Percentile alues

[™ Duartiles
[~ Cut paints for IT equal groups
[~ Percentile(s]: I_
Add
LChange
Hemove
— Dizperzion

¥ Std deviation [V Minimum
[ Wariance ¥ W aximum
[ Range [~ 5E mean

— Central Tendency
¥ tean

¥ Median

™ Mode

™ Sum

r— Distribution
[" Skewness

[ Kurtosis

™ Walues are group midpoints

Contirue

Cancel

dil

Help

Click continue.
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» Deselect Display frequency tables in the main dialog box. (Frequency tables are usually
not useful for scale variables since there may be amost as many distinct values as
there are cases in the data file.)

» Click OK to run the procedure.

The Fregquencies Statistics table is displayed in the Viewer window.

Figure 5-8
Frequencies Statistics table

= Yiewer !El m

File Edit “iew Inzert Format Analyze Graphs  Utlites  Window  Help
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@ Cravn Std. Deviation 77593483

e e Minirmurm 9.00 =

) Log Masimum 1070.00
E Frequencies
[ Title

-------- Nutes—lll -
A | 4| | v

In this example, there is alarge difference between the mean and the median, with the
mean being more than 25,000 greater than the median. Thisindicates that the values
are not normally distributed. We can visually check the distribution with a histogram.
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Histograms for Scale Variables
» Open the Frequencies dialog box again.
» Click Charts.

» Select Histograms and With normal curve.

Figure 5-9
Frequencies Charts dialog box
Frequencies: Charts [ x|
Chart Tppe———
(el
e Cancel |
" Bar charts
" Pie charts ﬂl
@ Histograms
v with nomnal curve

= Chart Y alues

= Frequencies | Percentages

» Click Continue and click OK in the main dialog box to run the procedure.
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Figure 5-10
Histogram

i Viewer

Examining Summary Statistics for Individual Variables
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The majority of cases are clustered at the lower end of the scale, with most falling
below 100,000. There are, however, afew casesin the 500,000 range and beyond (too
few to even be visible without modifying the histogram). These high valuesfor only a
few cases have a significant effect on the mean but little or no effect on the median,
making the median a better indicator of central tendency in this example.
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Working with Output

The results from running a statistical procedure are displayed in the Viewer. The
output produced can be statistical tables, charts or graphs, or text, depending on
the choices you make when you run the procedure. This chapter uses the files
viewertut.spo and demo.sav.

Using the Viewer

Figure 6-1
SPSS Viewer
it Viewer !EIE
Fil=  Edit “iew |nzert Format Analyze Graphs  Utlitier  Window Help
SE|SR » = o @k o & |
«|»] +|-| @O 2=
fE] output ;I
........ @ Lo
Statistics
Lewel of education
M ¥alid G400
; Mizsing ]
:'I@ Crosstabs
Title
- [ Mates
o g Cose P Levrel of education
@ oz H
Frequency Fercent y
Yalid E:i::lt complete high 1380 a7 =
T [ P[] | | 4
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The Viewer window is divided into two panes. The outline pane contains an outline
of al of theinformation stored in the Viewer. The contents pane contains statistical
tables, charts, and text output.

Use the scrollbars to navigate through the window’ s contents, both vertically
and horizontally. For easier navigation, click an item in the outline pane to display
it in the contents pane.

If you find that there isn’t enough room in the Viewer to see an entire table or that
the outline view is too narrow, you can easily resize the window.

Click and drag the right border of the outline pane to change its width.

An open book icon in the outline pane indicates that it is currently visible in the
Viewer, athough it may not currently be in the visible portion of the contents pane.

» To hide atable or chart, double-click its book icon in the outline pane.

The open book icon changes to a closed book icon, signifying that the information
associated with it is now hidden.

» To redisplay the hidden output, double-click the closed book icon.

You can also hide all of the output from a particular statistical procedure or al of the
output in the Viewer.
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» Click the box with the minus sign (—) to the left of the procedure whose results you

want to hide, or click the box next to the topmost item in the outline pane to hide
all of the outpuit.

Figure 6-2
Hidden output in the Viewer

is Viewer !El ﬂ

File Edit “iew |nseit Format Analyze Graphs  Ublities  Window  Help

(=] 5] | B| o] B=k| @ & ]
|| +|-| QO] =]
OquuT

The outline collapses, visually indicating that these results are hidden.

You can also change the order in which the output is displayed.

» Inthe outline pane, click on the items you want to move.
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» Drag the selected itemsto anew location in the outline and rel ease the mouse button.

Figure 6-3
Reordered output in the Viewer
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You can also move output items by clicking and dragging them in the contents pane.

G145 96.0% 255

Using the Pivot Table Editor

The results from most statistical procedures are displayed in pivot tables.

Accessing Output Definitions

Many statistical terms are displayed in the output. Definitions of these terms can be
accessed directly in the Viewer.

» Double-click the Owns PDA * Gender * Internet Crosstabulation table.
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» Right-click Expected Count and select What's This? from the pop-up context menu.
The definition is displayed in a pop-up window.

Figure 6-4
Pop-up definition
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Pivoting Tables

The default tables produced may not display information as neatly or as clearly as you
would like. With pivot tables, you can transpose rows and columns (“flip” the table),
adjust the order of data in atable, and modify the table in many other ways. For
example, you can change a short, wide table into along, thin one by transposing rows
and columns. Changing the layout of the table does not affect the results. Instead, it's
away to display your information in a different or more desirable manner.

» Double-click the Owns PDA * Gender * Internet Crosstabulation table.
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» If the Pivoting Trays window is not visible, from the menus choose:

Pivot
Pivoting Trays

Pivoting Trays provide a way to move data between columns, rows, and layers.

Figure 6-5
Pivoting Trays
s VYiewer !EIE
File Edit “iew Insert Format Analwze Graphs  Utlites Window Help
SRS | m | me(k] 2| & ¢
2| +|-| m|O] x|=[8]]
BipvoingTraps 3|
Gender
Internet n ale hale
Mo oY Colomna ~ nese7 1962
nh =
alt 7 - = ho3d 10556
. L)
i S (s BI% 50.8%
> 127 323
206 329.4
n nn F."’J".r.( 0.3% 45 7%
TC 2224 2289
= Expected Count 22240 22850 |
<I A TS B s _>l_|
Double click to edit Pivot Table [¥ [SPSS Processer isready
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» Click one of the pivot icons to see what it represents. The shaded areain the table
indicates what will be moved when you move the pivot icon. A pop-up label aso
indicates what the icon represents in the table.

Figure 6-6
Pivot icon labels
i% Yiewer !Eln
File Edit Miew Inzert Pivot Format fnalpze Graphs  Utlikes “indow Help
W vt EIS
Owns PDA * Gender * i
=
Internet =
Mo Owns Mo =
FDA 3
Ves T
IStatistics|  HH.7R
Total 2224 2285
= 22240 | 22860
49 3% a0.7%
es wng Mo A13 612
FDA 5125 5125
a0.0% a0.0%
Was anA InE i
< | Al

» Drag the Statistics pivot icon from the Row dimension to the bottom of the Column
dimension. The table isimmediately reconfigured to reflect your changes.
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The order of the pivot icons in a dimension reflects the order of the elementsin
the table.

Figure 6-7
Pivoting tray icon associations

& Pivoting Trays [x] =l E
File Edt ¥ew Inf—— =z Utlites “Window Help
[=ender—Tr Layers | n ] [ [ ;l
o =
i Colurmnsg H
& @ i
= z S
o Owns
ng ro
4 Fernale
Internet / Count Expected Count | % within Owns PC
] [Mo Owns  No 1887 1903.4 49.2
PDA  ves 327 3206 50.3
Total 2224 22240 4593
Yes Dwing Mo a13 a12.5 40.0
PDA  veg 305 305.5 4949
Total 818 418.0 a0.0
q | 3
[W |SPSS Processar isready

» Drag the Owns PDA icon to the |eft of the Internet icon and release the mouse button
to reverse the order of these two rows

Creating and Displaying Layers

Layers can be useful for large tables with nested categories of information. By
creating layers, you simplify the look of the table, making it easier to read. Layers
work best when the table has at least three variables.

» Double-click the Owns PDA * Gender * Internet Crosstabulation table.

» |If the Pivoting Trays window is not visible, from the menus choose:

Pivot
Pivoting Trays
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» Drag the Gender pivot icon to the Layer dimension.

Figure 6-8
Gender pivot icon in the Layer dimension

i viewertut spo - 5P55 Viewer A= E
HE | Edit View Inzet Pivot Fomat Analyze Graphs  Utiities  Window Help
| Gender « [Mernet | [ [ [ [ ;I
By Pivoting Traps1 [ x|
Owns PDA * Gender * Interm "p" g’
[ Colurmns| = =
Gender | GenderFemale j| s 2 =
Internet Count Exp & &
Owns Mo Mo 1897
| For Yes 513 an o
Tes o a2y
Yes 305 305.4 49.¢
Total Mo 2234 22340 49.:
Yes 818 818.0 50.C
‘ | Ll [P

To view the different layers, you can either click the arrows on the layer pivot icon, or
you can select alayer from the drop-down list in the table.



98

Chapter 6
Figure 6-9
Choosing a layer
% Dutput] - SPSS Viewer [_ (O] x|
File Edit “iew |nzert Pieot Fomat Analyze Graphs  Utliies Window Help
|Gender*|nternet | an o | oo | =C | SR | Lﬂ
Owns PDA * Gender * Internet Crosstabulation
Gender | GenderFemale x|
nt Expected Count | % within Owns Pl
wng Gender hale 897 1503.4 49
*1 | Poa Total 513 512.5 50.0
es Ho 327 3206 a0z
Yes 305 3055 49t
Total Mo 2224 22240 497
Yes g 218.0 50.1
b
4| | v
1 items selected [0 hidden/collapsed) |—'.r|SF'SS Processor is ready v
Editing Tables

Unless you' ve taken the time to create a custom Tablel ook, pivot tables are created
with standard formatting. You can change the formatting of any text within atable.
Formats that you can change include font name, font size, font style (bold or italic),

and color.

» Double-click the Level of education table.

» |f the Formatting toolbar is not visible, from the menus choose:

View
Toolbar

» Click thetitle text, Level of education.

» From the drop-down list of font sizes on the toolbar, select 12.
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» To change the color of thetitle text, click the Text Color tool and select acolor.

>

Figure 6-10
Reformatted title text in the pivot table
Formatting Toolbar =}
o] & | [rarial =l [z -] B|r|u|@| =|=|=|=| &
s Viewer !EIB
. File Edit “iew [nzert Pivot Fomnat Analyze Graphs  Utlites  Window Help
Level of education
Curmulative
Frequency Percent Percent
Walid Did not complete high
chool 1390 217 217
=» High school degree 1936 303 52.0
Some college 1360 21.3 732
College degree 13585 21.2 94 .4
FPost-undergraduate
degree 3549 5.6 100.0
Total G400 100.0
Crosstabs
| | H 4

You can also edit the contents of tables and labels. For example, you can change the
title of this table.

Double-click the title.

» Type Education Level for the new label.

Note that if you change the values in atable, totals and other statistics are not
recal cul ated.
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Hiding Rows and Columns

Some of the data displayed in atable may not be useful or it may unnecessarily
complicate the table. Fortunately, you can hide entire rows or columns without
losing any data.

» Double-click the Education Level table.
» Citrl-Alt-click on the Valid Percent column label to select all of the cellsin that column.

» Right-click the highlighted column and select Hide Category from the pop-up context
menu.

The column is now hidden but not deleted.
To redisplay the column:
» From the menus choose:

View
Show All

Rows can be hidden and displayed in the same way as columns.

Changing Data Display Formats

You can easily change the display format of datain pivot tables.
» Double-click the Education Level table.
» Click on the Percent column label to select it.
» From the menus choose:

Edit

Select
Data Cells
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» From the menus choose:

Format
Cell Properties

» Type0inthe Decimalsfield to hide all decimal pointsin this column.

Figure 6-11
Cell Properties dialog box
Cell Properties [ 7] x|
Value | Aligrment I Marging | Shading |
LCategory: Eorrnat:
o -
Mumber B HHHRE-H
D ate jaghun i B2 a
Time st oo
Currency L HBE+HH
%
dd-mmim-yy
debmmm-py Sample
i/ dd sy
i/ dd Ay " L
dd .y = Percent
A r
Decimals: IE
¥ &diust format for cell width

ok I Cancel | Apply | Help |

You can also change the data type and format in this dialog box.

» Select the type that you want from the Category list, and then select the format for
that type in the Format list.
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» Click OK to apply your changes and return to the Viewer.

Figure 6-12
Decimals hidden in Percent column
in Viewer [_ O] x|
Eile Edit “iew [|nzett Pivat Format Analyze Graphs  Utilities  Wwindow Help
=

Education Level

Statistics
Cumulative
Level of education Frequency | Percent Percent
N Walid Ecltl]goult complete high 1300 29 217
Hinh schoal degree 1936 an 52.0
Sorme college 1360 1 732
College degree 1355 al 944
Post-undergraduate
iegres 8 359 B 100.0
Total G400 100

<

i

The decimals are now hidden in the Percent column.

TableLooks

The look and feel of your tables are a critical part of providing clear, concise, and
meaningful results. For example, if your tableis difficult to read, the information

contained within that table may not be easily understood.

Using Predefined Formats

» Double-click the Marital status table.

» From the menus choose:

Format
TableLooks...
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The TableL ooks dialog box lists a variety of predefined styles. Select a style from
the list to preview it in the Sample window to the right.

Figure 6-13
TableLooks dialog box

Tablelook:  <Spstem Defaulty

— Sample

Cancel |
<System Defaul>
Academic [narmow) Help |
Academic [VGA narmow)

Academic [VGA)

Academic 2 [narrow)

Academic 2 [VEA narmow]

Academic 2 [VGEA)

Academic 2

Acadenic

Avant-garde [harrow) ;l

Browse... |

" Beset all cell formats to the Tablel ook

B

Save Look Save iz, Edit Look...

You can use astyle asis, or you can edit an existing style to better suit your needs.

» To use an existing style, select one and click OK.

Customizing TableLook Styles

You can customize aformat to fit your specific needs. Almost all aspects of atable
can be customized, from the background color to the border styles.

» Double-click the Marital status table.

» From the menus choose:

Format
TableLooks...
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» Select the stylethat is closest to your desired format and click Edit Look.

» Click the Cell Formats tab to view the formatting options.

Figure 6-14
Table Properties dialog box

Table Properties n B

Generall Footnotes  Cell Farmats |Bolders| F'lintingl

— Tent

IArial j IS ;l ﬂﬂﬂ@ Area: |Data ;I

Foreground:  Background:

[Jox - -

— Inner Marginz (in points]

Top: |1 3: Left; Is 3:
Biattar: |1 3: Right: IS 3:

0K I Cancel | Appl | Help |

The formatting options include font name, font size, style, and color. Additional
options include alignment, shading, foreground and background colors, and margin
sizes.

The Sample window provides a preview of how the formatting changes affect your
table. Each area of the table can have different formatting styles. For example, you
probably wouldn’t want the title to have the same style as the data. To select atable
areato edit, you can either choose the area by name in the Area drop-down list, or
you can click the area that you want to change in the Sample window.

» Select Title from the Area drop-down list.

» Select anew color from the Background drop-down list.

The Sample window shows the new style.
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» Click OK to return to the Tablel ooks dialog box.

You can save your new style, which allows you to apply it to future tables easily.
» Click save As.

» Navigate to the desired target directory and enter a name for your new style in the
File Name text box.

» Click save.

» Click OK to apply your changes and return to the Viewer.
The table now contains the custom formatting that you specified.

Figure 6-15
Custom TableLook
i Yiewer |- (O] x]
Eile Edit “iew Inset Piwot Fomat Analyze Graphe  Utiliies  Window  Help
Matital status ;I
Mo Walid g400
Mizsing 1]
Marital status
Cumulative
Frequency | Percent | Valid Percent Percent
Walid  Unmarried 3244 a0.4 a0.4 a0.4
Married 3176 49,6 49,6 100.0
Total G400 100.0 100.0
< a

Changing the Default Table Formats

Although you can change the format of atable after it has been created, it may be
more efficient to change the default Tablel ook so that you do not have to change the
format every time you create atable.
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To change the default Tablel ook style for your pivot tables, from the menus choose:
Edit
Options...

» Click the Pivot Tables tab in the Options dialog box.

Figure 6-16
Options dialog box
General | Viewer | Diraft Viewer | Output Labels I Charts I Interactive I
Pivot Tables I Data | Cunrency I Scripts
— TableLook —Sample

C:4. ALooksNAcademic [harrow].to

< Suzhern [efaylt: -
scaderic [ramor | o ]
Academic [VEA namow) o
Academic [VEA)Ho
Academic 2 [narmow].to
Academic 2 [VES narrow] o

;
ol e

:

i

Academic 2 [VEA)Ho a2 st am e
Academic 2.to ;I = T ET=
Browsze. . | [——
[ —
Set TableLook Directary | =
—&djust Column YWidthg for ————— — Diefault Editing Mode
@ | abels only " Labels and data IEdit all tables in Viewer LI

Ok I Cancel | Lpply | Help |

» Select the Tablel ook style that you want to use for all new tables.

Use the Sample window to see a preview of each Tablel ook.

» Click OK to save your settings and close the dialog box.

All tablesthat you create after changing the default Tablel ook automatically conform
to the new formatting rules.
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Customizing the Initial Display Settings

Theinitial display settings include the alignment of objects in the Viewer, whether
objects are shown or hidden by default, and the width of the Viewer window. To
change these settings:

» From the menus choose:

Edit
Options...

» Click the Viewer tab.

Figure 6-17

Viewer options

Options E
[rata | Curnency | Scripts

General Wigwer | Diraft Wiewer I Output Labels I Charts I Interactive | Fivat Tables

r Initial Dutput State————— ‘ITitIe Fant vI

L=
[Lea - [oia | 1 =] Eﬂﬂm

Contents are initially: | — Text Dutput Page Size

£+ Shown Width: Length:
" Hidden % Standard (B0 characters] % Standard (59 linez)
Justificatior: " wide (132 characters) ' Infirite

& Aligrleft
[[BA_ e " Custom: ISD  Custom: |59
@ | Certer
€ &lign right — Text Dutput Font
m;l Courier Mew j I'IEI ;I ﬂﬂﬂ -l'l

[ Display commands in the log W Monospaced fonts

Ok I Cancel Apply Help
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The settings are applied on an object-by-object basis. For example, you can
customize the way charts are displayed without making any changes to the way tables
are displayed. Simply select the object that you want to customize, and make the
desired changes.

» Click the Title icon to display its settings.

» Click center to display dl titlesin the (horizontal) center of the Viewer.

You can aso hide elements, such as the log and warning messages, that tend to
clutter your output. Double-clicking on an icon automatically changes that object’s
display property.

» Double-click the warnings icon to hide warning messages in the output.

» Click OK to save your changes and close the dialog box.

Figure 6-18
Centered title in the Marital status table
s Yiewer !EIE
File Edit “iew Inseit Pivol Format Analyze Graphs  Utblites Window Help
I« Frequ
Marital status
Cumulative
- Freguency Percent Yalid Percent Percent
Yalid  Unmarried 3224 50.4 50.4 a0.4
Married MTE 496 496 100.0
Total G400 100.0 100.0
< | i

Your new settings will be applied the next time you run a statistical procedure. All
items that you have hidden will still be created, but they will not be visible in the
contents pane. Centered items can be identified by the small symbol to the left of
the item.
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Displaying Variable and Value Labels

In most cases, displaying the labels for variables and values is more effective than
displaying the variable name or the actua data value. There may be cases, however,
when you want to display both the names and the labels.

» From the menus choose:

Edit
Options...

» Click the Output Labels tab.

Figure 6-19
Output Labels options
Data I Currency I Scripts
General | Wiewer | DraftViewer Output Labels | Chats | Interactive | Fivat Tables

— Outline Labeling
Wariables in item labelz shown az:

I Labels LI

Wariable walues in item labels shown as;

I Labels LI

— Pivat Table Labeling

‘Wariables in labels shown as:

Wariable walues in labels shown as:

Labels LI

] I Cancel | Apply | Help |

You can specify different settings for the outline and contents panes. For example, to
show labelsin the outline and variable names and data values in the contents:

» Inthe Pivot Table Labeling group, select Names from the Variables in Labels
drop-down list to show variable names instead of labels.
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» Then, select Values from the Variable Values in Labels drop-down list to show data
values instead of labels.

Figure 6-20
Pivot Table Labeling settings

Data I Currency Scripts
General | Wiewer | DraftViewer Output Labels | Chats | Interactive | Fivat Tables

— Outline Labeling
Wariablez in item labelz shown az:

I Labels LI

Wariable walues in item labels shown as:

I Labels LI

— Pivat Table Labeling
‘Wariablez in labelz shown as:

Mames LI

‘Wariable walues in labels shown as:

] I Cancel Apply Help
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The new settings are applied the next time you run a statistical procedure.

Figure 6-21
Variable names and values displayed
i Viewer !Eln
File Edit “iew Insert Format Analyze Graphs  Ublites  Window Help
sE(8R| »| m | Delk| 2| & ¢
«[»] +[-| @o] =[=]a]]
Statistics ;I
MARITAL
] Walid 6400
Missing 0
MARITAL
Cumulative
Freguency Fercent Yalid Percent FPercent
Valid i 3224 a0.4 a0.4 a0.4
1 INTE 449 6 496 100.0
Total G400 100.0 100.0
1 | bl

Using Results in Other Applications

Your results can be used in many applications. For example, you may want to
include a chart or graph in a presentation or report. Applications such as Microsoft’s
PowerPoint or Word can display your results as plain text, rich text, or as a metafile,

which isagraphical representation of the output.

The following examples are specific to Microsoft Word, but they may work
similarly in other word processing applications.
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Pasting Results as Rich Text

You can paste pivot tables into Word as native Word tables. Text formatting, such
as font size and color, is not retained, but columns and rows are properly aligned.

Because the table is in a text format, the data can be edited after you paste it into
your document.

» Click the Marital status tablein the Viewer.
» From the menus choose:

Edit
Copy

» Open your word processing application.
» From the word processor’s menus choose:

Edit
Paste Special

» Select Formatted Text (RTF) in the Paste Specia dialog box.

Figure 6-22
Paste Special dialog box
Paste Special nm
Source:  Unknown
Cancel |
(o Paste:

Unformatted Text

o ink:
Faste link: Picture

LI I Display as iron

esult

Inserts the contents of the Clipboard as kext with

font and table Formatting.

» Click OK to paste your results into the current document.
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Pivot table displayed in Word
L_Ei Document] - Microsoft Word [_ O] x|

JEiIe Edit Yiew Insert Format Tools Table ‘Window Help

Working with Output

E

DEEHLERY {ERT v-o Q@D 0w -3E 2

EE- L S S-S NI SN BN SO B 5%
Marital status
Cumulative
Freguency | Percent | Walid Percent Fercent
Walid Unmarried 3224 50.4 504 a0.4
Warried 3176 49.6 49.6 100.0
Tatal 6400 100.0 100.0

|«|0|»|<

Thetable is now displayed in your document. You can apply custom formatting, edit
the data, and resize the table to fit your needs.

Pasting Results as Metafiles

Pasting your results as metafiles maintains the formatting of your output. Your pasted
output becomes an image in the target document.

» Click the Marital status tablein the Viewer.

» From the menus choose:

Edit
Copy

» Open your word processing application.

» From the word processor’s menus choose:

Edit
Paste Special
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» Select Picture in the Paste Specia dialog box. (In some applications, the choice
may be “metafile” instead of “Picture.”)

Figure 6-24
Paste Special dialog box
Paste Special EHE
Source:  Unknown
& Cancel |
= Paste: Formatted Text (RTF) ;I
¢ Paste link: Unformatbed Text

LI I™ Display as icon

esult

— Inserts the contents of the Clipboard as a picture,
r. This farmat is better than Bitmap For printing to high
% quality printers. OF the Format options available,
Picture occupies the least space on disk and displays
the quickest in Word.

» Click OK to paste your results into the current document.

Figure 6-25

Metafile displayed in Word

L'-_Ei Documentb - Microsoft Word !El
JFiIe Edit Miew Insert Format Tools Table Window Help

JDWH.|§&J|E\®|ﬂvnv %I:I§§|120% - )

X
x|
L] e SR R R~

Marital status

CL

Freguency | Percent Walid Percent F
- | wvalid  Unmarried 3224 0.4 204
T Married 3176 496 498
Total 5400 100.0 100.0

HIO| |4
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The metafile is now embedded in your document. Thisimage is a snapshot of the
Marital statustable. Only the visible portions of the table are copied. Information in
hidden categories or layersis not included in the metafile.

Pasting Results as Text

Pivot tables can be copied to other applications as plain text. Formatting styles are not
retained in this method, but you gain the ability to edit the table data after you paste
it into the target application.

» Click the Marital status tablein the Viewer.
» From the menus choose:

Edit
Copy

» Open your word processing application.
» From the word processor’s menus choose:

Edit
Paste Special

» Select Unformatted Text in the Paste Special dialog box.

Figure 6-26
Paste Special dialog box
Paste Special nm
Source!  Unknown
& Cancel |
& Paste: Formatted Text (RTF _

UnFormatked Test
Picture

" Paste link:

;I I™ Display as icon

esult
Inserts the contents of the Clipboard as texk without

.E" any Formatting
% .
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» Click OK to paste your results into the current document.

Figure 6-27
Pivot table displayed in Word

L'._Ei Documentt - Microsoft Word [_ (O] x|
JFiIe Edit %iew Insert Format Tools Table ‘Window Help ﬂ|

J g@’|nvnv|%|:|§§|mn% =

Marital statns

- Frequency  Pemesnt  VWalid Pereent  Cumulative Percent
. Valid Unmarmisd 3224 04 304 304

N Marmied 3174 49.4 49.6 100.0

Tatal G400 100.0 100.0

Ml D w4

Each column of the table is separated by tabs. You can change the column widths by
adjusting the tab stops in your word processing application.

Exporting Results to Microsoft Word, PowerPoint, and Excel Files

SPSS alows you to export results to a single Microsoft Word, PowerPoint, or Excel
file. You can export selected items or al itemsin the Viewer. If exporting to Word
or PowerPoint, you can export charts. This topic uses the files msouttut.spo and
demo.sav.

In the Viewer's outline pane, you can select specific items that you want to export.
You do not have to select specific items.

» From the Viewer menus choose:
File
Export...
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There are several options for exporting the results.

Figure 6-28
Export Output dialog box

Export Output

E xport; Dutput Document Options.... |
Ehart Size... |
— Export File
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First, you can select which type of output file you want to create. For Word and
PowerPoint, you can create afile that contains charts (Output Document) or one that
does not contain charts (Output Document (No Charts)). Charts are embedded in
Word documents as Windows metafiles. For Excel, you can create only documents
that do not contain charts (Output Document (No Charts)).

Select Output Document from the Export drop-down list.

You can save the exported Word, PowerPoint, or Excel file to any location and assign
it any name that Windows allows. The default file name is OUTPUT, and the default
path is the installation location or, if you opened or saved an output file, the location
of that file. You can change the default by typing a new path or clicking Browse

to locate a destination. You do not have to specify afile extension. The export
functionality adds the appropriate extension.

Note the default file path in the File Name text box. You will need to know where
thefileisto openit.

Instead of exporting all objects in the Viewer, you can choose to export only
visible objects (open books in the outline pane) or those that you selected in the
outline pane. If you did not select any items in the outline pane, you do not have
the option to export selected objects.
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» Select All Objects in the Export What group.

Finally, you select the file format.
» Select Word/RTF file (*.doc) from the File Type drop-down list.

» Click OK to generate the Word file.

When you open the resulting file in Word, you can see how the results are exported.
Notes, which are not visible objects, appear in Word because you chose to export all

objects.
Figure 6-29
Output.doc in Word
i OUTPUT.DOC - Microsoft Word M=
J File Edit Wiew Insert Format Tools Table Window Help  Acrobat 1'
Frequencies a
Notes
Cutput Created 23-JAN-2003 -
Comments
Input Data CF
Files\SPSStutarialsample_fib
Filter =
-
Weight
Snlit File o
hlp £ H S
I:lEIEIZ‘liI | 3
[Page 1 Sec 1 3 far Ln1 ol REC [TRK || gz
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Pivot tables become Word tables, with al of the formatting of the original pivot table,
including fonts, colors, borders, and so on.

Figure 6-30
Pivot tables in Word
i OUTPUT.DOC - Microsoft Word [_ (O] x|
JEiIe Edit Wiew Insert Format Tools Table ‘Window Help Acrobat x|
Frequency Table ZI
Gender _|
Cumuls
Freguency | Percent | Walid Percent Perce
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Male 3221 a0n.3 0.3
Total 6400 100.0 100.0 -
+
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Income category in thousands :
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[Page 1 Sec 1 3 [ar 1" lnl coll REC [TRE | 4
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Charts become embedded Windows metafiles.

Figure 6-31
Charts in Word
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Text output is displayed in a fixed-pitch font.

Figure 6-32
Text output in Word
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If you export to a PowerPoint file, each exported item is placed on a separate slide.
Pivot tables exported to PowerPoint become Word tables, with al of the formatting of
the original pivot table, including fonts, colors, borders, and so on.

Figure 6-33
Pivot tables in PowerPoint
Microsoft PowerPoint - [DUTPUT.ppt] [_ (O] x|
J File Edit Wiew Insert Format Tools Slide Show Window Help  Acrobat = |E’|£||
1 & Frequencies: Statistics . [
2 B Frequencies: Gender Frequenmes: Gender
3 2 Frequencies: Income
category in thousands Gender —
4 [Z) Graph: Bar of count by
inceat (
Freguency Percent Yalid P ercent
alicd Femals v 497 487
tlale 22 503 503
Total B400 1000 1000 | =
b
B=EOs7 (| | o | Iv]
| Slide Z of 4 | Default Design rgf v

Charts selected for export to PowerPoint are embedded in the PowerPoint file.

Figure 6-34
Charts in PowerPoint

Microsoft PowerPoint - [OUTPUT ppt] |_ (O] x|
J File Edit Wiew Insert Format Tools Slide Show Window Help Acrobak o |E|1|
1 2 Frequencies: Statistics =l
2 [J Frequencies: Gender § 1,600
3 2 Frequencies: Income é B
category in thousands 1,500 =
4 [# Graph: Bar of count by + 400 -
. " 40
1,200 =
| B =
1,000 T T T T
Uneler $25 525 - 340 %50 - 574 75+ ;I
Income category in thousands :
EHEO®T 4| i | ol
| Slide 4 of 4 Defaulk Design r@? v
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If you export to an Excel file, results are exported differently.

Figure 6-35
Output.xls in Excel
£ Microsoft Excel - DUTPUT xls [_ (O] x|
J@ Bz Edt ¥iew Inssrt Farmat Iools Data window Help Acrobat =& %]
Al j =| Frequencies
A B 3‘
1 [Frequencies [
2
3 Notes
LOutputCreated
| 5 |Comments
Input Data
B
| 7 | Filter
| & | Wigight
ER Split File
| 10 | M of Rows inWorking Data File |
4[4 [» ¥l Sheet I« |
Ready || | UM | T

Pivot table rows, columns, and cells become Excel rows, columns, and cells.

Figure 6-36
Pivot tables in Excel

B3 Microsoft Excel - DUTPUT xls Hi=1 E1
J@ File Edit Wiew Insert Format Tools Daka Window Help  Acrobat ;lilﬁl
A 4| =| Fraquencies

A | B | C | D [ E 3
22 |Frequency Table
El
24 Gender
258 Fregquency Percent Walid PerceJ
26 |valid Female 3,179 487 4
| 27 | Male 3,221 603 5
E Total £.400 100.0 10
129 |
30 Income category in thousands
31 Freguency Parcent Walid Parce
E\Falid Under $25 1,174 18.3 1w
[ «[» [} Sheet 14 | _>|JJ
Ready |[ | T WM
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Each line in the text output isarow in the Excel file, with the entire contents of the
line contained in asingle cell. Charts are not exported at all.

Figure 6-37

Text output in Excel

B3 Microsoft Excel - DUTPUT xls Hi=1 E1
J@ File Edit Wiew Insert Format Tools Daka Window Help  Acrobat ;Iilﬁl

A 4| =| Fraquencies
A | B | C | D [ E —

B7 | Income _I
Ecategnry bAoe in Lewel of

Ein years education

70 |thousands HMean Mean

71

72

| 73 |Under $25 3g 2

74

75 325 - ja9 g 3 [
75

i |450 - 374 3 3 -
[« «]> [vi}\ Sheet ld | _>IJ_‘
Ready ||| L

Exporting Results to HTML and Text Formats

You can also export results to HTML (hypertext markup language) and text formats
and a number of graphic formats. When saving as HTML and text, all non-graphic
output from SPSS can be exported into a single file and read by other programs.
HTML format is commonly used for intranet and Internet Web pages, while text can
be read by all word processors. In this way, SPSS output can be easily incorporated
into documents on computers that do not run SPSS or onto Web pages.
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When you export HTML and text output, charts can be exported as well, but
not to asingle file.

Figure 6-38
Chart in HTML

3 <I--Text used as the document title [dizplayed in the title bar).--» - Micros... !Elm

File Edt Yiew Favoritez Toolz  Help |Links >

1,800 -

1,600 =

1,400 -

1,200 J
1,000 | T |

1 I
Under §25 25 - §49 $50 - §74 §7o+

Income category in thousands

=
4| | v

|@ [one I_ I_ I_ |@ Fdy Computer 4
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Each chart will be saved as afilein aformat that you specify, and references to these
graphics fileswill be placed in the HTML or text document created by SPSS. Thereis
also an option to export all charts, or selected charts, in separate graphics files.

Figure 6-39

References to graphics in HTML output

File Edit Fomat Help

. ) ) <CENTER:> -
File  Edit Miew | v~ {23 Ear of count by inccat</H2>——» _I
<IMG SRC="OUTPUTO.IPG" ALT="Bar of count by inccat"
</ CEMTER>
£ 1800 [<BR>
3 <CEMTER>
S <Hl>Report
1600 | s =
</CENTER>
<CENTER:
1,400 — -
| v
1,200 = J
1,000 r T I T
Uncler §25 $25 - §49 $50 - 574 $75+
Income category in thousands
-
4| |

|@ Cione I_ ’_ ’_ |@ My Computer v
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Creating and Editing Charts

You can create and edit awide variety of chart typesin SPSS. In these examples, we
will create and edit three commonly used types of charts:

m  Simple bar chart
m Pie chart
m  Scatterplot with groups

Chart Creation Basics

To demonstrate the basics of chart creation, we will create abar chart of mean income
for different levels of job satisfaction. This example uses the data file demo.sav.

» From the menus choose:

Graphs
Bar...

In the Bar Charts dialog box, you specify what type of bar chart you want to create
and what data to use in the chart.

In this example, we will create a simple chart using groups of cases. The resulting
chart will show a bar for each group (category) in asingle categorical variable.

Bars can also be based on summaries of separate variables (so that each variable
isabar) or values from individual casesin the datafile (so that each caseis abar).
You can also create a clustered or stacked bar chart. With these charts, there are
multiple categorical variables.

» Click Simple.

127
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>

Click Ssummaries for groups of cases.

Figure 7-1
Bar Charts dialog box

Bar Charts

Cancel |
Help |

Data in Chart Are

" Summaries for groups of cases
" Summaries of separate vanables
™ Valyes of ndividual cases

Click Define.

In the Define Simple Bar dialog box, specify the variable or variables to use for
creating the chart. You want to create a chart that shows bars for the mean income of
each job satisfaction category.

Select Job satisfaction as the category axis variable.
In the Bars Represent group, select Other statistic (e.g., mean).

Select Household income in thousands as the variable to represent the bars. By
default, the summary function is the mean of thisvariable. If you want to select a
different summary function, click Change Statistic.
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Figure 7-2
Define Simple Bar dialog box

Il Define Simple Bar: Summaries for Groups of Cases

@ Age in years [age] -]
@ M arital gtatus [maritz
@ Years at current ade
® Income categom in
@ Price of primary veh
@ Primary vehicle price
A Level of education |
& ears with current
#» Retired [retire]

< Years with cunent &
[A} Gender [gender]
@ Mumber of people i
@ “Wirgless service [wi
@ Multiple ines [multi
® Woice mail [voice]
@ Paging service [pag
& Irternet finternet]
® Caller 1D [callid]

& Call waiting [callwait
G Dwns TV [owmnty]
@ Dz WCR [ownver

» Click OK to create the bar chart.

Creating and Editing Charts
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Figure 7-3
Bar chart
% Outputl - SPSS Viewer Mi=] E3
File Edit View Data Transform Insert Format Analyze Graphs Utilities Add-ons  Window Help
Sa|S(R| %l B - Hle=(k| @ & |
Qutput N B ;I
5@ Gragh " 120,00
+[(E] Title =
[+~
2 o000
=]
£
£
o 8000 o
E
5]
S 6ooo o
-
°
-_=
$  a.00
-
=]
T
=
@ 2000 -
-]
=
0.00 T T T T T
Highly Somewhat Meutral Sornewhat Highly [—
dissatisfied  dissatisfied satisfied satizfied
Job satisfaction -
Jd_1 >y | 1Y
The bar chart revedls that respondents who are more satisfied with their jobs also
tend to have higher household incomes.
Chart Editing Basics

You can edit chartsin avariety of ways. For the sample bar chart that you created,
you will:

m Change colors.

Format numbers in tick labels.
Edit text.

Display data value labels.

Use chart templates.
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To edit the chart, open it in the Chart Editor.

» Double-click the bar chart to open it in the Chart Editor.

Figure 7-4
Bar chart in the Chart Editor

File Edit Wiew Options Elements Transform  Help
JAriaI,SansSerif ﬂ|1D ;Il B I | = = = || At - _|'|

120.00 —
0
=
=
2
£ o000
e
=
-
=
- 80.00 -
E
=]
Q
E @000
=
]
=
% 40.00 -
E]
2
-
=
= 20,00 -
@
=

0.00 T T T T T
Higghly Somewhat Meutral Sornewhat Highly
dissatisfied  dissatisfied satisfied satisfied
Jobh satisfaction
H.274 5,324 75 paints

Selecting Chart Elements

To edit a chart element, you first select it.

» Click on any one of the bars. The blue rectangles around the bars indicate that they
are selected.
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There are general rules for selecting elements in simple charts:

m  When no data elements are selected, click any data element to select all data
elements.

m  When all data elements are selected, click a data element to select only that data
element. You can select adifferent data element by clicking it. To select multiple
data elements, click each element while pressing the Ctrl key.

Note: The behavior is dightly different for grouped charts. Grouped charts are
discussed in the scatterplot example. For more information, see “ Selecting Elements
in Grouped Charts’ on p. 164.

» To deselect al elements, press the Esc key.

» Click any bar to select all of the bars again.

Using the Properties Window

» From the Chart Editor menus choose:
Edit
Properties
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This opens the Properties window, showing the tabs that apply to the bars you
selected. These tabs change depending on what chart element you select in the Chart
Editor. For example, if you had selected atext frame instead of bars, different tabs
would appear. You will use these tabs to do most chart editing.

Figure 7-5

Properties window

Bar Options I “arishles I
ChertSize | Fil & Barder

Wariahle: IJDh satizfaction 'l

rCoIIapge (=um) categaries lessthan |5 9%

—Categorie

St byt I\-’alue 'I Directian: IAscending 'I

Order:

Highly dizsatisfied
Somewvhat diszatisfied
Meutral

Somewvhat satisfisd >
Highly satizfied

[x L[>

Excluded:

El

Loweer margin (%) IS Upper margin (%) IS

Apply I Cloze | Help |

Changing Bar Colors

First, you will change the color of the bars. You specify color attributes of data
elements (excluding lines and markers) on the Fill & Border tab.
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» Click the Fill & Border tab.

» Click the swatch next to Fill to indicate that you want to change the fill color of the
bars. The numbers below the swatch specify the red, green, and blue settings for
the current color.

» Click the dark blue color, which is second from the left in the second row.

Figure 7-6
Fill & Border tab
Bar Options | Variables | Denth & Andle
Chart Size Fill & Border I Categories
Previewn
-]
~Calat
- Fill o |
(40, 42, 115) - ..
. Border . . .
B

] )
Pattern _I_I_I_I_I_l
[ 5 A A o

Eclit | Reset |
(40, 42,113)
~Border Style
Wieight Shyle End Caps
TR [ —— R

Apply I Cancel | Help |

» Click Apply.
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The barsin the chart are now dark blue.

Figure 7-7
Edited bar chart showing blue bars

120.00 -

Mean Household income in thousands

Highly Somewhat Meutral Somewhat Highly
dissatisfied  dissatisfied satisfied satisfied

Job satisfaction

Formatting Numbers in Tick Labels

Notice that the numbers on the y axis are scaled in thousands. The numbers also
include two unnecessary decimal places. To make the chart more attractive and easier
to interpret, we will change the number format in the tick labels and then edit the
axis title appropriately.

» Select they axistick labels by clicking any one of them.

» To reopen the Propertieswindow (if you closed it previoudly), from the menus choose:
Edit
Properties
Note: From here on, we assume that the Properties window is open. If you have
closed the Properties window, follow the previous step to reopen it. You can also use
the keyboard shortcut Ctrl+T to reopen the window.
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» Click the Number Format tab.

» You do not want the tick labels to display decimal places, so type 0 in the Decimal
Places text box.

» Type 0.001 in the Scaling Factor text box. The scaling factor is the number by which
the Chart Editor divides the displayed number. Because 0.001 isafraction, dividing
by it will increase the numbersin the tick Iabels by 1,000. Thus, the numbers will no
longer be in thousands; they will be unscaled.

» Select Display Digit Grouping. Digit grouping uses a character (specified by your
computer’s locale) to mark each thousandth place in the number.
Figure 7-8
Number Format tab
Properties

Chart Size | Text | Scale | Labets & Ticks  Murber Format |

Sample
The number 1000000 will appear as:
1,000,000 000

Decimal Places:

Scaling Factor: 0.001

ID
I—

Leading Characters: I
I—

Trailing Characters:

Sciettific Matation

% Autornatic
7 Always

" Mever

Apply I Cancel | Help |

» Click Apply.
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Thetick labels reflect the new number formatting: there are no decimal places, the
numbers are no longer scaled, and each thousandth place is specified with a character.

Figure 7-9
Edited bar chart showing new number format

20,000

20,000

G0,000

40,000

20,000

Mean Household income in thousands

:
=
:
® :

Highly Somewhat Meutral Somewhat Highly
dissatisfied  dissatisfied satisfied satisfied

Job satisfaction

Editing Text
Now that you have changed the number format of the tick labels, the axistitleis no
longer accurate. Next, you will change the axistitle to reflect the new number format.
Note: You do not need to open the Properties window to edit text. You can edit
text directly on the chart.
» Click they axistitle to select it.

» Click the axistitle again to start edit mode. While in edit mode, the Chart Editor
positions any rotated text horizontally. It also displays a flashing red bar cursor (not
shown in the example).
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» Delete the following text:

in thousands
» Press Enter to exit edit mode and update the axis title. The axis title now accurately
describes the contents of the tick labels.

Figure 7-10
Bar chart showing edited y axis title

120,000 —

100,000 —

20,000 —

G0,000 —

40,000 —

[Mean Household incnme]

20,000 —

Highly Somewhat Meutral Sormewhat Highly
dissatisfied  dissatisfied satisfied satisfied

Job satisfaction

Displaying and Editing Data Value Labels

Another common task is to show the exact values associated with the data elements
(which are barsin this example). These values are displayed in data labels.

» From the Chart Editor menus choose:

Elements
Show Data Labels
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Figure 7-1
Bar chart showing data value labels

120,000 —

100,000 —

20,000 —

G0,000 —

40,000 —

Mean Household income

20,000 =

Higghly Somewhat Meutral Somewhat Higghly
dizzatisfied  dissatisfied satisfied satis fied

Jobh satisfaction

Each bar in the chart now displays the exact mean household income. Notice that the
units are in thousands, so you could use the Number Format tab again to change the
scaling factor. Instead, we will change the statistic shown in the data values.

» With the data value labels selected, click the Data Value Labels tab.

The Data Value Labelstab alows you to change various label properties. In this case,
you are going to change the content of the labels so that they display the percentage
of respondents in each category.

» Move Household income in thousands from the Displayed list to the Not Displayed
list.
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» Move Percent from the Not Displayed list to the Displayed list.
Figure 7-12
Data Value Labels tab
Propetties

chatsize | Tet | FilgBorder | Coteanries
Mumbeer Format Wariables Data *alue Labels
~Labels

Displayed:

s
Led Fercert

Mot Displayed:
Joh satisfaction
Houzehald income in thousancs

v x|

~Lakel Position Display Options

E] |- Suppress overlapping labels
. Custom I Display connecting lines to label

[ Color by marker

D]

Apply Cancel | Help |

» Click Apply to update the data value labels.
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As aresult, the bars display the percentage of casesin each Job satisfaction category.

Figure 7-13
Bar chart showing percentages
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Using Templates

If you make a number of routine changes to your charts, you can use a chart template
to reduce the time needed to create and edit charts. A chart template saves the
attributes of a specific chart. You can then apply the template when creating or
editing a chart.

We will save the current chart as atemplate and then apply that template to create
anew chart.

» From the menus choose:
File
Save Chart Template...

The Save Chart Template dialog box allows you to specify which chart attributes you
want to include in the template.
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If you expand any of the items in the tree view, you can see which specific
attributes can be saved with the chart. For example, if you expand the Scale axes
portion of the tree, you can see all of the attributes of data value labels that the
template will include. You can select any attribute to include it in the template.

» Select All settings to include all of the available chart attributesin the template.

You can also enter a description of the template. This description will be visible
when applying the template.

Figure 7-14
Save Chart Template dialog box

ESave Chart Template

Plesse =elect the settings that you want to save in the template.

EM i settings

| »

B Layout Reset
+ M Chart size
Lo Test, data, and other frames Cancel
- styles

=B Test tormatting Help
- Nan-data element styles
F-F Data elemert styles
= axes

EIF Scale axes

- Oriertation

= Range

- Ticks

-"F Lahelz

e Margins

F-F Category axes

2 Data value labels

_cweu |
I
_Eomaa |

Expand Al

----- = Display —

----- I Contert

----- I Fort style (fort, fort size, etc.)

----- F Drstinn fala " hstifieatina" =
l | LI_I

—Description of Templste

ou may enter & brief description of the termplate.

ITemplate for bar charts.

» Click Continue.

» Inthe Save Template dialog box, specify alocation and filename for the template.
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» When you are finished, click Save.

You can apply the template when you create a chart or in the Chart Editor. In the
following example, we will apply it while creating a chart.

Creating and Editing Charts

» Closethe Chart Editor. The updated bar chart is shown in the Viewer.

Figure 7-15

Updated bar chart in Viewer
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» From the Viewer menus choose:

Graphs
Bar...

» Click Define to open the Define Simple Bar dialog box.

The dialog box “remembers’ the variables that you entered when you created the
original chart. However, here you will create a slightly different chart to see how

applying a template formats a chart.
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>

Remove Job satisfaction from the Category Axistext box and replace it with Level
of education.

Select Use chart specifications from.
Click File.

In the Use Template from File dialog box, locate the template file that you previously
saved using the Save Chart Template dialog box.

Select that file and click Open.

The Define Simple Bar dialog box displays the file path of the template you selected.

Figure 7-16
Define Simple Bar dialog box showing template file path
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(Our example shows the path C:\... \SPSS\Looks\My Template.sgt.)

» Click OK to create the chart and apply the template.

The formatting in the new chart matches the formatting in the chart that you
previously created and edited. Although the variables on the x axis are different, the
charts otherwise resemble each other.

If you want to apply templates after you' ve created a chart, you can do it in the
Chart Editor (choose Apply Chart Template from the File menu).

Figure 7-17
Updated bar chart in Viewer
i Output2 - SP55 Viewer = B3
File Edit Wiew Data Transform Insert Format Analyze Graphs Utilities Add-ons Window Help
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Defining Chart Options

In addition to using templates to format charts, you can use the SPSS options to
control various aspects of how charts are created.
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» From the Data Editor or Viewer menus choose:
Edit
Options...

The Options dialog box contains many settings for configuring SPSS. Click the
Charts tab to see the available options.

Figure 7-18
Charts tab in Options dialog box
Data | Cumency | Scripts I
General | Viewer I Draft Viewer I Qutput Labels Charts | Interactive | Pivat Tables
—Chart T —Chart Aspect Ratio:
oF ! g [
™ Use chart template file Browse... |
[d@ne
—Cument Settings
— Font — Frame
IAriaI ~ I™" Quter
v Inner
— Style Cycle Preference Grid Lines
ICycIe through colors only j I Scale ais
[ Category axis
— Style Cycles
Calors... I Lines... I Markers... I Fills... |
ok | came | g | Hep |

The options control how a chart is created. For each new chart, you can specify:
m  Whether to use the current settings or a template

m  The width-to-height ratio (aspect ratio)

m If you're not using atemplate, the settings to use for formatting

m The style cycles for data elements
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Style cycles allow you to specify the style of data elementsin new charts. In this
example, we'll look at the details for the color style cycle.

» Click Colors to open the Data Element Colors dialog box.

For asimple chart, the Chart Editor uses one style that you specify. For grouped
charts, the Chart Editor uses a set of styles that it cycles through for each group
(category) in the chart.

» Select Simple Charts.

» Select the burgundy color, which is second from the right in the second row.

Figure 7-19
Data Element Colors dialog box
Data Element Colors
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DCategoryE B ﬂ D I:‘ D I:‘ D I:‘
.Eategor_l,l (51 Edit | Reset |
W Category 7 (162, 22, 25)
I:‘ Categony 8
|_| Cateqom 9 LI
Inzert Bemove
Feset Sequence
Cottiriuie I Cancel Help

» Click Continue.

» Inthe Options dialog box, click OK to save the color style cycle changes.

The data elements in any new simple charts will now be burgundy.
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» From the Data Editor or Viewer menus choose:

Graphs
Bar...

» Click Define to open the Define Simple Bar dialog box.

» Deselect Use chart specifications from. If you don't deselect this option, the chart will
use styles from the template rather than from the SPSS options.

» Click OK to create the chart.

The bars in the new chart are burgundy.

Figure 7-20
Updated bar chart in Viewer
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Other Examples

Now we will create and edit a pie chart and a grouped scatterplot to explore other
editing capabilities, including:
m  Hiding categories

m  Moving text
m  Converting a chart to another chart type
B Adding afit line to a scatterplot
m |dentifying points in a scatterplot
Pie Chart

First, we will create a smple pie chart that shows how many respondents have
Internet service at home. This example uses the data file demo.sav.

» From the menus choose:

Graphs
Pie...

» Click Summaries for groups of cases.

Figure 7-21

Pie Charts dialog box

Pie Charts [ x|
Datain Chartdre———————
& Summaries for groups of cases Cancel |
" Summaries of separate warisbles
& Walues of individual cases Help |

» Click Define.
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» Select Internet as the variable that defines slices (Define Slices by).

Figure 7-22
Define Pie dialog box
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When you create charts, they do not show the missing category by default. You want
to display this category to make sure that the number of cases with missing values
is not excessive.

» Click Options.



151

Creating and Editing Charts

» Select Display groups defined by missing values, and then click Continue.

Figure 7-23
Options dialog box

» Click oK in the Define Pie dialog box to create the pie chart.
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Figure 7-24
Pie chart in Viewer
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The pie chart reveals that most respondents do not have Internet service at home.
From the chart, it appears that only about a quarter of the respondents have home
Internet service.

For this pie chart, you will:

Add atitle.

Remove the small category of missing data.

Display percentages for the two remaining categories.
Move the data labels and connect them to the slices with lines.
Convert the pie chart to a bar chart.
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» Double-click the pie chart to open it in the Chart Editor.

Figure 7-25
Pie chart in the Chart Editor

[ Chart Editor
elp

File Edit Wiew Options Elements Transform  H
J ol e rjs==s(lArE—t]
Internet
B Missing
B Mo
O Yes

H.274 5, W:324 75 points

Adding a Chart Title

First, you will add atitle to the chart. Because the title applies to the entire chart and
not to a specific chart element, you don’t need to select anything to add the title.

» From the menus choose:

Options
Title
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The Chart Editor adds the word “Title” above the chart and enlarges the chart to

accommodate the title. Like footnotes, the titleisin atext frame that you can move to
another position in the chart.

Figure 7-26
Pie chart showing default title

Internet
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» TypeHome Internet Service over the highlighted default title.
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Note: If you clicked elsewhere in the Chart Editor, the default title may no longer be
highlighted. The text frame around the title may be selected instead. If thisisthe
case, click the title again to start edit mode. You can then double-click the title

text and begin typing.

Figure 7-27
Pie chart showing edited title
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Modifying Chart Categories

Next, you will remove the small category of missing data.
» In the Chart Editor, select the pie chart.

» Click the Categories tab in the Properties window. (If the window is closed, choose
Properties from the Edit menu or press Ctrl+T.)

» Move Missing from the Order list to the Excluded list.
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Figure 7-28
Categories tab
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» Click Apply.
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The pie chart now displays only the No and Yes categories for home Internet service.

Figure 7-29
Pie chart with excluded missing category
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The pie chart clearly shows that most respondents do not have Internet service at
home; it appears that about three-quarters of the respondents are in the No category.
However, it might be useful to see the exact percentages.

Changing Data Value Label Content and Location
» Inthe Chart Editor, select the pie chart.

» From the menus choose:

Elements
Show Data Labels
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The pie chart now displays labels of counts. We need to change the counts to
percentages.

» Click the Data Value Labels tab in the Properties window.
» Move Count from the Displayed list to the Not Displayed list.

» Move Percent from the Not Displayed list to the Displayed list.

Figure 7-30
Data Value Labels tab
Properties E
Chart Size | test | Fill & Fnreler
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» Click Apply.
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Percentages are now displayed in the pie dices.

Figure 7-31
Pie chart showing percentages
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The percentages are based on the two categories displayed (73.4 + 26.6 = 100). If
you put the category containing missing values back into the pie, the percentages
will change.

You may not want the data value labels to appear in the pie dlices. You can move
them and add connecting lines to their respective slices.

Return to the Data Value Labels tab.

In the Label Position group, click Custom.

Click the icon showing the labels outside the dlices.
Select Display connecting lines to label.

Click Apply.



160

Chapter 7

Data value labels now appear outside the slices with lines connecting the labels to
their respective dices.

Figure 7-32
Labels outside of pie chart
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Converting a Chart

Finally, you will convert the pie chart into a bar chart.

» From the menus choose:

Transform
Simple Bar
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The Chart Editor converts the chart and displays the result. The bar chart retains the
title and data labels. However, the bars are the same color rather than the two different

colors shown in the pie chart. Because the tick labels identify the categories, two
colors are unnecessary.

Figure 7-33
Bar chart converted from pie chart
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Grouped Scatterplot

In this example, we will create a scatterplot using the data file car_sales.sav. The
scatterplot will show fuel efficiency against curb weight.

» From the Data Editor menus choose:

Graphs
Scatter/Dot...
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» Click Simple Scatter.

Figure 7-34
Scatter/Dot dialog box
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» Click Define.

For a scatterplot, you need to define a scale variable for each axis. Put the dependent
variable on the y axis and the independent variable on the x axis.

» Select Fuel efficiency as the y axis variable.
» Select Curb weight as the x axis variable.

» Select \ehicle type as the grouping variable (Set Markers by).



163

Creating and Editing Charts

Figure 7-35
Simple Scatterplot dialog box
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» Click oK.
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» Inthe Viewer, double-click the resulting scatterplot to display it in the Chart Editor.

Figure 7-36
Scatterplot in the Chart Editor
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Selecting Elements in Grouped Charts

Selecting an element in grouped charts (that is, charts with categories) differs from
selecting an element in simple charts. You can tell that a chart is grouped because it
includes, by default, alegend for the groups.

You can hide the legend if necessary (choose Hide Legend from the Options menu).
However, the legend provides important information for interpreting the chart. You
can also use the legend to easily select groups.
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There are general rules for selecting elements in grouped charts:

m  When no data elements are selected, click any data element to select all data
elements.

m  When al data elements are selected, click a data element in a specific group to
select al data elementsin the group. You can then click a data el ement in another
group to select its associated group.

m  You can aso click the legend entry for a group to select only that group.

m  When agroup of data elementsis selected, click a data element in the group to
select only that data element. You can then select another data element in the
chart by clicking it.

With specific data el ements selected, you can make changes to only the selected data
elements. So, you could change the color of dataelementsin agroup. In thisexample,
we changed thefill color of the marker from transparent to the same color asits border.

Figure 7-37
Scatterplot showing one case with a different fill color
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Adding a Fit Line

With scatterplots, you often want to add afit line to the chart. For elements like fit
lines that apply to the whole chart, it doesn’t matter what is selected in the chart. You
can make the change or add the item to the whole chart. If you were creating afit line
for only one or more specific groups, you would need to make specific selections.

From the menus choose:

Elements
Fit Line at Total

Figure 7-38
Scatterplot showing fit line at total
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The Chart Editor adds the fit line to the chart. It also displays the coefficient of
determination, R2. R?2 is the proportion of the variability in the dependent variable (y
axis) that can be explained by the independent variable (x axis). In this example, we
can say that 67% of the variability in Fuel efficiency values can be explained by Curb
weight. The closer RZ isto 1, the better the line fits the data.
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Displaying Data Value Labels for Specific Points

Previoudly, in the bar and pie chart examples, we displayed the data value labels for
all data elements. With scatterplots, displaying data value labels for al markers

is not usually useful. There are too many data elements, making viewing of the
associated data value labels difficult.

» For example, from the menus choose:

Elements
Show Data Labels

The results are cluttered and of limited use.

Figure 7-39
Scatterplot showing all data value labels
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Not every marker in the scatterplot has a displayed data value label. This occurs
because of a Data Value Labels tab setting that suppresses overlapping labels. This
setting helps to eliminate some of the clutter, but you don’'t have control over which
particular data value labels are displayed. You could turn off this setting to display all
data value labels, even the overlapping ones. However, many labels would become



168

Chapter 7

unreadable. A better option would be to display data value labels for only those
points that you want to highlight.

First, hide the current data value labels.
» From the menus choose:

Elements
Hide Data Labels

Next, turn on data label mode, which allows you to click any data element and
automatically display its data value label.

» From the menus choose:

Elements
Data Label Mode

The cursor changes to indicate that you are in data label mode.

» Click the marker for which we previously changed thefill color.

Figure 7-40
Scatterplot with one marker showing a data value label
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The Chart Editor now displays the data value label for only that marker. You can
repeat this process for each marker that needs a data value label. You can also hide a
data value label by clicking it while in data label mode.

The data value label contains the case number. You can change the contents of the
data value label on the Data Value Labels tab.

» When you are finished |abeling the data elements, exit data label mode. From the
menus choose:

Elements
Data Label Mode
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Working with Syntax

SPSS syntax provides a method for you to control the product without navigating
through dialog boxes, viewers, or data editors. Instead, you control the application
through syntax-based commands. Nearly every action you can achieve through the
user interface can be achieved through syntax. Using syntax also allows you to
save the exact specifications used during a session. Syntax is not available with the
Student Version.

The examples in this chapter use the data file demo.sav.

Pasting Syntax

The easiest way to create syntax is to use the Paste button located on most dialog
boxes.

» Open demo.sav for use in this example.

» From the menus choose:

Analyze
Descriptive Statistics
Frequencies...

171
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This opens the Frequencies dialog box.

@ Level of education Help

& Years with current '
-

FUT o WL I |

Figure 8-1
Frequencies dialog box
g in years [age] = — : d |

® A | [agel \-’anable.[s] : K
G Years at current ad @iMantal status [martal] |
< Household income &I
A Income category in Bezet |
@ Price of primary vet E C I
< Primary vehicle pric anee |

¥ Display frequency tables

§tatistics...| Qharts...l Eormat...l

Select Marital status (marital) in the source list.

Click the arrow button to move the variable to the Variables list.
Click Charts.

In the Charts dialog box, select Bar charts.

In the Chart Values group, select Percentages.

Click Continue.

vV v v Vv v v Vv

Click Paste to copy the syntax created as a result of the dialog box selections to
the Syntax Editor.
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Figure 8-2
Frequencies syntax
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You can use this syntax alone, add it to a larger syntax file, or refer toitina
Production Facility job.

» To run the syntax currently displayed, from the menus choose:

Run
Current
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Editing Syntax

In the syntax window, you can edit the syntax. For example, you could change
the subcommand /BARCHART to display frequencies instead of percentages. (A
subcommand is indicated by a dash.)

Figure 8-3
Modified syntax

Bi Syntax2 - SPSS Syntax Editor |_ O] x|
File Edit “iew Analyze Graphe Utlities Run  “Window Help
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FREQIUEMNCIES
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/BARCHART FREQR

/ORDER= AMALY SIS .

[% |SP5S Processor is e g

To find out what subcommands and keywords are available for the current command,
click the Syntax Help button. The example shows the complete syntax for the
FREQUENCIES command.
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Figure 8-4
FREQUENCIES syntax help
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[/BARCHART=[MIN(n)] [MAX(n)] [{FREQ(n) 111
{PERCENT (n} }
[/PIECHART=[MIN(n)] [MAX(n)] [{FREQ 3}

{ FERCENT:
[{MISSING 1]
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[/HISTOGRAM=[MIN (n)] [MAX (n)] [{FREQ(n} 1]
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If the cursor is not in a command, clicking the Syntax Help button displays an
alphabetical list of commands. You can select the one you want.

Typing Syntax

You can type syntax into a syntax window that is already open, or you can open anew
syntax window by choosing:

File
New
Syntax...
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Saving Syntax

To save a syntax file, from the menus choose:
File

Save
or

File
Save As...

Either action opens the standard dialog box for saving files.

Opening and Running a Syntax File

>

>

To open a saved syntax file, from the menus choose:
File
Open
Syntax...

Select a syntax file. If no syntax files are displayed, make sure Syntax (*.sps) is
selected in the Files of type drop-down list.

Click open.

» To run the syntax currently displayed, from the menus choose:

Run
Current

If the commands apply to a specific datafile, the data file must be opened before
running the commands, or you must include a command that opens the datafile. You
can paste this type of command from the dialog boxes that open datafiles.
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The data you start with may not always be organized in the most useful manner for
your analysis or reporting needs. For example, you may want to:

m Create a categorical variable from a scale variable.
m  Combine several response categories into a single category.

m Create a new variable that is the computed difference between two existing
variables.

m Caculate the length of time between two dates.

This chapter uses the data file demo.sav.

Creating a Categorical Variable from a Scale Variable

Several categorica variables in the data file demo.sav are, in fact, derived from scale
variablesin that datafile. For example, the variable inccat is simply income grouped
into four categories. This categorical variable uses the integer values 14 to represent
the following income categories: less than 25, 25-49, 50-74, and 75 or higher.

To create the categorical variable inccat:
» From the menus in the Data Editor window choose:

Transform
Visual Bander...
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Figure 9-1
Initial Visual Bander dialog box
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Intheinitial Visual Bander dialog box, you select the scale and/or ordinal variables
for which you want to create new, banded variables. Banding means taking two or
more contiguous values and grouping them into the same category.

Since the Visual Bander relies on actual valuesin the datafile to help you make
good banding choices, it needs to read the data file first. Since this can take some
time if your data file contains alarge number of cases, thisinitial dialog box also
allows you to limit the number of casesto read (“scan”). Thisis not necessary for
our sample data file. Even though it contains more than 6,000 cases, it does not
take long to scan that number of cases.

Drag and drop Household income in thousands [income] from the Variables list into
the Variables to Band list, and then click Continue.
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Modifying Data Values

Main Visual Bander dialog box
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» Inthe main Visual Bander dialog box, select Household income in thousands
[income] in the Scanned Variable List.

A histogram displays the distribution of the selected variable (which in thiscaseis

highly skewed).

» Enter inccat2 for the new banded variable name and Income category (in thousands)

for the variable label.

» Click Make Cutpoints.



180

Chapter 9

Figure 9-3
Visual Bander Cutpoints dialog box
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o Apply will replace the current cutpoint definitions with this specification.

A final interval will include all remaining walues.

» Select Equal Width Intervals.

» Enter 25 for the first cutpoint location, 3 for the number of cutpoints, and 25 for
the width.

The number of banded categoriesis one greater than the number of cutpoints. So, in
this example, the new banded variable will have four categories, with the first three
categories each containing ranges of 25 (thousand) and the last one containing all
values above the highest cutpoint value of 75 (thousand).

» Click Apply.
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Figure 9-4
Main Visual Bander dialog box with defined cutpoints
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The values now displayed in the grid represent the defined cutpoints, which are
the upper endpoints of each category. Vertical lines in the histogram also indicate
the locations of the cutpoints.

By default, these cutpoint values are included in the corresponding categories. For
example, the first value of 25 would include all values less than or equal to 25. But
in this example, we want categories that correspond to less than 25, 25-49, 5074,

and 75 or higher.

» Inthe Upper Endpoints group, select Excluded (<).

» Then click Make Labels.
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Figure 9-5
Automatically generated value labels
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This automatically generates descriptive value labels for each category. Since the
actual values assigned to the new banded variable are simply sequential integers
starting with 1, the value labels can be very useful.

You can also manually enter or change cutpoints and labels in the grid, change
cutpoint locations by dragging and dropping the cutpoint lines in the histogram, and
delete cutpoints by dragging cutpoint lines off of the histogram.

» Click OK to create the new, banded variable.
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The new variable is displayed in the Data Editor. Since the variable is added to the
end of thefile, it is displayed in the far right column in Data View and in the last

row in Variable View.

Figure 9-6

New variable displayed in Data Editor
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Computing New Variables

Using awide variety of mathematical functions, you can compute new variables based
on highly complex equations. In this example, however, we will simply compute a
new variable that is the difference between the values of two existing variables.

The data file demo.sav contains a variable for the respondent’ s current age and
avariable for the number of years at current job. It does not, however, contain a
variable for the respondent’ s age at the time he or she started that job. We can create
anew variable that is the computed difference between current age and number of
years at current job, which should be the approximate age at which the respondent

started that job.
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>

From the menus in the Data Editor window choose:

Transform
Compute...

For Target Variable, enter jobstart.

Select Age in years (age) in the source variable list and click the arrow button to copy

it to the Numeric Expression text box.

Click the minus (=) button on the calculator pad in the dialog box (or press the minus

key on the keyboard).

Select Years with current employer (employ) and click the arrow button to copy it

to the expression.

Figure 9-7

Compute Variable dialog box

: Compute Yariable

Target * anable: umerc Expression;
Iiohstalt = |age - employ ;I
Type & Label... |
i

# ears at curent ad;l

< Household income

Function group:

® < <] 2e]s] ] 5
|hcome category it Arithmetic
-] 2=|x=| 4]|5]|E
® Price of primary vt _I _I _I_I_ EDF & N_oncentlal CDF
@ Primary vehicle pric _xl ;I:I Llili ES::;[SE)D;BHT ime
@ Level of education o] o] Diate Arithmetic
< Years with curent . il ;I_UJ Delete Diate Creation
4 Rietired [retire] F.J_..a.t!a_ _E_x.t—[\?—dlon LI
> Years with curent d Functions and Special Variables:
< Job satisfaction [jot
@ Gender [gender]
® Mumber of people |
< Wireless service [
< Multiple lines [rmultl
@ Woice mail [voice]
@ Pauing service [paill =
| If... | [optiohal case selection condition] |
Ok, I Paste | Reset | Cancel | Help |
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Note: Be careful to select the correct employment variable. There is aso arecoded
categorical version of the variable, which is not what you want. The numeric
expression should be age-employ, not age-empcat.

» Click OK to compute the new variable.

The new variable is displayed in the Data Editor. Since the variable is added to the
end of thefile, it is displayed in the far right column in Data View and in the last
row in Variable View.

Figure 9-8
New variable displayed in the Data Editor
Data Editor [ O] x]
File Edit “iew Data Transform Analyze Graphs  Utlities Window  Help
2R85B o] L] =[k| &l £l BlE|E[ 2
|‘I : age E
News response | inccat2 Jobstart var V;LI
1 Yes Mo 3.00 32.00
2 fes fes 4.00 21.00
3 Mo Mo 2.00 2400
4 Mo Mo 2.00 2400
5 Mo Mo 1.00 20.00
5 Yes Mo 4.00 32.00
7 Yes Mo 2.00 32.00
a Yes Mo 3.00 34.00
g Mo Mo 1.00 35.00
10 Mo Yes 4.00 2200
TITI{E)ata\ﬁe:\:kVariablemiew}' |mﬂ e | AP

Using Functions in Expressions

You can also use predefined functions in expressions. More than 70 built-in functions
are available, including:

m  Arithmetic functions
m Statistical functions
m Distribution functions
m Logica functions
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m Date and time aggregation and extraction functions
®  Missing-value functions
m  Cross-case functions
m  String functions
Figure 9-9
Compute Variable dialog box displaying function grouping
i Compute Variable [ x|
T arget Y anable: umeric Expression;
I jobatart = |5UMlage, - employ] ;I
Type & Label... | _I
@ Age invears [age] = Function group:
< Warital status [marit LI LILI ilil q -
< Years at current ad = Arithrnetic
> Househald incame _I ﬁlﬁl ilili gDF & Moncentral COF
@ Income category in _xl ;IEI Llili ES::;ﬁ[SE)D:teHT ime
# Price of primary vet _.n’l il_ll 0 |_ Diate Arithmetic
<& Primary vehicle pric #| ~|[)] _Delete Diate Creation
@ Lewvel of education — _I P_‘,a,tf _E_:-:It_r\?_ctlon LI
4 Years with cunent s SUM [nume=pr.numexprl.,.. ], Mumeric, | Functions and Special Variables:
@ Retired [retire] Feturns the sum of its arguments that have St ;I
@ “Years with cument « valid values. Thiz function requires bwo or String
K - more arguments, which must be numeric, Subst(1]
& Job satistaction [jot f'ou can specify a minimum number of valid Subah]?
@ Gender [gender] arguments for thiz function to be evaluated. _
< Mumber of people i Sysmis
a0 Wireless service [u pme.aa}ls1
@ Multipl ines mui 2] =] |fime et
ultiple lines [roulti Time. Hms(2]
Tirne Hrrz[3) —
| If.. | [optional case selection condition] | Trunc
Upcaze LI
u]. I FPaste | Feset | Catcel | Help |

Functions are organized into logically distinct groups, such as a group for arithmetic
operations and another for computing statistical metrics. For convenience, a number
of commonly used system variables, such as $TIME (current date and time), are also
included in appropriate function groups. A brief description of the currently selected
function (in this case, suM) or system variable is displayed in areserved areain the
Compute Variable dialog box.
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Pasting a function into an expression. To paste a function into an expression:

» Position the cursor in the expression at the point where you want the function to
appear.

» Select the appropriate group from the Function group list. The group labeled All
provides alisting of al available functions and system variables.

» Double-click the function in the Functions and Specia Variables list (or select the
function and click the arrow adjacent to the Function group list).

The function is inserted into the expression. If you highlight part of the expression
and then insert the function, the highlighted portion of the expression is used as the
first argument in the function.

Editing a function in an expression. The function is not complete until you enter the
arguments, represented by question marks in the pasted function. The number of
question marks indicates the minimum number of arguments required to complete
the function.

» Highlight the question mark(s) in the pasted function.

» Enter the arguments. If the arguments are variable names, you can paste them from
the variable list.

Using Conditional Expressions

You can use conditional expressions (also called logical expressions) to apply
transformations to selected subsets of cases. A conditional expression returns avalue
of true, false, or missing for each case. If the result of a conditional expression is
true, the transformation is applied to that case. If the result is false or missing, the
transformation is not applied to the case.

To specify a conditional expression:

» Click If in the Compute Variable dialog box. This opensthe If Cases dialog box.
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Figure 9-10
If Cases dialog box

Compute Yanable: If Cases m

oo s el " Include all cases
@ Marital status [mar_ & Include if case satisfies condition:
® ‘ears at current ac age »= 21 ﬁ
#»Household income i
@ Incame cakegoty ir LI
@ Price of primary we Function group:
@ Primary vehicle pric s A S e X I Al A il
bl B o o 1 I
@ Retired [retive] 2l ==l z]s] Ezrnr\;rtsggteﬂime ;I
@Vears with current == -u il—u —I—I n'L'_A":LL'"L:' i i
@ 1ab satisfaction [jo ﬂl _I Delete I Functions and Special Yariables:
[A} Gender [gender]
@ Mumber of people i ;I
o Wireless service [
® Multiple lines [rultli
@ Yoice mail [voice]
@ Paging service [pat_Ll LI
Continue Cancel | Help |

» Sedlect Include if case satisfies condition.

» Enter the conditional expression.

Most conditional expressions contain at least one relational operator, asin:
age>=21

or

income*3<100

In the first example, only cases with avalue of 21 or greater for Age (age) are

selected. In the second example, Household income in thousands (income) multiplied
by 3 must be less than 100 for a case to be selected.
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You can aso link two or more conditional expressions using logical operators, asin:
age>=21 | ed>=4
or

income*3<100 & ed=5

In the first example, cases that meet either the Age (age) condition or the Level of
education (ed) condition are selected. In the second example, both the Household
income in thousands (income) and Level of education (ed) conditions must be met for
a case to be selected.

Computing Variables with Missing Values

When computing variables with missing values, it's a good idea to perform atrial
on asmall datafile in order to ensure that your missing data are handled in a way
that is acceptable. Some computations handle missing data by removing them from
the equation, while others cannot perform the computation and the new value is
considered missing. The following examples use car_sales.sav.

There are two different ways to compute the mean of a set of variables. Thefirstis
to divide the sum of the set of variables by the number of variablesin the set.

» From the menus choose:

Transform
Compute...

» Type avgsale in the Target Variable text box.
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» Type (resale + price) / 2 in the Numeric Expression text box.

>

Figure 9-1
Find the average

: Compute ¥Yariable E

T arget Y anable:

Mumeric Expressior:

Iavgsale

Type & Label...

(A} Manufacturer [ran |
@ Model [model]

# Sales in thousands
< dpear resale value
@ Wehicle type [tope]
4 Price in thousands
# Engine size [engine
& Horsepower [harse

@ Wheelbaze [wheel=
< Width [width]

< Length [length]

< Curb weight [curb_
@ Fuel capacity [fuel
@ Fuel efficiency [mpm
< Logtrarsformed sa

G Feoore: d-pear res-;l

[rezale + price] / 2

[]

| If.. | [optional case selection condition]

(o ]

Paste |

Feset | Cancell

Function group:

Al

Arithmetic

CDF & Moncentral CDF
Conversion

Current Date/Time
Date Arithmetic

Date Creation

Date Extraction
lisssmanm Fal

[
[~

I~

Functions and Special Variables:

Help |

This equation finds the average of the original price of acar and its four-year resale

price.

Click oK.
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A new variable has been added to the end of the data file. This variable, which
we named avgsale, isin the far right column in Data View. Any cases that have
missing values in either of the two variables that we computed also have a missing
value for the avgsale variable.

Figure 9-12
Data Editor with avgsale added
SPS5 Data Editor |_ (O] x|
File Edit Miew Data Transform  Analyze Graphs  Utiliies  Wwindow  Help
=[S @] o] L] =|k| &l Fe=] B|EFE S 2
|20: |
zourh wy | zfuel ca zmpy avysale war Yar Wt ﬂ
1 17212 -1.22223 97053 18.93
2 22042 - 19340 27004 24,14
3 14587 - 19340 80353 .
4 4857 01237 - 43045 35.86
5 - 60274 - 39917 73703 2312
53 29020 14057 - 43045 2875
7 83104 1.47844 -.66395 20,50
g - 31566 - 34772 52608 .
£l =287 1 - 34772 03654 31.04
10 14905 14057 22334 37.51
11 -.01530 - 11624 27004 17.23
12 26166 - 11624 - 19696 19.52
13 63437 14057 03654 26.05
14 33779 - 11624 27004 20.62
15 95158 14087 - 43045 32 -
|4 [* |\ Data view A Variable view I} | v

The second way to compute the mean of a set of variablesis to use the mean function.
» Recall the Compute Variable dialog box.
» Click Reset to clear the previous selections in this dialog box.

» Type meansale in the Target Variable text box.
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» Type mean(resale, price) in the Numeric Expression text box.

Figure 9-13
Find the mean

0 Wheelbaze [wheel—
B Width [wicth]

@ Length [length]

< Curb weight [curb_
< Fuel capacity [fusl_
@ Fuel efficiency [mp

® Log-transformed za
# Zocore: d-vear res-ﬂ j

| If... | [optional caze relection condition] |
O, I Pazte | Hesetl Cancell Help |

Functions and Special Variables:

i Compute Yarnable E
Target * ariable: Mumeric Expression:
Imeansale = |mean(resale price) ;I
Type & Label... | _I
w
(8] Manufacturer [man = Funiction group:
’E‘; Model [rmadel] ;I ;ILI ilil g all -
4 Sales in thousands Avithretic
% Lyear resal valus | «=l>=] 4]5]6] CDF & Noncential COF
< Vehicle type [type] == 2] 8] EER;[SEJD;EHT ine
< Price in thousands Aol o ] Diate Arithmetic
4 Engine size [engine = ~[()] _Delets | Date Creation
@ Horsepower [horse E P.‘.a.t?_ _I-:_:-:It_r\?_ctlon LI

Like the previous example, this equation finds the average, or mean, of the car’s
origina price and its four-year resale price.

» Click OK.
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The meansale variable is added to the far right column in Data View. Unlike the
previous example, the mean function removes missing values from the equation and

computes the mean of the remaining values. You can modify the behavior of this

function to limit the number of values that can be removed from the equation.
Figure 9-14

Results from two mean calculations

SPSS Data Editor HE=
File Edit iew [Data Transform  Analyze  Graphs  Utlties  Window  Help
a8 8 || | =k @l Elre| BlEE v 9

|2‘I : |

zourb_wy | zfuel_ca zmpy avgsale | meansale yar yar ﬂ
SATMZ 122223 97053 18.93 18.93

1

2 22042 19340 27004 2414 2414
3 14587 19340 50353 . 18.23
4 74857 0237 -.43045 35.86 35.86
5 -BOZ74 39917 73703 2312 23.12
B

Fi

g

29020 14097 -.43045 2875 2875

83104 1.47844 -BB355 50.50 50.50

- 31568 - 34772 526838 . 2699

d - 2871 - 34772 03654 31.04 31.04
10 14305 14097 22334 37 .51 37.581
11 -01580 - 11624 27004 17.23 17.23
12 26166 - 11624 - 19858 19.52 19.52

13 B3437 14097 03654 26.05 26.08
14 33779 - 11624 27004 20.62 2082
15 95158 14097 -.43045 3121 31.21 -

] I\Data\ﬁéw;{ Variable View 7 [l«] | e[
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If you want to find the mean of four variables and only want a result if three or more
of the variables have valid values, you could use the following syntax:

newvar = mean.3(varl, var2, var3, varié)
Figure 9-15
Specifying number of valid values for mean calculation
: Compute VYariable E
Target * anable: umerc Expression;
Inewvar = |mean 3(varl, vard, vard, vard] ;I
Type & Label... | _I
- M anufacturer [man;. Function group:
E‘, Maodel [madel] ;I ;ILI ilil q Al -
# Sales in thousands = Arithretic
-] 2=|x=| 4]|5]|E
@ dvear resale value _I _I _I_I_ EDF & Moncentral COF
@Vehicle tupe [tupe] _xl ;I:I Llili CS;;z[SE)D;eHTime
4 Price in thousands o] o] Diate Arithmetic
@ Engine size [engine il ;I_UJ Delete Date Cleatio_n
@ Horzepower [horze F.J_..a.t!a_ _E_x.t—[\?—dlon LI
@ Wheelbasze [wheel— d Functions and Special W ariables:
< Width [width]
@ Length [length]
® Curb weight [curb_
# Fuel capacity [fuel_
<& Fuel efficiency [mp:
@ Loghransformed sa
@ Zecore: 4-pear res-;l ;I
| If... | [optional caze selection condition] |
Ok, I Paste | Reset | Cancel | Help |

To raise or lower the number of required valid values, simply change the number
following mean (which is 3 in this example).

Working with Dates and Times

A number of tasks commonly performed with dates and times can be easily
accomplished using the Date and Time Wizard. Using this wizard, you can:

m Create adate/time variable from a string variable containing a date or time.
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m  Construct a date/time variable by merging variables containing different parts of
the date or time.

m  Add or subtract values from date/time variables, including adding or subtracting
two date/time variables.

m Extract apart of adate or time variable; for example, the day of month from a
date/time variable which has the form mm/dd/yyyy.

The examples in this section use the data file upgrade.sav.

To use the Date and Time Wizard:

From the menus choose:

Transform
Date/Time...

Figure 9-16
Date and Time Wizard Introduction Screen

Date and Time Wizard B

Welcomne ko kthe date and time wizard

what would vou like o do?

% Learn how dates and times are represented in SPSS

| Create adateftine variable From a string containing 2 date ar time

10 / 2 £ Create a dateftime variable from variables holding parts of dates or times
3

3 " Calrulate with dates and times
T8
/ " Extract a part of a date or time variable
= Assign periodicity to a dataset (For time series data). This ends the wizard and opens the
Define Dates dialog box

= Back I Mext = I Fimish Cancel Help
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The introduction screen of the Date and Time Wizard presents you with a set of
general tasks. Tasks that do not apply to the current data are disabled. For instance,
the data file upgrade.sav doesn’t contain any string variables so the task to create a
date variable from a string is disabled.

If you're new to dates and times in SPSS you can select Learn how dates and
times are represented in SPSS and click Next. This leads to a screen that provides a
brief overview of date/time variables, and alink, through the Help button, to more
detailed information.

Calculating the Length of Time Between Two Dates

One of the most common tasks involving dates is calculating the length of time
between two dates. As an example, consider a software company interested in
analyzing purchases of upgrade licenses by determining the number of years since
each customer last purchased an upgrade. The data file upgrade.sav contains a
variable for the date on which each customer last purchased an upgrade, but not the
number of years since that purchase. A new variable that is the length of time, in
years, between the date of the last upgrade and the date of the next product release
will provide a measure of this quantity.

To calculate the length of time between two dates:

Select Calculate with dates and times on the introduction screen of the Date and Time
Wizard and click Next.
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Figure 9-17
Calculating the length of time between two dates Step 1

Date and Time Wizard - Step 1 of 3 [ x|

Da Calculations on Dates

Choose one of the Following tasks and press hext

add or subtract a duration from & date (e.q., add a month to an age or add a time wariable
to a date/time variable)

5 Calculate the number of time units between bwo dates (e.g., calculate an age in years from
a birthdate and another date})

= Subtrack bwe durations (2,9, bime warked - bne cammmuting

< Back I Mext > I Firish | Cancel | Help

» Select Calculate the number of time units between two dates and click Next.
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Figure 9-18

Calculating the length of time between two dates Step 2

Date and Time Wizard - Step 2 of 3

Calculate the number of time units between bwo date or dateftime variables,

The result will be an integer wariable.

Cnly date or dateftime variables are shown in the list below,

‘Wariables!

Datel:

$TIME is the current date and time.

» I@ Date of next releas...

minus Datez:

> I@ Date of last upgrad. ..

Lnit:

I‘r’ears

< Back I et = I

[~

FEimish

Cancel

Help

Select Date of next release for Datel.

Select Date of last upgrade for Date2.

Click Next.

| 2
>
» Leavethe Unit drop-down list at the default of Years.
| 2
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Figure 9-19
Calculating the length of time between two dates Step 3
Date and Time Wizard - Step 3 of 3 E
Calculation: $TIME - LastUp
Result Yariable: LUniks:
I YearsLastUp ‘Years
1k
10 2
9/ 3 Yariable Label:
8 ’@ I\"ears since last upgrade
i
L]
A/
Execution
[6 Create the variable now " Paste the syntax into the syntax window
< Back I Text = | Fimish | Cancel | Help |

» Enter YearsLastUp for the name of the result variable. Result variables cannot have
the same name as an existing variable.

» Enter Yearssince last upgrade as the [abel for the result variable. Variable |abels for
result variables are optional.

» Leavethe default selection of Create the variable now and click Finish to create the
new variable.

The new variable YearsLastUp, displayed in the Data Editor, is the integer number of
years between the two dates. Fractional parts of ayear have been truncated.
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Figure 9-20
New variable displayed in Data Editor
upgrade.sav - SP55 Data Editor Hi=E
File Edit “iew Data Transform Analyze Graphs  Utiiies  Add-ons  ‘Window  Help
28| B] o] | =|k| @ Fl=| SEE %l
|1  custid |‘I
custid PurDate Support LastUp MNextRel |YearsLastlUp 3
1 1 12/30/1993 4 0272872002 | 0BAD1/04 2
2 2 0B/28/2001 2 0972872002 | 0BA1/04 1
3 3 08/,27/1959 2 092772001 |  0OBAD1/04 2
4 4 02/22/2000 4 01,/22/2003 |  0BAD1/04 1
5 ] 01,/26/2000 2 08/26/2001| 0OBAD104 2
B B 07/10/1959 3 07102003 | 0BAD1/04 0
7 7 01,/24/2003 2 0772472003 |  0OBAD104 0
8 a 0B/15/1959 2 09/15/2003| 0OBAD1/04 0
9 9 01/18/2003 5 071872003 |  0OBAD104 0
10 10 120252002 4 06/02/2003| 0BAD1/04 0
11 11 08/10/2000 1 10A0/2002 | 0601404 1 -
4 [+ ]\ Data View £ Variahie Yiew 7 [« ]
|SPSS Processar is ready [ [ v

Adding a Duration to a Date

You can add or subtract durations, such as 10 days or 12 months, to adate. Continuing
with the example of the software company from the previous section, consider
determining the date on which each customer’sinitial tech support contract ends.
The data file upgrade.sav contains a variable for the number of years of contracted
support and a variable for the initial purchase date. You can then determine the end
date of the initial support by adding years of support to the purchase date.

To add a duration to a date:

» Select Calculate with dates and times on the introduction screen of the Date and Time
Wizard and click Next.

» Select Add or subtract a duration from a date and click Next.
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Figure 9-21
Adding a duration to a date Step 2

Date and Time Wizard - Step 2 of 3 [ x|

Add to or subtract From a date or dateftime variable

Choose a date or date/time variable,

Then choose either a duration variable or an ordinary variable or enter a constant;
Set the duration units and operation choice appropriately, and press Mext,

Wariables! Date:
@ Current date and ... P I@ Date of initial produ. ..
W

Duration Yariable:

12 ®
m11 /12 @ Date of next rele... 3 I@Years of kech suppa... Lriits:
3 ® Years since last u.., T Years -

]
T |
/ Operation ———————

& Addition
¢ Subtraction

$TIME is the current date and time.

< Back I Mext > I Firish Cancel Help

Select Date of initial product license for Date.

Select Years of tech support for the Duration Variable.

Since Years of tech support is simply a numeric variable, you need to indicate the
units to use when adding this variable as a duration.

Select Years from the Units drop-down list.

Click Next.
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Figure 9-22
Adding a duration to a date Step 3

Date and Time Wizard - Step 3 of 3 [ x|

Enter a name For the result variable and optionally, a label. The Farmat For the input date/time
wariable will be applied ta the result wariable.

Calculation:
PurDate + Support (Years)

Result Yariable:

I SupEndDate
1k
10 2
B 3 Yariable Label:
8 ’@ IEnd date For support
i
L]
A/
Execution
[6 Create the variable now " Paste the syntax into the syntax window

< Barck I Iext = | Finish | Cancel | Help |

» Enter SupEndDate for the name of the result variable. Result variables cannot have
the same name as an existing variable.

» Enter End date for support as the label for the result variable. Variable labels for
result variables are optional.

» Click Finish to create the new variable.
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Figure 9-23
New variable displayed in Data Editor
upgrade.zav - 5P55 Data Editor [ _ [O] x|
File Edit View Data Transform Analyze Graphs  Utliter Add-ons  Window  Help
=E18| B o] |k sl e BlslE vl
|1  custid |1
custid PurDate Suppart Lastlp NextRel | YearsLastlp| SupEndDate g
1 1 12/30/1995 4 0272372002 | 06/01/04 2 1243072002
2 2 068/28/2001 2 0972372002 | 06/01/04 1 067232003
E 3 058/27/1999 2 02427/2001| 060104 2 082772001
4 4 022272000 4 01/22/2003| 060104 1 0202272004
5 5 01/26/2000 2 08/26/2001| 06/01./104 2 0172652002
B B 07101999 3 071072003  08/01/04 0 07 A0£2002
7 7 0142452003 2 0772472003 080104 0 0172472005
g g 08151999 2 0941572003 080104 0 0&/1552001
9 g 011585003 5 071872003 080104 0 0141852008
10 10 120272002 4 06/02/2003| 06/01/104 0 1210252006
11 11 08/10/2000 1 10/10/2002( 0B/01,/04 1 03#10/2001 |
d_lﬂ\zaata\ﬁew;(\iariabl;\‘fi_éw;f o I‘.—.lm—.”—.. | B nrrﬁhm—iu

|SPSS Processor is ready [
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Sorting and Selecting Data

Datafiles are not always organized in the ideal form for your specific needs. To
prepare data for analysis, you can select from awide range of file transformations,
including the ahility to:

m  Sort data. You can sort cases based on the value of one or more variables.

m  Select subsets of cases. You can restrict your analysis to a subset of cases or
perform simultaneous analyses on different subsets.

The examples in this chapter use the data file demo.sav.

Sorting Data

Sorting cases (sorting rows of the datafile) is often useful and sometimes necessary
for certain types of analysis.

To reorder the sequence of cases in the data file based on the value of one or
more sorting variables:

» From the menus choose:

Data
Sort Cases...

205
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This opens the Sort Cases dialog box.

Figure 10-1

Sort Cases dialog box
X Sort Cases [ x|
@ M arital status [marit = Sort by
> Years at cunent ad @ bge in pears [age] - As
&> Income categary in Household income i t &l
@ Price of primary wet Reset |
& Primary vehicle !:nc Sort Order —
< Level of education & dscendin |
& Years with current - -g Help |
<& Retired Tretire] ;I Descending

» Addthe Agein years (age) and Household income in thousands (income) variables to
the Sort By list.

If you select multiple sort variables, the order in which they appear on the Sort By
list determines the order in which cases are sorted. In this example, based on the
entries in the Sort By list, cases will be sorted by the value of Household incomein
thousands (income) within categories of Age in years (age). For string variables,
uppercase letters precede their lowercase counterparts in sort order (for example, the
string value Yes comes before yes in the sort order).

Split-File Processing

To split your data file into separate groups for analysis:

» From the menus choose:

Data
Split File...
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This opens the Split File dialog box.

Figure 10-2
Split File dialog box
: Split File [ x]
: ’ Paste
# Number of peaple i " Organize output by groups
G Wireless service [u Groups Based an; Reset
® Fultiple lines [multh @ Income cate -
gany in the
< Voice mail [voice] Cancel |
@ Gender [gender]
4 Paging service [par Help |
@ Intemet [internet]
< Caller D [calid]
> Call waiting [calwa % Sort the file by grouping variables
< Owns TY [ovnty] LI " File s already sorted

Current Status: Analpsiz by groups is off.

Select Compare groups Or Organize output by groups. The examples following these
steps show the differences between these two options.

Select Gender (gender) to split the file into separate groups for these variables.

You can use numeric, short string, and long string variables as grouping variables. A
separate analysisis performed for each subgroup defined by the grouping variables. If
you select multiple grouping variables, the order in which they appear on the Groups
Based On list determines the manner in which cases are grouped.
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If you select Compare groups and run the Frequencies procedure, a single pivot

table is created.
Figure 10-3
Split File output with single pivot table
Statistics
Household income in thousands
Femala M Walid nry
Missing i
Mean G8.7798
Median 44.0000
Std. Deviation 7573510
Male M Yalid 32
Mizsing 1]
Mean 701608
Median 45.0000
Std. Deviation 8186216

If you select Organize output by groups and run the Frequencies procedure, two pivot
tables are created: one for females and one for males.

Figure 10-4
Split File output with pivot table for females
Statistics®
Househald income in thousands
M walid 3179
Missing i
Mean 63.7798
Median 44.0000
Std. Deviation 7573510

a. Gender= Female
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Figure 10-5
Split File output with pivot table for males
Statistics™
Househaold income in thousands
M Walid 321
Missing i]
Mean 701608
Wedian 45.0000
Std. Deviation 8186216

a. Gender= Male

Sorting Cases for Split-File Processing

The Split File procedure creates a new subgroup each time it encounters a different
value for one of the grouping variables. Therefore, it isimportant to sort cases based
on the values of the grouping variables before invoking split-file processing.

By default, Split File automatically sorts the data file based on the values of the
grouping variables. If thefileis already sorted in the proper order, you can save
processing time if you select File is already sorted.

Turning Split-File Processing On and Off

Once you invoke split-file processing, it remains in effect for the rest of the session
unless you turn it off.

m  Analyze all cases. Turns split-file processing off.
m  Compare groups and Organize output by groups. Turns split-file processing on.

If split-file processing is in effect, the message Split File on appears on the status bar at
the bottom of the application window.
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Selecting Subsets of Cases

You can restrict your analysis to a specific subgroup based on criteria that include
variables and complex expressions. You can also select a random sample of cases.
The criteria used to define a subgroup can include:

Variable values and ranges
Date and time ranges
Case (row) numbers
Arithmetic expressions
Logical expressions

Functions

To select a subset of casesfor analysis:
» From the menus choose:

Data
Select Cases...

This opens the Select Cases dialog box.

Figure 10-6
Select Cases dialog box
el
4 hge in years [age] =+ e
& Marital status [marit & Allcases
B Years ot cument ad £ IF condition is satisfied
< Household income If |

B Income category in " Random sample of cases

@ Price of primary vel e

& Primary vehicle pric _Ia'"Fl c

% Level af education " Based on time ar case 1ange
4 Years with curent « Fange,.. |

& Retired [retire]

© Use filter variable:
@ Years with cunent .

@ Jab satisfaction fjot —
4 Number of peaple i

@Wue\ess servics [m Unselected Cases Ar

& Mulliple lines [mult = ’7(" Filtered ) Deleted

Current Status: Do not filker cases

ok | Paste | F\asatl Eam:a\l Help |
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Selecting Cases Based on Conditional Expressions

To select cases based on a conditional expression:

» Select If condition is satisfied and click If in the Select Cases dialog box.

This opens the Select Cases If dialog box.

Figure 10-7

Select Cases If dialog box

Select Cazes: If E
@ Age inyears [age] |~ ;I
< Marital status [marit
G Years at cument ad ;I

4 Household income
4 Income categary in
@ Price of primary vet

|
@ Primary vehicle pric j
N
[

;I 5 _Iilil Functions: E
ﬁlﬁl _Iilﬂ SBS numexpr] 3
_=| _Iilil ANY[test value value.,...)

ARSIN[umespr)

4 Level of education
& Years with current

;I
& ] o ] [ARTANRumesp)
@ Retired [retire] ;l

COFMORM[zvalue)
e 0l _Belete ||| epr BERNOLLLIp) =
Ears With current

@ Job satisfaction [iﬂlj Contifue I Cancel | Help |

The conditional expression can use existing variable names, constants, arithmetic
operators, logical operators, relational operators, and functions. You can type and edit
the expression in the text box just like text in an output window. You can also use the
calculator pad, variable list, and function list to paste el ements into the expression.
For more information, see “Using Conditional Expressions’ in Chapter 9 on p. 187.

Selecting a Random Sample

To obtain a random sample:
» Select Random sample of cases in the Select Cases dialog box.

» Click sample.

This opens the Select Cases Random Sample dialog box.
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Figure 10-8
Select Cases Random Sample dialog box

! Select Cages: Random 5 ample m

Sample Size

& Approsimately I % of all cazes

e EHactIyI cagzes from the first I casesl
Continuel Cancel | Help |

You can select one of the following alternatives for sample size:

m  Approximately. A user-specified percentage. This option generates a random
sample of approximately the specified percentage of cases.

m  Exactly. A user-specified number of cases. You must also specify the number of
cases from which to generate the sample. This second number should be less
than or equal to the total number of casesin the datafile. If the number exceeds
the total number of casesin the datafile, the sample will contain proportionally
fewer cases than the requested number.

Selecting a Time Range or Case Range
To select arange of cases based on dates, times, or observation (row) numbers:
» Select Based on time or case range and click Range in the Select Cases dialog box.

This opens the Select Cases Range dialog box, in which you can select arange
of observation (row) numbers.
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Figure 10-9
Select Cases Range dialog box

First Case  Last Case Comtinue I

Obseration: I I |
Cancel

Help |

m  First Case. Enter the starting date and/or time values for the range. If no date
variables are defined, enter the starting observation number (row number in the
Data Editor, unless Split Fileis on). If you do not specify a Last Case value, al
cases from the starting date/time to the end of the time series are selected.

m Last Case. Enter the ending date and/or time values for the range. If no date
variables are defined, enter the ending observation number (row number in the
Data Editor, unless Split Fileis on). If you do not specify aFirst Case value, al
cases from the beginning of the time series up to the ending date/time are sel ected.

For time series data with defined date variables, you can select arange of dates and/or
times based on the defined date variables. Each case represents observations at a
different time, and thefile is sorted in chronological order.

Figure 10-10
Select Cases Range dialog box (time series)

i Select Cases: Range m
First Case  Last Case Cantinue I

WEEk:I I Cancel |
oo Help |
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To generate date variables for time series data:

» From the menus choose:

Data
Define Dates...

Unselected Cases

You can choose one of the following aternatives for the treatment of unselected cases:

m Filtered. Unselected cases are not included in the analysis but remain in the data
file. You can use the unselected cases later in the session if you turn filtering
off. If you select arandom sample or if you select cases based on a conditional
expression, this generates a variable named filter_$ with avalue of 1 for selected
cases and a value of 0 for unselected cases.

m Deleted. Unselected cases are deleted from the datafile. By reducing the number
of casesin the open data file, you can save processing time. Deleted cases can
be recovered only by exiting from the file without saving any changes and then
reopening the file. The deletion of casesis permanent if you save the changes
to the datafile. Note: If you delete unselected cases and save the file, the cases
cannot be recovered.

Case Selection Status

If you have selected a subset of cases but have not discarded unselected cases,
unselected cases are marked in the Data Editor with a diagonal line through the
row number.
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Figure 10-11
Case selection status
demo.zay - SPS5 Data Editor |_ O] x|
File Edit “iew Data Transform Analyze Graphs  Utlitie:  Window Help
S|&|S| B| <« 5] =] &l £ ElEE S 2
: k_ |‘|

age marital address incorme inccat car ;I

1 45| Unmarried 25 24.00| Under §25 12.20

34| Unmarried 10 2000| Under §25 10.00

3 21| Unmarried 0 13.00| Under $25 £.30

4 24| Unmarried 5 24.00| Under §25 11.80

& 21| Unmarried 0 2200 Under §25 11.00

3 38 Married 0 19.00| Under §25 9.20

7 30 Married 0 20,00 Under $25 9.70

g 22| Unmarried 3 23.00| Under $25 11.50

9 34| Unmarried 15 23.00| Under §25 11.40

700 Unrmarried 23 21.00| Under $25 10,20

48 harried 19 23.00| Under §25 11.40

31| Unmarried 4 2200| Under §25 11.20

28 Married 7 15.00 | Under §25 7.50
4 50| Unmarried 3 23.00| Under §25 170 -
4 |+ |\ Data view £ Variahle View f ]| _»lJ
|SPSS Processor is ready [ v







Chapter

Additional Statistical Procedures

This chapter contains brief examples for selected statistical procedures. The
procedures are grouped according to the order in which they appear on the Analyze
menul.

The examples are designed to illustrate sample specifications required to run a
statistical procedure. The examplesin this chapter use the data file demo.sav, except
for the following:

m The paired-samplest test example uses the data file dietstudy.sav, which isa
hypothetical datafile containing the results of a study of the “ Stillman diet.” In
the examples in this chapter, you must run the procedures to see the output.

m  The correlation examples use Employee data.sav, which contains historical
data about a company’s employees.

m  The exponential smoothing example uses the data file inventor.sav, which
contains inventory data collected over a period of 70 days.

For information about individual itemsin a dialog box, click Help. If you want to
locate a specific statistic, such as percentiles, use the Index or Search facility in the

Help system. For additional information about interpreting the results obtained by
running these procedures, consult a statistics or data analysis textbook.

Summarizing Data

The Descriptive Statistics submenu on the Analyze menu provides techniques for
summarizing data with statistics and charts.
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Frequencies

In the chapter Examining Summary Statistics for Individual Variables, thereis an
example showing afrequency table and a bar chart. In that example, the Frequencies
procedure was used to analyze the variables Owns PDA (ownpda) and Owns TV
(owntv), both of which are categorical variables having only two values. If the
variable that you want to analyze is a scale (interval, ratio) variable, you can use the
Freguencies procedure to generate summary statistics and a histogram. A histogram
isachart that shows the number of cases in each of severa groups. This example will
use Frequencies to analyze the variable Years with current employer (employ).

To generate statistics and a histogram of the years with current employer, follow

these steps:

» From the menus choose:

Analyze

Descriptive Statistics

Frequencies...

This opens the Frequencies dialog box.

Figure 11-1

Frequencies dialog box

: Frequencies

® Age inyears [age] -~
< Warital status [marit
& Years at currert a

< Household income

A Income category in
® Price of primary vet
< Primary vehicls pric

A Level of education ﬂ

v WL I |

[~ Display frequency tables

Y ariable(z):

0K
4 Years with current empl

Paste
Fezet

Cancel

Help

iz A

Statistics...l Eharts...l Format...l

» Select Yearswith current employer (employ) and move it to the Variable(s) list.
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» Desdlect the Display frequency tables check box.

(If you leave this item selected and display a frequency table for current salary, the
output shows an entry for every distinct value of salary, making a very long table.)

» Click Charts to open the Freguencies Charts dialog box.

Figure 11-2
Frequencies Charts dialog box
Frequencies: Charts [ x|
Chart Tppe———
(el
e Cancel |
" Bar charts
" Pie charts ﬂl
@ Histograms
v with nomnal curve

= Chart Y alues

= Frequencies | Percentages

» Select Histograms and With normal curve, and then click Continue.

» To select summary statistics, click Statistics in the Frequencies dialog box. This
displays the Frequencies Statistics dialog box.
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Figure 11-3
Frequencies Statistics dialog box
Frequencies: Statistics E
— Percentile Values r— Central Tendency
[~ Quartiles ¥ Mean Cancel |
[ Cut paints for:I‘IEl equal groups [ Median Help |
r Percentile[s]:l [ Mode
il [~ Sum
Chatige
m [~ Walues are group midpoints
— Dizperzion — Distribution
¥ Std. deviation [ Minimum ™ Skewness
[~ Variance ¥ Mazimum W et
[~ Range [~ 5.E. mean

» Select Mean, Std. deviation, and Maximum, and then click Continue.

» Click OK in the Frequencies dialog box to run the procedure.

The Viewer shows the requested statistics and a histogram in standard graphics
format. Each bar in the histogram represents the number of employees within arange
of five years, and the year values displayed are the range midpoints. Asrequested, a
normal curve is superimposed on the chart.

Explore

Suppose that you want to look further at the distribution of the years with current
employer for each income category. With the Explore procedure, you can examine the
distribution of the years with current employer within categories of another variable.
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» From the menus choose:

Analyze
Descriptive Statistics
Explore...

This opens the Explore dialog box.

Figure 11-4

Explore dialog box
> Age in pears [age] | = Dependent List: oK |
< Marital status [marit @ ears with current emp

Paste |

< “ears at current ad
< Household income Reset |
& Price of primary vet Factor List:
@ Primary vehicle pric L2 Income category in the ﬂl
< Level of education ‘II Help |

& Retired [retire]
@ “Years with current Label Cazes by:

@ Job zahisfaction [iotLI I

— Display

@ Both ¢ Statistics © Plots Statistics...l Plots. .. | Options. .. |

» Select Yearswith current employer (employ) and move it to the Dependent List.
» Select Income category in thousands (inccat) and move it to the Factor List.

» Click OK to run the Explore procedure.

In the output, descriptive statistics and a stem-and-leaf plot are displayed for the years
with current employer in each income category. The Viewer aso contains a boxplot
(in standard graphics format) comparing the years with current employer in the
income categories. For each category, the boxplot shows the median, interquartile
range (25th to 75th percentile), outliers (indicated by O), and extreme values
(indicated by *).
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More about Summarizing Data

There are many ways to summarize data. For example, to calculate medians or
percentiles, use the Frequencies procedure or the Explore procedure. Here are some
additional methods:

Descriptives. For income, you can calculate standard scores, sometimes called
z scores. Use the Descriptives procedure and select Save standardized values
as variables.

Crosstabs. You can use the Crosstabs procedure to display the relationship
between two or more categorical variables.

Summarize procedure. You can use the Summarize procedure to write to your
output window alisting of the actual values of age, gender, and income of the
first 25 or 50 cases.

To run the Summarize procedure, from the menus choose:
Analyze

Reports

Case Summaries...

Comparing Means

The Compare Means submenu on the Analyze menu provides techniques for
displaying descriptive statistics and testing whether differences are significant

between two means for both independent and paired samples. You can aso test
whether differences are significant among more than two independent means by
using the One-Way ANOVA procedure.
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In the demo.sav file, several variables are available for dividing people into groups.
You can then calculate various statistics in order to compare the groups. For example,
you can compute the average (mean) household income for males and females. To
calculate the means, use the following steps:

From the menus choose:

Analyze
Compare Means
Means...

This opens the Means dialog box.

Figure 11-5
Means dialog box (layer 1)

@ Primary vehicle pric;l Dependent List:
&> Level of education 4 Household income in H
G Years with curent | Easte
<#> Retired [retire] Beset |
&> ears with current 1 Layer 1 of 1 C |
@ Job satisfaction [job T Nest ﬂl
@ Mumber of people | —I __I Help |
@ Wirelezs zervice [u Independent List:
> Multiple lines [mult [ER Gander |
@ Voice mail [voice] E .

Options. . |
#» Paing service [DaLI =l

» Select Household income in thousands (income) and move it to the Dependent List.

» Select Gender (gender) and move it to the Independent List in layer 1.

» Click Next. This creates another layer.



224

Chapter 11

Figure 11-6
Means dialog box (layer 2)

< Voice mail [voice] ;I Dependent List: oK.
> Paging service [pa & Household incame in

@ Internet [intermet] Paste
@ Caller 1D [calid] Feset

® Call waiting [callwa Layer 2 of 2

Cancel
& Dz TV [owntv] J Previous | [Next |

& Owns YCR [ownve Help
@ Owns sterec/CD pl

@ Oz computer [o.
< Dwng Fax machine E
< Newsnaner subscriLI

Independent List:

Folslelelels

Optiohs. ..

» Select Owns PDA (ownpda) and move it to the Independent List in layer 2.

» Click OK to run the procedure.

Paired-Samples T Test

When the data are structured in such away that there are two observations on

the same individual or observations that are matched by another variable on two
individuals (twins, for example), the samples are paired. In the datafile dietstudy.sav,
the beginning and final weights are provided for each person who participated in the
study. If the diet worked, we expect that the participant’ s weight before and after the
study would be significantly different.

To carry out at test of the beginning and final weights, use the following steps:

» Open the data file dietstudy.sav, which can be found in the \tutorial\sample_files\
subdirectory of the directory in which you installed SPSS.
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» From the menus choose:

Analyze
Compare Means
Paired-Samples T Test...

This opens the Paired-Samples T Test dialog box.

Figure 11-7
Paired-Samples T Test dialog box
> Patient ID [patid] =~ Paired Variables:
@ Age in pears [age] wgtd - wgtd
@ Gender [gender] j ﬂl
@ Triglyceride [tgl] Reset |
& Tst interim triglyceric
@ 2nd interim triglycen ﬂl
® Zrd inkerim trighycenc Help |
<#s Final tinloreride HnaLI
— Current Selections
Wariable 1:
Warisble 2 Options. .. |

» Click Weight (wgt0). The variableis displayed in the Current Selections group (below
the variable list).

» Click Final weight (wgt4). The variableis displayed in the Current Selections group.
» Click the arrow button to move the pair to the Paired Variables list.

» Click OK to run the procedure. If there are rows of asterisksin some columns,
double-click the chart and drag to make the columns wider.

The results show that the final weight is significantly different from the beginning
weight, as indicated by the small probability displayed in the Sg. (2-tailed) column
of the Paired Samples Test table.
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More about Comparing Means

The following examples suggest some ways in which you can use other procedures to
compare means.

m Independent-Samples T Test. WWhen you use at test to compare means of one
variable across independent groups, the samples are independent. Males and
females in the demo.sav file can be divided into independent groups by the
variable Gender (gender). You can use at test to determine if the mean household
incomes of males and females are the same.

m  One-Sample T Test. You can test whether the household income of people with
college degrees differs from a national or state average. Use Select Cases on the
Data menu to select the cases with Level of Education (ed) >= 4. Then, run
the One-Sample T Test procedure to compare Household income in thousands
(income) and the test value 75.

m  One-Way ANOVA. The variable Level of Education (ed) divides employeesinto five
independent groups by level of education. You can use the One-Way ANOVA
procedure to test whether Household income in thousands (income) means for the
five groups are significantly different.

ANOVA Models

The General Linear Model submenu on the Analyze menu provides techniques for
testing univariate analysis-of-variance models. (If you have only one factor, you can
use the One-Way ANOVA procedure on the Compare Means submenu.)

Univariate Analysis of Variance

The GLM Univariate procedure can perform an analysis of variance for factorial
designs. A simple factorial design can be used to test if a person’s household income
and job satisfaction affect the number of years with current employer.
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» From the menus choose:
Analyze

General Linear Model
Univariate...

This opens the Univariate dialog box.

Figure 11-8
Univariate dialog box

i Umivanate m

> Age in pears [age] = Dependent Yariable: Model...
@ Marital statuz [marit I@Years with current emp

G Years at curent ad Fixed Factor(s] Clairsts
# Household income r . -

@ Price of primary vel @ Income category |n;| Plots..
% Primary vehicle pric @ Job satisfaction [|olL|
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Post Hoc...

Random Factor(s]:
® Retired [retire] Save..

Years with cument | -
® — n Options...

EL Gender [gender]
® Mumber of people |

s Wireless service [w

< Multiple lines [rmultli
> Voice mail [voice]

@ Paging service [pan

@Intemet[intemet] ;I I\ELSW’eight:
QK I Eastel Besetl Eancell Help |

i

LCovariate(s):

» Select Yearswith current employer (employ) as the dependent variable.

» Select Income category in thousands (inccat) and Job satisfaction (jobsat) as fixed
factors.

» Click OK to run the procedure.

In the Tests of Between-Subjects Effects table, you can see that the effects of income
and job satisfaction are definitely significant and that the observed significance level
of the interaction of income and job satisfaction is 0.000. For further interpretation,
consult a statistics or data analysis textbook.
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Correlating Variables

The Correlate submenu on the Analyze menu provides measures of association for
two or more numeric variables.
The examplesin this topic use the data file Employee data.sav.

Bivariate Correlations

The Bivariate Correlations procedure computes statistics such as Pearson’s
correlation coefficient. Correlations measure how variables or rank orders are related.
Correlation coefficients range in value from —1 (a perfect negative relationship) and
+1 (aperfect positive relationship). A value of 0 indicates no linear relationship.

For example, you can use Pearson’s correlation coefficient to seeif thereisa
strong linear association between Current Salary (salary) and Beginning Salary
(salbegin) in the data file Employee data.sav.

Partial Correlations

The Partial Correlations procedure calculates partial correlation coefficients that
describe the relationship between two variables while adjusting for the effects of one
or more additional variables.

You can estimate the correlation between Current Salary (salary) and Beginning
Salary (salbegin), controlling for the linear effects of Months since Hire (jobtime)
and Previous Experience (prevexp). The number of control variables determines the
order of the partial correlation coefficient.

To carry out this Partial Correlations procedure, use the following steps:

» Openthe Employee data.sav file. Itisusualy in the directory where SPSSisinstalled.
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» From the menus choose:

Analyze
Correlate
Partial...

This opens the Partial Correlations dialog box.

Figure 11-9

Partial Correlations dialog box
i Partial Correlations m
@ Employee Code [id] Wariables:
& Date of Birth [bdate] @ Beginning Salary [salbe .
@ Educational Level [yes & Current Salary [salany] i
® Employment Category | Reset

@ tinonity Classification [ C I
) ancel
Controliing for:

E 4 Months since Hire [jobti Help

. Previous Expenence [m

elefze[A

— Test of Significance
& Two-tailed ¢ Dne-tailed

i

Options...
¥ Display actual significance level

» Select Current Salary (salary) and Beginning Salary (salbegin) and move them to
the Variables list.

» Select Months since Hire (jobtime) and Previous Experience (prevexp) and move
them to the Controlling For list.

» Click OK to run the procedure.

The output shows atable of partial correlation coefficients, the degrees of freedom,
and the significance level for the pair Current Salary (salary) and Beginning Salary
(salbegin).
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Regression Analysis

The Regression submenu on the Analyze menu provides regression techniques.

Linear Regression

The Linear Regression procedure examines the relationship between a dependent
variable and a set of independent variables. You can use it to predict a person’s
household income (the dependent variable) from independent variables such as age,
number in household, and years with employer.

» From the menus choose:

Analyze
Regression
Linear...

This opens the Linear Regression dialog box.

Figure 11-10
Linear Regression dialog box

i Linear Regression m
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WLS s> | §tatistics...| Plots... | Save... | thions...l

» Select Household income in thousands (income) and move it to the Dependent list.
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» Select Agein years (age), Number of people in household (reside), and Years with
current employer (employ) and move them to the Independent(s) list.

» Click OK to run the procedure.

The output contains goodness-of-fit statistics and the partial regression coefficients
for the variables.

Examining fit. To see how well the regression model fits your data, you can examine
the residuals and other types of diagnostics that this procedure provides. In the Linear
Regression dialog box, click Save to see alist of the new variables that you can add to
your datafile. If you generate any of these variables, they will not be availablein a
later session unless you save the data file.

Methods. If you have collected a large number of independent variables and want to
build aregression model that includes only variablesthat are statistically related to the
dependent variable, you can select a method from the drop-down list. For example, if
you select Stepwise in the above example, only variables that meet the criteriain the
Linear Regression Options dialog box are entered in the equation.

Nonparametric Tests

The Nonparametric Tests submenu on the Analyze menu provides nonparametric tests
for one sample or for two or more paired or independent samples. Nonparametric
tests do not require assumptions about the shape of the distributions from which

the data originate.

Chi-Square

The Chi-Square Test procedure is used to test hypotheses about the relative proportion
of casesfaling into several mutually exclusive groups. You can test the hypothesis
that people who participated in the survey occur in the same proportions of gender
as the general population (50% males, 50% females).

In this example, you will need to recode the string variable Gender (gender) into
anumeric variable before you can run the procedure.
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» From the menus choose:

Transform
Automatic Recode...

This opens the Automatic Recode dialog box.

Figure 11-11
Automatic Recode dialog box
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» Select the variable Gender (gender) and move it to the Variable -> New Name list.
» Typegender2 in the New Name text box, and then click the New Name button.

» Click OK to run the procedure.

This creates anew numeric variable called gender2, which has avalue of 1 for females
and avalue of 2 for males. Now a chi-square test can be run with a numeric variable.

» From the menus choose:

Analyze
Nonparametric Tests
Chi-Square...

» This opens the Chi-Square Test dialog box.
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Figure 11-12
Chi-Square Test dialog box
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» Select Gender (gender?) asthe test variable.

» Select All categories equal, since, in the general population of working age, the number
of males and females is approximately equal.

» Click OK to run the procedure.

The output shows atable of the expected and residual values for the categories. The
significance of the chi-square test is 0.6. Consult a statistics or data analysis text book
for more information on interpretation of the statistics.

Time Series Analysis

A time series variable is a variable whose values are recorded at regular intervals
over aperiod of time. The Time Series submenu on the Analyze menu provides
exponential smoothing that can be used for predictions. Exponential Smoothing is
available in the Student Version and in the Trends module.
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Exponential Smoothing

The Exponential Smoothing procedure performs exponential smoothing of time
series data. It creates new series containing predicted values and residuals. This
topic uses the Inventor.sav file.

For example, you can fit amodel for inventory data and use it to predict the next
week’ sinventory. Suppose that for 70 days you have kept track of the inventory of
power supplies and that you want to construct a model and then use it to forecast
power supplies for the next week.

To use the Exponential Smoothing procedure to forecast power supplies, follow
these steps:

» Open the Inventor.sav file. It isusually in the directory where SPSSisinstalled.

» From the menus choose:

Analyze
Time Series
Exponential Smoothing...

This opens the Exponential Smoothing dialog box.

Figure 11-13
Exponential Smoothing dialog box
i+ Exponential Smoothing E
@ Day number [num] Laetrios tndel
@ Humber of power suppli .
& Gimple Pazte |
 Helt =
- Rezet
E  inters ﬂl
 Custom Cancel |
Seazonal Factons:
I Custor... | ﬂl

Current Penodicity,  Mone

Save.. | Farameters. .. |

» Select Number of power supplies (amount) and move it to the Variables list.
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» Click Parameters to specify the procedure.

This opens the Exponential Smoothing Parameters dialog box.

Figure 11-14
Exponential Smoothing Parameters dialog box

Exponential Smoothing: Parameters m

Trend: None

Continue
Seazonal Component.  Mone _

—General [Alpha) = Tirend (& amna] Cancel

" Value: I.'I &~ Value:l.'l Help

dii

% Grid Search: | Grid Search:
Start:  Stop: By Start: Stop: By
[ K | O
~Seasonal (Deltal —~Trend Mad. (Phij—— [ 'nitial Values
& Automatic
% e I.'I i alue |.1  Custar:
! Grid Search: ! Grid Search: il l—
Start:  Stop: By Start: Stop: By
| O K E Trend: |

¥ Dizplay only 10 best models for grid search

» To search for the best general parameter, select Grid Search and then click Continue.

» To create anew variable that contains predicted values, click Save.

This opens the Exponential Smoothing Save dialog box.

Figure 11-15
Exponential Smoothing Save dialog box

Exponential Smoothing: Save E
Create Variables r— Predict Caze
@ sdd o file ' Predict from estimation period thiough last caze
" Replace existing * Predict through:
" Do not create Observation: I??

The Estimation Period is:
all cases

Continue I Cancel Help
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>

>

>

>

Select Predict through and type 77 in the Observation text box.
This adds 7 days to the original 70.

Click Continue and then in the main dialog box, click OK.

This runs the procedure and adds the new variablesfit_1 and err_1. The variablefit_1
contains the fitted values and the seven new predicted values. The variable err_1
contains residual values for the original 70 cases; you can use the residuals for further
analysis. If you want to save the new variables, select Save As from the File menu
and save the data file under a new name.

To see achart of the original data and the new fit line, from the menus choose:

Graphs
Sequence...

This opens the Sequence Charts dialog box.

Figure 11-16
Sequence Charts dialog box

< Day rumber [rurm] ariables:
< Error for AMOUNT fron & Mumber of power supp
E < Fit for AMOUNT from E Paste

Reset

Cancel
Time Awis Labels:

|

Transfom

HHHE

™ Matural log transform

[ Difference: I'I_
[T Seasonally diference: I‘I_

Current Perodicity:  Mone

[~ One chart per variable Time Lines... | Fomat... |

Select Number of power supplies (amount) and Fit for AMOUNT (fit_1) and move
them to the Variables list.

Click OK to run the procedure.
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The resulting chart shows both the actual number of power supplies and thefit line
plotted on the same axes. The predicted values are plotted for the next week on the
right side of the chart.
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